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Introduction to the Manuals

The following manuals are supplied with your Epson printer. As well as the manuals, check the various types of
help information available from the printer itself or from the Epson software applications.

O Start Here (paper manual)

Provides you with information on setting up the printer, installing the software, using the printer, solving
problems, and so on.

To obtain the latest version, visit the Epson Europe support website at http://www.epson.eu/Support, or the
Epson worldwide support website at http://support.epson.net/ .
U User's Guide (digital manual)

This manual. This manual is available as PDF and Web manuals. Provides overall information and instructions
on using the printer, on network settings when using the printer on a network, and on solving problems.

To view the Web manual, visit the following website, enter the product name, and then go to Support.

http://epson.sn

Guide to Video Manuals

You can view video manuals to learn how to connect to the printer over Wi-Fi, or how to use the software. Access
the following website. The contents of the video manuals are subject to change without prior notice.

SC-P900 Series: https://support.epson.net/p_doc/785/
SC-P700 Series: https://support.epson.net/p_doc/784/

Searching for Information

The PDF manual allows you to search for information you are looking for by keyword, or jump directly to specific
ections using the bookmarks. This section explains how to use a PDF manual that has been opened in Adobe
Reader X on your computer.

Searching by keyword

Click Edit > Advanced Search. Enter the keyword (text) for information you want to find in the search window,
and then click Search. Hits are displayed as a list. Click one of the displayed hits to jump to that page.
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Jumping directly from bookmarks

Click a title to jump to that page. Click + or > to view the lower level titles in that section. To return to the previous
page, perform the following operation on your keyboard.

O Windows: Hold down Alt. and then press <.
0 Mac OS: Hold down the command key, and then press <.

EPSON

User's Guide

Printing Only the Pages You Need

You can extract and print only the pages you need. Click Print in the File menu, and then specify the pages you
want to print in Pages in Pages to Print.

0 To specify a series of pages, enter a hyphen between the start page and the end page.
Example: 20-25
O To specify pages that are not in series, divide the pages with commas.

Example: 5, 10, 15

Prigter: v Propedies Aglvance s
Copies |1 = [1Prnt in grayszale (Black and white)
[C5ave inkftener (L
Comments & Forms
Document any d Mariups
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About This Manual

This section explains the meaning of marks and symbols, notes on descriptions, and operating system reference
information used in this manual.

Marks and Symbols

A Caution:

Instructions that must be followed carefully to avoid bodily injury.
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g Important:

Instructions that must be observed to avoid damage to your equipment.

Note:
Provides complementary and reference information.

Related Information

= Links to related sections.

Notes on Screenshots and Illustrations
[ Screenshots of the printer driver are from Windows 10 or macOS High Sierra. The content displayed on the
screens varies depending on the model and situation.

O Tllustrations used in this manual are examples only. Although there may be slight differences depending on
themodel, the method of operation is the same.

U Some of the menu items on the LCD screen vary depending on the model and settings.

U You can read the QR code using dedicated app.

Operating System References

Windows

In this manual, terms such as "Windows 10", "Windows 8.1", "Windows 8", and "Windows 7" refer to the following
operating systems. Additionally, "Windows" is used to refer to all versions.

3 Microsoft® Windows® 10 operating system
3 Microsoft® Windows® 8.1 operating system
3 Microsoft® Windows® 8 operating system

3 Microsoft® Windows® 7 operating system

Mac OS

In this manual, "Mac OS" is used to refer to macOS Catalina, macOS Mojave, macOS High Sierra, macOS Sierra,
OS X El Capitan, OS X Yosemite, and OS X Mavericks.

Trademarks

U QR Code is a registered trademark of DENSO WAVE INCORPORATED in Japan and other countries.
3 Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft Corporation.

1 Apple, Mac, macOS, OS X, Bonjour, ColorSync, Safari, AirPrint, iPad, iPhone, iPod touch, and iTunes are
trademarks of Apple Inc., registered in the U.S. and other countries.

O Use of the Works with Apple badge means that an accessory has been designed to work specifically with
the technology identified in the badge and has been certified by the developer to meet Apple performance
standards.
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U Chrome, Google Play, and Android are trademarks of Google LLC.

J Adobe, Adobe RGB, Lightroom, Photoshop, and Photoshop Elements are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

O The SuperSpeed USB Trident Logo is a registered trademark of USB Implementers Forum, Inc.
O Firefox is a trademark of the Mozilla Foundation in the U.S. and other countries.

J Mopria® and the Mopria® Logo are registered and/or unregistered trademarks and service marks of Mopria
Alliance, Inc. in the United States and other countries. Unauthorized use is strictly prohibited.

1 General Notice: Other product names used herein are for identification purposes only and may be trademarks
of their respective owners. Epson disclaims any and all rights in those marks.

Copyright

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by
any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission
of Seiko Epson Corporation. No patent liability is assumed with respect to the use of the information contained
herein. Neither is any liability assumed for damages resulting from the use of the information herein. The
information contained herein is designed only for use with this Epson product. Epson is not responsible for any
use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties
for damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or
abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.)
failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use
of any options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko
Epson Corporation.

© 2022-2025 Seiko Epson Corporation

The contents of this manual and the specifications of this product are subject to change without notice.
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Safety Instructions

Read and follow these instructions to ensure safe use of this printer. Make sure you keep this manual for future
reference. Also, be sure to follow all warnings and instructions marked on the printer.

J Some of the symbols used on your printer are to ensure safety and proper use of the printer. Visit the following
Web site to learn the meaning of the symbols.

http://support.epson.net/symbols

J Use only the power cord supplied with the printer and do not use the cord with any other equipment. Use of
other cords with this printer or the use of the supplied power cord with other equipment may result in fire or
electric shock.

J Be sure your AC power cord meets the relevant local safety standard.

J Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, or options by yourself, except
as specifically explained in the printer's manuals.

O Unplug the printer and refer servicing to qualified service personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the printer; the printer has been dropped or the casing
damaged; the printer does not operate normally or exhibits a distinct change in performance. Do not adjust
controls that are not covered by the operating instructions.

O Place the printer near a wall outlet where the plug can be easily unplugged.

1 Do not place or store the printer outdoors, near excessive dirt or dust, water, heat sources, or in locations
subject to shocks, vibrations, high temperature or humidity.

U Take care not to spill liquid on the printer and not to handle the printer with wet hands.

0 Keep the printer at least 22 cm away from cardiac pacemakers. Radio waves from this printer may adversely
affect the operation of cardiac pacemakers.

U If the LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on your hands, wash them
thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with
water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

Safety Instructions for Ink

0 If ink contacts your skin, eyes, or mouth, take the following actions.
U If ink gets on your skin, wash the area thoroughly with soap and water.

U If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after
a thorough flushing, see a doctor immediately.

U Ifink gets into your mouth, see a doctor right away.

0 Do not disassemble the ink cartridge and the maintenance box; otherwise ink may get into your eyes or on your
skin.

0 Do not shake ink cartridges too vigorously; otherwise ink may leak from the cartridge.

O Keep ink cartridges and maintenance box out of the reach of children.

11
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Printer Advisories and Warnings

Read and follow these instructions to avoid damaging the printer or your property. Make sure you keep this
manual for future reference.

Advisories and Warnings for Setting Up the Printer

U Do not block or cover the vents and openings in the printer.

(J When placing the printer on a desk that is easily scratched, place a desk mat or the like on the desk first before
placing the printer.

[ Use only the type of power source indicated on the printer's label.
U Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
1 Avoid electrical outlets controlled by wall switches or automatic timers.

O Keep the entire computer system away from potential sources of electromagnetic interference, such as
loudspeakers or the base units of cordless telephones.

O The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place
objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over.
Be particularly careful to keep all the power-supply cords straight at the ends and the points where they enter
and leave the transformer.

U If you use an extension cord with the printer, make sure that the total ampere rating of the devices plugged into
the extension cord does not exceed the cord's ampere rating. Also, make sure that the total ampere rating of all
devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

U If you plan to use the printer in Germany, the building installation must be protected by a 10 or 16 amp circuit
breaker to provide adequate short-circuit protection and over-current protection for the printer.

J When connecting the printer to a computer or other device with a cable, ensure the correct orientation of the
connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation
may damage both devices connected by the cable.

(1 Place the printer on a flat, stable surface that extends beyond the base of the printer in all directions. The printer
will not operate properly if it is tilted at an angle.

O Allow space above the printer so that you can fully raise the printer cover.
[ Leave enough space in front of the printer for the paper to be fully ejected.

O Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer away from direct
sunlight, strong light, or heat sources.

Advisories and Warnings for Using the Printer

O Do not insert objects through the slots in the printer.

U Do not put your hand inside the printer during printing.

U Do not touch the white flat cable inside the printer.

0 Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.

0 Do not move the print head by hand; otherwise, the printer may be damaged.

12
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J Always turn the printer off using the O button. Do not unplug the printer or turn off the power at the outlet
until the O light stops flashing.

U If you are not going to use the printer for a long period, be sure to unplug the power cord from the electrical
outlet.

Advisories and Warnings for Using the Printer with a Wireless

Connection

J Radio waves from this printer may negatively affect the operation of medical electronic equipment, causing it
to malfunction. When using this printer inside medical facilities or near medical equipment, follow directions

from the authorized personnel representing the medical facilities, and follow all posted warnings and directions
on the medical equipment.

O Radio waves from this printer may negatively affect the operation of automatically controlled devices such as
automatic doors or fire alarms, and could lead to accidents due to malfunction. When using this printer near
automatically controlled devices, follow all posted warnings and directions on these devices.

Advisories and Warnings for Using the Touchpad

U The touchpad only responds when touched directly with your finger.

U The touchpad may not respond if your fingers are wet, if you are wearing gloves, or if there is a protective sheet
or sticker on the touchpad.

J Do not use sharp objects such us a ballpoint pen or mechanical pencil to perform operations. The touchpad
may be damaged.

U If the touchpad gets dirty, wipe it with a soft cloth. If it is very dirty, dip a soft cloth in a solution diluted with
neutral detergent, squeeze it well, wipe oft the dirt, and then wipe it with a soft dry cloth. Do not use volatile
chemicals such as thinner, benzene, or alcohol. The surface of the touchpad may be damaged.

1 Avoid locations subject to rapid changes in temperature and humidity. Condensation will form inside the
touchpad, and may cause performance to deteriorate.

J The LCD screen may contain a few small bright or dark spots, and because of its features it may have an uneven
brightness. These are normal and do not indicate that it is damaged in any way.

0 Do not press the touchpad with too much force or subject it to heavy impacts. The touchpad could break.
Contact your dealer if the touchpad surface chips or cracks, and do not touch or attempt to remove the broken
pieces.

Advisories and Warnings for Transporting or Storing the Printer

J When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

U Before transporting the printer, make sure that the print head is in the home (far right) position.

13
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Notes on the Administrator Password

This printer allows you to set an administrator password to prevent unauthorized access or changes to the device
settings and network settings stored in the product when connecting to a network.

Default Value of the Administrator Password

The default value of the administrator password is printed on the label on the product itself, such as the one shown.
The position where the label is attached depends on the product, such as the side where the cover is opened, the
back, or the bottom.

The following illustration is an example of the label attachment position on the side of the printer where the cover
opens.

ISERIAL No. X3B8153559 I

[@ Passworo asizzor g || |[sviat wo. InmmmII |

If both labels (1) and (2) are attached, the value next to PASSWORD written on the label in (1) is the default value.
In this example, the default value is 03212791.

If only label (2) is attached, the serial number printed on the label in (2) is the default value. In this example, the
default value is X3B8153559.

Administrator Password Has Not Been Set

Set a password on the password entry screen that is displayed when you access Web Config.

Related Information

= “Running Web Config on a Web Browser” on page 211

Changing the Administrator Password

For security reasons, we recommend changing the initial password.

It can be changed from Web Config and Epson Device Admin. When changing the password, set it with at least 8
single-byte alphanumerical characters and symbols.

Related Information

= “Running Web Config on a Web Browser” on page 211

14
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Operations that Require You to Enter the Administrator Password

If you are prompted to enter the administrator password when performing the following operations, enter the
administrator password set on the printer.
J When updating the firmware of the printer from a computer or smart device

J When logging on to the advanced settings of Web Config

O When adjusting settings using an application that can change the printer's settings.

Initializing the Administrator Password

You can return the administrator password to its default setting by initializing the network settings.

Related Information

= “Restore Default Settings” on page 218

Protecting Your Personal Information

When you give the printer to someone else or dispose of it, erase all the personal information stored in the printer's

memory by selecting A > General Settings > Restore Default Settings > Clear All Data and Settings on the
control panel.

15
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(1) Rear paper feeder Loads paper.

(2] Edge guide Feeds the paper straight into the printer. Slide to the edges of the paper.

(3] Printer cover Open to replace the ink cartridges or to remove jammed paper.

(4] Front cover Open when sliding out the front paper feeder and output tray or replacing
the maintenance box.

(5) Edge guide Feeds the paper straight into the printer. Slide to the edges of the paper.

Do not slide the edge guide below the A4-size mark on the front paper
feeder. Otherwise, the edge guide could be damaged.

(6] Output tray

Holds the ejected paper.

Front paper feeder

Loads fine art media, poster board, or the CD/DVD tray.

(8] Maintenance box cover

Open when replacing the maintenance box. The maintenance box is a
container that collects a very small amount of surplus ink during cleaning
or printing.

(9] Control panel

Allows you to make settings and perform operations on the printer. Also
displays the printer’s status.

Press the control panel with your thumb and pull it with your other finger to
change the angle of the control panel.

1 (I) (Power button/light)

Turns the printer on or off. Unplug the power cord after checking that the
power light is off.

17
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Rear

SC-P900 Series

(1) LAN port Connects a LAN cable.
(2] USB port Connects a USB cable.
(3] Port cover Open to connect a USB cable or LAN cable. See the related information link

below for details on how to open the cover.

“Opening the Port Cover” on page 19

(4] ACinlet Connects the power cord.

(5] Rear cover Open to install the optional roll paper unit.

SC-P700 Series

(1) LAN port Connects a LAN cable.
(2] USB port Connects a USB cable.
(3] Port cover Open to connect a USB cable or LAN cable. See the related information link

below for details on how to open the cover.

“Opening the Port Cover” on page 19
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(4] ACinlet Connects the power cord.

(5) Roll paper unit Loads roll paper.

(6) Rear cover Open to load roll paper.

(7] Edge guide Feeds the paper straight into the printer. Slide to the edges of the paper.
Opening the Port Cover

Open the rear paper feeder and then open the port cover.
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Home Screen Configuration

Prem. Glossy

A3

o

Paper Setting

12

I I

11 (10

(1) E Displays the Menu screen. You can make settings related to printer features and operations.

(2] FQ-IJ Displays the Print Information Sheet screen. You can check the last 12 print histories. For
example, if you print three copies of a photo, the printer saves three print histories. See the
related link information for details on how to print the photo information sheet.

(3) m Allows you to turn on or off the printer's interior light.

E Indicates the light is on.
E Indicates the light is off.

(4] % Allows you to switch the view of the home screen and the printing screen. See the related link
information for more details.

(5) Displays the Maintenance screen. Displays the menus recommended to improve the quality of
your printouts such as unclogging nozzles by printing a nozzle check pattern and performing
head cleaning, and improving blurring or banding in your printouts by aligning the print head.

(6] IE.:- E.;g Displays the network connection status. See the following for more details.

“Guide to the Network Icon” on page 22

(7] m Displays the Printer Status screen. The number displayed indicates the number of notifications.

(8] Displays the printer status.

(9] Displays the paper settings.

(10) Displays the Supply Status screen. You can check the approximate ink levels and the

approximate service life of the maintenance box.
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(11) .|'J You can eject paper that has been loaded.
¥

The following can be performed when roll paper is loaded.
1 Move roll paper to the cutting position.
3 Eject paper after moving the roll paper to the cutting position.

3 Eject roll paper

® Displays the Paper Setting screen. You can select the paper size and paper type by selecting
q% Paper Setting when paper is loaded.

Related Information

= “Switching the Screen View” on page 23
= “Printing Information About Photo Printing” on page 68

Internal Light

When printing starts, the internal light turns on allowing you to view printing as it happens through the printer
cover. To turn off the light, make settings from the home screen as described below.

E > General Settings > Basic Settings > Inside Light > Manual

You can also turn the light on or off by selecting E on the home screen.

&) Ready.

Prem. Glossy

[/

A3

kL

Paper Setting

Guide to the Network Icon

I‘ |_i_| The printer is not connected to a wired (Ethernet) network or unset it.

The printer is connected to a wired (Ethernet) network.

=
=

l;‘:_:_: The printer is not connected to a wireless (Wi-Fi) network.
]
l’® The printer is searching for SSID, unset IP address, or having a problem with a wireless

(Wi-Fi) network.
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E The printer is connected to a wireless (Wi-Fi) network.
The number of bars indicates the signal strength of the connection. The more bars
there are, the stronger the connection.
- The printer is not connected to a wireless (Wi-Fi) network in Wi-Fi Direct (Simple AP)
mode.
E&" The printer is connected to a wireless (Wi-Fi) network in Wi-Fi Direct (Simple AP) mode.

Switching the Screen View

When you select E=] while the home screen or printing screen is displayed, the screen view is switched.

Home screen

Standard mode

&) Ready.

Prem. Glossy

[)

A3

kL

Paper Setting

Consumables infomation mode

You can check the approximate ink levels and the approximate service life of the maintenance box.

Prem. Glossy

[/

I

MK PK GY LGY C VM LC VLM Y v

Printing screen

Photo display mode
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Displays thumbnails of images when you print using the printer driver and Epson Print Layout.

\)

Cancel

Print status display mode

Displays ink levels and a progress bar when printing.

Cancel

[[) Velvet Fine Art Paper A4 210 x

e

MK PK GY LGY C VM LC VLM Y v

Print setting display mode

Displays print settings for the printer driver and Epson Print Layout.

Sample2ijpg
Epson Premium Glossy
A3

Print Quality
Overcoat
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Entering Characters
You can enter characters and symbols by using on-screen keyboard when you make network settings.
. |——

<= e

Indicates the character count.

Moves the cursor to the input position.

(1)
(2]
(3] Switches between upper case and lower case or numbers and symbols.
(4]

Switches the character type.

i : You can enter numbers and symbols.

ABC
: You can enter letters.

Enters frequently used email domain addresses or URLs by simply selecting the item.

Enters a space.

Enters character.

© o0 0|06

Deletes the character to the left.
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Loading Paper

Paper Handling Precautions
Note the following points when handling and storing the paper. If the paper is not in good condition, print quality
may decline.

Check the manuals supplied with each paper.

Handling Precautions

1 Use Epson special media under normal room conditions (temperature: 15 to 25°C; humidity: 40 to 60%).
1 Do not fold the paper or scratch the surface of the paper.

J Avoid touching the printable surface of the paper with your bare hands. Moisture and oils from your hands can
affect print quality.

J Paper may be wavy or slack if the temperature and humidity change. Be careful not to scratch or soil the paper,
and flatten it before loading it in the printer.

O Do not wet the paper.
U Do not throw away the paper packaging as you can use it for storing the paper.
O Avoid locations that are subject to direct sunlight, excessive heat, or humidity.

U Keep paper in their original package after opening, and keep them in a flat place.

Printed Paper Handling Precautions

To maintain long lasting, high quality print results, note the following points.
U Do not rub or scratch the printed surface. If they are rubbed or scratched, the ink may peel off.
O Do not touch the printed surface; otherwise, the ink may peel off.

J Make sure the print outs are completely dry before folding of stacking; otherwise, the color may change where
they touch (leaves a mark). These marks will disappear if they are separated immediately and dried; however,
they will remain if not separated.

U If you put the print outs in an album before they are completely dry, they may be blurred.
0 Do not use a dryer to dry the print outs.
O Avoid direct sunlight.

 Prevent color distortion while displaying or storing the print outs by following the instructions in the paper’s
manual.

U To keep your printouts from discoloring, store them in a dark place, away from high temperatures, high
humidity, and direct sunlight.
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Note:

Typically, print outs and photos fade over time (color distortion) due to the effects of light and various constituents in the
air. This also applies to Epson special media. However, with the correct storage method, the degree of color distortion can be
minimized.

O See the manuals supplied with Epson special media for detailed information on handling the paper after printing.

L The colors of photos, posters, and other printed materials appear different under different lighting conditions (light
sources”). The colors of print outs from this printer may also appear different under different light sources.

* Light sources include sunlight, fluorescent light, incandescent light, and other types.

Notes on Loading Paper

This printer has three paper sources. Load paper of the appropriate size and type to suit your printing needs.

(1) Rear paper feeder Normally, load paper in the rear paper feeder. (Except for roll paper, poster board, or paper
that is over 0.5 mm thick.)

(2] Front paper feeder Load paper into the front paper feeder when printing on poster board or paper that is
over 0.5 mm thick, or when you are unable to feed commercially available fine art paper
from the rear paper feeder. If roller marks appear on your printout when using glossy
paper, select Front Paper Feeder - No Eject Roller(Glossy Paper) in the Paper Setting
menu.

(3) Roll paer unit Load roll paper into the roll paper unit. For the SC-P700 Series, roll paper unit is stored in
the rear of the printer. For the SC-P900 Series, use an optional roll paper unit.

Paper Size and Type Settings

If you register the paper size and type on the screen displayed when you load the paper, the printer informs you
when the registered information and print settings differ. This prevents you from wasting paper and ink by making
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sure you are not printing on the wrong paper size or printing in the wrong color due to using settings that do not
match the paper type.

Rear Paper Feeder

Select the size and type of the loaded paper.

Paper Type

Paper Size

Max: 20 sheets

If displayed paper size and type differ from the loaded paper, select the item to change. If the settings match the
loaded paper, close the screen.

Note:
[ The paper setting screen is not displayed if you have disabled Paper Setup Auto Display in the following menu. If you
disable this setting, some functions will be unavailable.

E > General Settings > Printer Settings > Paper Setup Auto Display

U When you want to give priority to the paper type and size selected in the printer driver, regardless of the paper type and
size registered on the printer, make settings in one of the following ways. When you make these settings, the confirmation
screen is not displayed when the paper type and size differ between the printer settings and the printer driver settings.

However, if you select a paper type which has been added by Epson Media Installer with the printer driver, the following
settings are not applied.

J Windows

On the printer driver's Main tab, enable Driver Paper Settings Priority.

J Mac OS

Select System Preferences from the Apple menu > Printers & Scanners (or Print & Scan, Print & Fax),
and then select the printer. Click Options & Supplies > Options (or Driver), and then enable Driver Paper
Settings Priority.

Related Information

= “Paper Setup Auto Display:” on page 214

List of Paper Types

To obtain optimum printing results, select the paper type that suits the paper. When using commercially available
paper other than genuine Epson paper, select the paper type that closest to that paper.

Media Name Media Type
Control Panel Printer Driver
Bright White Ink Jet Paper Plain paper Plain Paper / Bright White Paper
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Media Name

Media Type

Control Panel

Printer Driver

Premium Glossy Photo Paper

Prem. Glossy

Epson Premium Glossy

Premium Semigloss Photo Paper

Prem. Semigloss

Epson Premium Semigloss

Photo Paper Glossy

Glossy

Photo Paper Glossy

Watercolor Paper - Radiant White

Watercolor Paper Radiant White

Watercolor Paper Radiant White

Velvet Fine Art Paper

Velvet Fine Art Paper

Velvet Fine Art Paper

UltraSmooth Fine Art Paper

Epson UltraSmooth Fine Art paper

UltraSmooth Fine Art Paper

Matte Paper-Heavyweight

Archival Matte Paper

Archival Matte

Epson Archival Matte

Photo Quiality Ink Jet Paper

Photo Quality Ink Jet

Epson Photo Quiality Ink Jet

Epson Proofing Paper White Semimatte

Proofing Semimatte

Epson Proofing Paper White
Semimatte

Premium Glossy Photo Paper (250)

Prem. Glossy

Epson Premium Glossy

Premium Semigloss Photo Paper (250)

Prem. Semigloss

Epson Premium Semigloss

Premium Luster Photo Paper (260)

Prem. Luster

Premium Luster Photo Paper

Premium Semimatte Photo Paper (260)

Prem. Semigloss

Epson Premium Semigloss

Enhanced Matte Paper

Archival Matte

Epson Archival Matte

Plain Paper (cut sheets)

Plain paper

Plain Paper / Bright White Paper

Loading Paper in the Rear Paper Feeder

1. Open and slide out the rear paper feeder to its maximum position.
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g Important:

Be careful not to trap your fingers at the points shown in the illustration.

2. Slide out the edge guides.

3. Load paper with the printable side facing up.
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4.

Slide the parts of the edge guides indicated by (a) to the edges of the paper.

The paper setting screen is displayed on the printer's control panel.
Select the paper size and paper type and then select OK.

When using commercially available paper other than genuine Epson paper, select the paper type that closest to
that paper. If you use paper information which has been added by Epson Media Installer, make sure you select
the paper type.

Note:
If you have registered paper information to your printer, the printer informs you if the registered information and the
print settings differ. This prevents you from making the misprints.

If you have not used the register function, select I > General Settings > Printer Settings, and then disable the Paper
Setup Auto Display setting. If you disable this setting, some functions will be unavailable. See Related Information for
more details.

Open the front cover.
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7. Slide out the output tray to its maximum position.

n Important:

To avoid paper jams, make sure you open the front paper feeder and extend the output tray before printing.

Related Information

= “Paper Setup Auto Display:” on page 214

= “Available Paper and Capacities” on page 187
= “Paper Size and Type Settings” on page 28

Loading Paper in the Front Paper Feeder

You can load paper into the front paper feeder by referring to the animations displayed on the printer's control
panel.

Paper sticks out from the rear of the printer when it is loaded from the front paper feeder. Leave a space (A)
between the rear of the printer and the nearest wall as shown in the figure.

A
v

=

SC-P900 Series: 405 mm or above
SC-P700 Series: 330 mm or above
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g Important:

O An error may occur if you perform the following operations during initialization movement.
- Extend the front paper feeder.
- Load poster board.

U Inserting paper from the rear may cause a malfunction or error.

1. Select Paper Setting on the printer's control panel.

= m 6 B = i &

& Load paper.

O

Paper Setting Ink Info

2. Select Front Paper Feeder - Fine Art (Thick) or Front Paper Feeder - Poster Board.

Paper Setting

3. Pull out the front paper feeder by referring to the animations displayed on the screen.

Pull out the Front Paper Feeder.

Load paper by referring to the animations displayed on the screen.
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4. The paper setting screen is displayed on the printer's control panel.

Select the paper size and paper type and then select OK. When using commercially available paper other than
genuine Epson paper, select the paper type that closest to that paper.

Note:
If you have registered paper information to your printer, the printer informs you if the registered information and the
print settings differ. This prevents you from making the misprints.

If you have not used the register function, select IR > General Settings > Printer Settings, and then disable the Paper

Setup Auto Display setting. If you disable this setting, some functions will be unavailable. See Related Information for
more details.

Related Information

= “Paper Setup Auto Display:” on page 214

= “Available Paper and Capacities” on page 187
= “Paper Size and Type Settings” on page 28

Loading Roll Paper
You can load a roll paper by referring to the animations displayed on the printer's control panel.

1. Select Paper Setting on the printer's control panel.

L 8 B ety &

& Load paper.

O

Ink Info

2. Select Roll Paper.

Paper Setting

Rear Paper Feeder
You nultip

Roll Paper

Front Paper Feeder - Fine Art (Thick)

D Not
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3. Load the roll paper by referring to the animations displayed on the screen.

Pull out the Roll Paper Unit.

n Important:

U Remove any slack from the roll paper before setting it in the roll paper unit. If the roll paper has slack, it may
not feed correctly.

U Do not store the roll paper in the roll paper unit. The surface of the roll paper may get scratched or soiled.

4. 'The paper setting screen is displayed on the printer's control panel.

Select the paper size and paper type and then select OK. When using commercially available paper other than
genuine Epson paper, select the paper type that closest to that paper.

Important:
Note the following when loading roll paper in the printer.

U Insert the top edge of the paper slowly with both hands until you hear a beep. When there is only a small
amount of roll paper remaining, insert more of the top edge of the paper than usual.

(0 Make sure that the top edge of the paper has a straight cut which is perpendicular to the long side. If paper is
slanted or the cut edge is uneven, it may not be fed correctly. We recommend printing with Paper Setting >
Print Cutting Guideline enabled to make straight paper cuts.

Note:
If you have registered paper information to your printer, the printer informs you if the registered information and the
print settings differ. This prevents you from making the misprints.

If you have not used the register function, select = - General Settings > Printer Settings, and then disable the Paper
Setup Auto Display setting. If you disable this setting, some functions will be unavailable. See Related Information for
more details.

Related Information

= “Paper Setup Auto Display:” on page 214

= “Available Paper and Capacities” on page 187
= “Paper Size and Type Settings” on page 28

Cutting and Removing the Roll Paper

After printing on the roll paper, follow the steps below to remove the roll paper.
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1. Select Cut/Eject on the printer's control panel.

2. Select Cut and Eject.

The roll paper is moved to the cutting position.
3. Cut the ejected paper using scissors.
4. Select Done.

5. Open the roll paper unit. (Only for SC-P900 Series users)

\

6. Remove the roll paper.

Loading a CD/DVD

Printable CD/DVDs

You can print on a circular 12-cm CD/DVD labelled as suitable for printing, for example “printable on the label
surface" or "printable with ink jet printers."

You can also print on Blu-ray Discs™.

CD/DVD Handling Precautions

O See the documentation provided with your CD/DVD for more information on handling the CD/DVD or
writing data.

O Do not print on the CD/DVD before writing your data to it. If you do, fingerprints, dirt, or scratches on the
surface may cause errors while writing data.

U Depending on the CD/DVD type or printing data, smearing may occur. Try making a test print on a spare
CD/DVD. Check the printed surface after waiting for one full day.

1 Compared to printing on genuine Epson paper, the print density is lowered to prevent ink from smearing on the
CD/DVD. Adjust the print density as necessary.

0 Allow the printed CD/DVDs at least 24 hours to dry avoiding direct sunlight. Do not stack or insert the
CD/DVDs into your device until they are completely dry.

U If the printed surface is sticky even after it has dried, lower the print density.

U Reprinting on the same CD/DVD may not improve the print quality.
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0 If the disc tray or the internal transparent compartment are accidentally printed on, immediately wipe off the
ink.

O Depending on the print area setting, the CD/DVD or disc tray may get dirty. Make settings to print on the
printable area.

U You can set the print range for the CD/DVD to a minimum of 18 mm for the inner diameter, and a maximum
of 120 mm for the outer diameter. Depending on the settings, the CD/DVD or disc tray may be smeared. Set
within the print range for the CD/DVD you want to print.

Loading a CD/DVD

You can load the CD/DVD by referring to the animations displayed on the printer's control panel.

g Important:

U Do not turn the printer on or off while the tray is inserted. This could cause a malfunction.
O Store the tray flat. Malfunction could result if the tray is curled or deformed.

O An error may occur if you perform the following operations during printing.
- Extend the front paper feeder.
- Load poster board.

U Use the disk tray supplied with the printer. Using a different tray could damage the printer, tray, or disc or cause
printer malfunction.

U Inserting the disk tray from the rear may cause a malfunction or error.

1. Select Paper Setting on the printer's control panel.

= 8 B oSt &

& Load paper.

O

Paper Setting Ink Info

2. Select Disc Tray.

Paper Setting

Feeder - Fine Art (Thick)
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3. Pull out the front paper feeder by referring to the animations displayed on the screen.

Pull out the Front Paper Feeder.

Load the CD/DVD by referring to the animations displayed on the screen.

Related Information

= “Available Paper and Capacities” on page 187

Removing a CD/DVD

1. When the disk tray is ejected after printing, hold the end of the tray and pull it straight out.

2. Store the front paper feeder.
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3. Close the front cover.

n Important:

After printing is finished, make sure you remove the disk tray. If you do not remove the tray and turn the
printer on or off, or run head cleaning, the disk tray will strike the print head and may cause the printer to
malfunction.

Note:
Select Remove on the printer’s control panel to remove the disk tray without printing.
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Printing Photos

Tips when Printing Photo Projects

This section explains important points to note when creating photo projects.

Shooting (Camera Settings)
Creating a photo project begins with shooting. The data storage format and size (resolution) are also important
points.

Some items only need to be set for the first time, while some items need to be set every time according to the
subject.

Items that only need to be set the first time
U Color spaces: Select sSRGB if you are unsure.

[ Storage size: We recommend saving at a resolution that suits the paper size you will use for printing, using the
table below as a guide.

Print Size Number of Pixels

A2/entire sheet 24 million (5830 x 4120)
A3/half sheet 18 million (5050 x 3570)
A4/8x10in/10x12in 12 million (4120 x 2920)

U Data format: We recommend selecting RAW when editing and printing photo data, or select JPEG just printing.

Items that need to be set every time
Set the following appropriately according to the subject.

U Select A mode (aperture priority auto) from shooting mode and control the F value (aperture) to set the amount
of burring.

(O Exposure: Set an approximate value to avoid halation or black defects.
[ Shutter speed: Set the speed to avoid blurring.
0 ISO speed: We recommend setting this as low as possible.

J White balance: Set an approximate setting according to the subject.

Raw Development and Editing (Printed Finish)

This process is as important as shooting to complete photo projects.

This allows you to edit photos (or perform color correction, gradation correction, cropping, and so on) with
applications” such as Adobe Photoshop or Lightroom, and save them in JPEG or TIFF format.

*You can also perform RAW development using the camera software.

O Adjust the color temperature to match the subject or the scene.
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J Maintain a rich gradation and do not increase the intensity of red and yellow.

J Adjust the black level and create a sharp photo.

Printing (Selecting the Paper and Print Settings Correctly)

You can create more attractive photos by selecting paper that suits the subject of the photo.

Most people think that glossy paper is the best for printing all photos, but there other textures available such as
semigloss and matte paper. These provide a wide variety of finished photos.

Also, the soft texture of fine art paper allows you to print photos that look like paintings.
The following pages introduce the characteristics and recommended uses of typical Genuine Epson paper.
“Available Paper and Capacities” on page 187

When you print a photo, select from the following three methods depending on your knowledge and purpose of
photo printing.

U If you want to easily print photos that have been edited in an application (color correction and so on).
“Printing with Epson Print Layout” on page 43

U If you want to print using an application or the printer driver.

“Printing Using the Application and Printer Driver” on page 50

0 If you want to print photos quickly and leave color reproduction to the printer.

“Printing Using Epson Photo+” on page 65

To bring the display color closer to the color of the printed material

The image on the display is expressed with the three primary colors of light (RGB), and the printed matter output
by the printer is expressed by the three primary colors (CMY) + K. Therefore, it is difficult to strictly produce the
same color.

The following three points can help to bring the colors as close as possible.
U Use a calibrated display
O Check under a light that allows you to see the correct color of the photo

3 Set the color management settings’ and print settings correctly

*Settings for matching colors displayed on different devices such as displays, digital cameras, and printers. When
you import photos taken with a digital camera and output them on the printer or display, each color may look
slightly different. This is because the color characteristics differ from device to device.

When printing using commercial paper
Add the paper information when you want to print easily using color matching on ordinary commercial paper.

“Printing to Paper Types Other than Genuine Paper” on page 197

Printing with Epson Print Layout

Epson Print Layout allows you to make print settings to be performed by the application and the printer driver on
one screen.
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Summary of Epson Print Layout

Epson Print Layout is an application that allows you to print retouched or developed photos in a few easy steps. It
can also be used as a plug-in for Adobe Photoshop, Adobe Lightroom, Nikon ViewNX-i, and SILKYPIX. See the
Epson Print Layout manual for details on supported applications and data formats.

You can download Epson Print Layout from the Epson Web site. You can also install it using EPSON Software
Updater.

Note:
You can download the manual for Epson Print Layout for iPad/iPhone from the App Store.

Screen Composition

» Printer Settings

Layout Setiings

ning e stme o

Tone

Check the print results using the selected settings before printing.

(2] Save your favorite print settings and use them repeatedly.
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(3) Set the print layout.

You can also select multiple photo templates and special layouts.

Template

Panorama

Gallery Wrap

(4] Select the color management method or Advanced B&W Photo print mode.

Making Print Settings

This section explains the procedure for printing one photo using a standard layout.

1. Start Epson Print Layout.

This section explains the procedure for starting directly from the photo to be printed.

See the Epson Print Layout manual for details on how to start from your applications.
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1 Windows
Right-click the photo and select Send to > Epson Print Layout.

171932342 tif 187833944.0:f 464460966.Lif

Edit with Paint 30

oy g Set as desktop background
Edit
Print
& Share with Skype

507750853 tif DolcePoster.tif

Rotate right
Rotate left

Cast to Device )
1& Share
Open with >

Give access to B

Restore orevious versions

Send to Bluetooth device

00 MB

5‘ Compressed (zipped) folder

Cut
Copy ‘ ! Desktop (create shortcut)
;:::shurﬁcut [| Epson Print Layout
Rename R A A
= Mail recipient
O Mac OS
Click the photo to be printed while holding down the Ctrl key, and then select Open With > Epson Print
Layout.

B i

Minan

171952342 tif 4}'1[ Open With » I £z Preview (default) (11.0)

=3 Move to Trash % ColorSync Utility (4.14.0)
E Get Info %5 CalarSune |iility (412 0
Rename = Epson Print Layout
RNTFTFRMBRT tif Ml FCrammrann TATIANINDIO FiEN PP (SFAN 11 4)

2. Set the paper information and print quality from Printer Settings.
Make sure that your printer is selected and select the correct paper type, size, and paper source.

Load fine art paper in the Rear Paper Feeder except for some commercial paper (paper except for genuine
Epson paper).

Select Standard as the print quality. Standard is the mode with the best balance between image quality and
speed.
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For borderless printing, select a Paper Source setting with a Borderless option as (Example: Rear Paper
Feeder (Borderless)).

Browse

Current Settings

Printer Settings

Printer | EPSON
Media Type | Epson Premium Gl
Paper Size | A4 210 x 297 mm
Paper Source | Rear Paper Feeder
Quality | Standard

Black Enhance C

» Layout Settings

» Color Seftings

3. Set the print layout in Layout Settings.

Browse  Settings

Preset | Current Settings M

» Printer Settings

¥ Layout Settir

Orientaf

| (mm)
Top
Left
Bottom

Right

Margin ]

Lock Irr ect Ratio

~ Color Settings

e | Printer Mana

(1) Select Standard.

(2] 3 When performing borderless printing

Select Expansion and Scale to Fit. If you cannot select Expansion, select a Paper Source setting with a
Borderless option in Printer Settings.

1 When adding a margin

Clear both checkboxes, and then set the following margin.

(3] QO Select Center.
1 Select Image Size or Margins and adjust the margin size.

3 Select Margin Color to change the color of the margins.
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4. Set the color management method from Color Settings.
Set one of the following methods, and then click Print.

J Manage color using the printer driver (this uses the recommended setting to make the best of the printer
color gamut”)

*Use the following setting method when using paper added in Epson Media Installer: Manage color using
an application.

Browse Settings

Preset | Current Settings -

» Printer Settings

» Layout Settings

¥ Color Settings

Mode | Autc

(1) Select Printer Manages Color.

(2] Select Auto Select.

J Manage color using an application (For users with knowledge of color management and specialized
equipment)

Browse  Seftings

Preset | Current Settings v

» Printer Settings
» Layout Settings

¥ Color Settings

(1] Select Use ICC Profile from Type. When you select Auto Select from Output ICC Profile, the ICC profile
for the paper selected in step 2 is set automatically.

(2] Select Perceptual.

Printing Black and White Photos Easily

In Advanced B&W Photo, you can make adjustments while checking the results in the preview area to easily
create beautiful black and white print outs. The photo data itself can be either color or monochrome.
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Depending on the paper selected in Media Type from Printer Settings, Advanced B&W Photo may not be
displayed.

1. Select Advanced B&W Photo from Type in Color Settings.

Browse Settings

Prest Current Settings -

» Printer Settings

» Layout Settings

¥ Color Settings

Tone | Darker
¥

Horizontal

2. Make any necessary detailed settings, and then click Print.

v Color Settings
Type | Advanced B&W Photo

Color Toning | Fine Adjustment
Tone | Darker

Horizontal

Vertical

Brightness
Contrast
Shadow Tonality

Highlight Tonality

Max Optical
Density

Print
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(1] Color Toning: Select your favorite black from the following four types.
3 Neutral: Standard black

3 Cool: Bluish black

1 Warm: Reddish black

[ Sepia: Brownish with a retro texture

Tone: You can adjust the modulation of black and white.

(2] You can adjust the black tone.

3 When you make an adjustment, Color Toning above changes to Fine Adjustment. If you save and select
Save Custom Toning, you can print the same black and white tone next time.

1 Note that adjustments will be undone if you change Color Toning or Tone after making adjustments.

(3] Switch on and off as needed.
On: Slightly adds color to the highlights of the image and reduces blown out highlights.

On (Full Page): The entire paper is coated with the adjusted color and the texture makes it look like it was
printed on light-colored paper.

Printing Using the Application and Printer Driver

Some features such as various layouts in Adobe Photoshop and advanced adjustments in the printer driver cannot
be realized with Epson Print Layout. In this case, you can make settings individually in the application and printer
driver. This section explains how to make color management settings in situations such as these.

Printing Using Color Management in Applications (Windows)

This is recommended when you want to print colors on the display correctly. You need the correct environmental
conditions such as screen calibration and surrounding lighting to view the correct print colors. The following two
points are important for color management settings.

(J Enable the color management settings in the application and disable those in the printer driver.

0 Select the ICC profile for the paper in the application and select the corresponding paper name in the printer
driver.

See the following for the paper names of genuine Epson paper and their corresponding ICC profiles.

“Available Paper and Capacities” on page 187

1. Make settings in the application.
Setting example for Adobe Photoshop Elements 2020

Click More Options on the print screen.
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Select Color Management, and then select Photoshop Manages Colors from Color Handling. Select the ICC
profile of the paper from Printer Profile and click Printer Preferences.

Mare Options X

Printing Choices Color Management

Custom Print Size
Color Management

Color Handling: | phatoshop Elements M... +
Image Space: sRGB IEC61966-2.1

Printer Profile: | o= s -

Rendering Intent: | Perceptual A4

;. Did you remember to disable color management
in the printer preferences dialog?

Printer Preferences...

oK Cancel Help

2. Display the printer driver's setting screen.

3. Make the following settings on the Main tab.

O Media Type: Select the paper name corresponding to the ICC profile selected as the Printer Profile in step
1.

1 Mode: Select Off (No Color Adjustment).

Note:
For Windows 7, Off (No Color Adjustment) is selected automatically.

4. Check other settings, and then start printing.

Printing Using Color Management in the Printer Driver (Windows)
This is recommended when you want to make the most of wide color spaces and the printer's gradation. This
reduces matching colors on the display. Color management set in the printer driver is not saved to the image data.
The following two points are important for color management settings.
0 Disable the color management settings in the application and enable those in the printer driver.
J Set Mode to match the color space of the image (SRGB/Adobe RGB) to print in the printer driver.
1. When using applications featuring a color management function, specify how to adjust colors from these
applications.
When using applications without a color management function, start from step 2.

Depending on the type of the application, make the settings following the table below.

Application Color Management Settings

Adobe Photoshop CS3 or later Printer Manages Colors
Adobe Photoshop Lightroom 1 or later

Adobe Photoshop Elements 6 or later
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Application Color Management Settings
Other applications No Color Management
Note:

For information on the operating systems supported by each application, visit the distributor’s website.

Setting example for Adobe Photoshop Elements 2020
Click More Options on the print screen.

Select Color Management, and then select Printer Manages Colors from Color Handling. Make a note of
what is displayed in the Image Space, and then click Printer Preferences.

Mare Options X

Printing Choices Color Management

Custom Print Size

| color Management | < Ve st

Color Handling: | printer Manages Colors

Image Space: sRGB IEC61966-2.1

Printer Profile: or=——— == -

Rendering Intent: | Perceptual A4

;. Did you remember to enable color management
*in the printer preferences dialog?

Printer Preferences...

oK Cancel Help

2. On the printer driver's Main tab, select the Media Type and Mode option.
For the Mode, select either of the following depending on what you noted in step 1.
(1 sRGB: EPSON Standard (sRGB)
J Adobe RGB: Adobe RGB

To adjust manually, click Advanced to display the Color Controls screen.
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3. Ifyoudisplayed the Color Controls screen in step 2, make settings for each item.

See the printer driver help for more details on each item.

Color Controls

Printer Color Adjustment

Mode:

Gamma:

EPSOM Standard (sRGE)

22

w

Color Adjustment Method
(®) Color Circle () 5lide Bar

Horizontal

Cancel Help

Note:

You can adjust values while checking the sample image on the left of the screen. You can also make fine adjustments to
the color balance by using the color circle.

4. Check other settings, and then start printing.

Printing Using Color Management in Applications (Mac OS)

This is recommended when you want to print colors on the display correctly. You need the correct environmental
conditions such as screen calibration and surrounding lighting to view the correct print colors. The following two
points are important for color management settings.

(J Enable the color management settings in the application and disable those in the printer driver.

[ Select the ICC profile for the paper in the application and select the corresponding paper name in the printer
driver.

See the following for the paper names of genuine Epson paper and their corresponding ICC profiles.
“Available Paper and Capacities” on page 187
1. Make settings in the application.
Setting example for Adobe Photoshop Elements 2020

Click More Options on the print screen.
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Select Color Management, and then select Photoshop Manages Colors from Color Handling. Select the ICC
profile of the paper from Printer Profile, click OK, and then click Print on the print screen.

Printing Choices
Custom Print Size
Color Management

More Options

Color Management

Color Management
Color Handling:  Photoshop Elements ... ~
Image Space: sRGB IEC61966-2.1

Printer Profile: | =m0 v
Rendering Intent: Perceptual b

' Did you remember to disable color management
in the printer preferences dialog?

0K Cancel

Help

On the printer driver's print dialog, select Print Settings from the pop-up menu.

Make the following settings.

O Media Type: Select the paper name corresponding to the ICC profile selected as the Printer Profile in step 1

0 Color Settings: Select Off (No Color Adjustment).

Check other settings, and then start printing.

Printing Using Color Management in the Printer Driver (Mac OS)

This is recommended when you want to make the most of wide color spaces and the printer's gradation. This
reduces matching colors on the display. Color management set in the printer driver is not saved to the image data.

The following two points are important for color management settings.

1 Disable the color management settings in the application and enable those in the printer driver.

[ Set Color Settings to match the color space of the image (SRGB/Adobe RGB) to print in the printer driver.

1.

When using applications featuring a color management function, specify how to adjust colors from these

applications.

When using applications without a color management function, start from step 2.

Depending on the type of the application, make the settings following the table below.

Application

Color Management Settings

Adobe Photoshop CS3 or later
Adobe Photoshop Lightroom 1 or later

Adobe Photoshop Elements 6 or later

Printer Manages Colors

Other applications

No Color Management

Note:

For information on the operating systems supported by each application, visit the distributor’s website.
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Setting example for Adobe Photoshop Elements 2020
Click More Options on the print screen.

Select Color Management, and then select Printer Manages Colors from Color Handling. Make a note of
what is displayed in the Image Space, click OK, and then click Print on the print screen.

More Options

Printing Choices Color Management

Custom Print Size

I n
Color Management A AL

Color Handling:  Printer Manages Colors
Image Space: sRGB IEC61966-2.1

Printer Profile: | S -

Rendering Intent: | Perceptual >

' Did you remember to enable color management
in the printer preferences dialog?

0K Cancel Help

2. On the printer driver's print dialog, select Color Matching from the pop-up menu, and then click EPSON
Color Controls.

Note:
For the following applications, you need to make settings in step 1 to select EPSON Color Controls.

[ Adobe Photoshop CS3 or later
[ Adobe Photoshop Lightroom 1 or later
[ Adobe Photoshop Elements 6 or later

3. Select Print Settings from the pop-up menu, and then select Color Settings option.
For the Color Settings, select either of the following depending on what you noted in step 1.
(1 sRGB: EPSON Standard (sRGB)
J Adobe RGB: Adobe RGB

To adjust the value manually, click Advanced Color Settings.
4. Set each item in basic settings.

5. Check other settings, and then start printing.

Printing Varieties (Windows)

Printing Black and White Photos

You can print black and white photos with rich gradation by adjusting the image data color by the printer driver.

The original data is not affected.

You can correct image data when printing without processing the data from applications.
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Note:

It is recommended that you use images with a color space of sSRGB.

1. When using applications featuring a color management function, specify how to adjust colors from these

applications.

When using applications without a color management function, start from step 2.

Depending on the type of the application, make the settings following the table below.

Application

Color Management Settings

Adobe Photoshop CS3 or later
Adobe Photoshop Lightroom 1 or later

Adobe Photoshop Elements 6 or later

Printer Manages Colors

Other applications

No Color Management

Note:

For information on the operating systems supported by each application, visit the distributor’s website.

Setting example for Adobe Photoshop Elements 2020

Click More Options on the print screen.

Select Color Management, and then select Printer Manages Colors from Color Handling. Click Printer

Preferences.

Mare Options

Printing Choices Color Management

Custom Print Size
Color Management

Color Handling: | printer Manages Colors

Image Space: sRGB IEC61966-2.1

-

Printer Profile: | ‘o —

-

Rendering Intent: = Perceptual

in the printer preferences dialog?

;- Did you remember to enable color management

Printer Preferences...

-

Cancel Help

3. Click Advanced for Mode.

Display the printer driver's Main tab and select Advanced B&W Photo as the Print Mode.

Make the settings for each item on the Color Controls screen.

See the printer driver help for more details on each item.

5. Check other settings, and then start printing.
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Printing with Auto Color Correction
The printer driver for this printer comes with the Epson proprietary function PhotoEnhance that makes the most
efficient use of the color reproduction area, corrects image data to improve colors before printing.

By using PhotoEnhance, you can correct photo colors to match the subject types such as people, scenery, or night
view. You can print color data in sepia or black and white. Colors are automatically corrected simply by selecting
the print mode.

Note:

It is recommended that you use images with a color space of sSRGB.

1. When using applications featuring a color management function, specify how to adjust colors from these
applications.

When using applications without a color management function, start from step 2.

Depending on the type of the application, make the settings following the table below.

Application Color Management Settings

Adobe Photoshop CS3 or later Printer Manages Colors
Adobe Photoshop Lightroom 1 or later

Adobe Photoshop Elements 6 or later

Other applications No Color Management

Note:

For information on the operating systems supported by each application, visit the distributor’s website.
Setting example for Adobe Photoshop Elements 2020

Click More Options on the print screen.

Select Color Management, and then select Printer Manages Colors from Color Handling. Click Printer
Preferences.

Mare Options X

Printing Choices Color Management
Custom Print Size

Color Management

Color Handling: | printer Manages Colors

Image Space: sRGB IEC61966-2.1

Printer Profile: | o= s -

Rendering Intent: | Perceptual -

;- Did you remember to enable color management
*in the printer preferences dialog?

Printer Preferences...

0K Cancel Help

2. Display the Main tab in the printer driver, select PhotoEnhance for Mode, and click Advanced.
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3. On the PhotoEnhance screen, you can set effects to apply to the print data.

See the printer driver help for more details on each item.

4. Check other settings, and then start printing.

Printing Banners

You can print banners and panoramic pictures if you create and set print data for banner printing in your
application. When printing using document preparation software, image editing software, and so on, create print
data with the same length and width ratio as the size you want to print.

The following printing sizes are available.

Width SC-P900 Series: 431.8mm
SC-P700 Series: 330.2mm
Length” Max. 18m

*. The paper length can be longer if using applications that support banner printing. However, the actual print size depends
on the application, the paper size loaded in the printer, and the computer environment.

1. In the printer driver's Main tab, select Media Type.

2. Select Roll Paper from the Source list.

3. Click User Defined and match the paper size to the size of the data if necessary.

4. Make sure the Optimize Enlargement check box is selected on the Layout tab.

5. Check other settings, and then start printing.

Printing by Increasing Black Density

To print by increasing black density, use black enhance overcoat in the printer driver. This feature overcoats light
gray ink on the dark parts of printouts to increase the maximum density of black and to increase the dynamic

range.

Black enhance overcoat is only available for glossy paper. Note that it is not available for all types of glossy paper.
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Image effects for black enhance overcoat

Note:
Enabling black enhance overcoat increases black density, and disabling it increases print speed.

1. When using applications featuring a color management function, specify how to adjust colors from these
applications.

When using applications without a color management function, start from step 2.

Depending on the type of the application, make the settings following the table below.

Application Color Management Settings

Adobe Photoshop CS3 or later Printer Manages Colors
Adobe Photoshop Lightroom 1 or later

Adobe Photoshop Elements 6 or later

Other applications No Color Management

Note:

For information on the operating systems supported by each application, visit the distributor’s website.
Setting example for Adobe Photoshop Elements 2020

Click More Options on the print screen.

Select Color Management, and them select Printer Manages Colors from Color Handling. Click Printer
Preferences.

Mare Options X

Printing Choices Color Management

Custom Print Size

| color Management | < Ve e

Color Handling: | printer Manages Colors

Image Space: sRGB IEC61966-2.1

Printer Profile: o= == -

Rendering Intent: | Perceptual -

;- Did you remember to enable color management
*in the printer preferences dialog?

Printer Preferences...

0K Cancel Help
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2. Make sure that Black Enhance Overcoat is selected as the Level on the printer driver's Main tab.

Black Enhance Overcoat is automatically enabled when anything other than Standard is selected as the Level.

e EPSOMN X000( *
=9 Main Layout " Llility
Select Setting: | Current Settings o Save/Del...
Media Settings
Media Type: Epson Premium Glossy ~
Print Mode: | Color ~ Paper Config...
Level: Quality Options e
[ [8lack Enhance Overcoat: ]
Mode: EPSOMN Standard (sRGE) o Advanced...
Paper Settings
Source: Rear Paper Feeder ~
giggﬁ'me"'t A4 210 x 297 mm “ User Defined...
[JBorderless
Ink Levels
|:| Print Preview
|:| Layout Manager
Driver Paper Settings
D Priority MK PKE GY LGY C WM LC VLM Y W
Restore Default Version 6.77
Cancel Apphy Help

3. If you want to further increase black density, select Max Quality (Carbon Black) as the Level.

4. Check other settings, and then start printing.

Printing Varieties (Mac OS)

Printing Black and White Photos

You can print black and white photos with rich gradation by adjusting the image data color by the printer driver.
The original data is not affected.
You can correct image data when printing without processing the data from applications.

Note:
It is recommended that you use images with a color space of sSRGB.
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1. When using applications featuring a color management function, specify how to adjust colors from these
applications.

When using applications without a color management function, start from step 2.

Depending on the type of the application, make the settings following the table below.

Application Color Management Settings

Adobe Photoshop CS3 or later Printer Manages Colors
Adobe Photoshop Lightroom 1 or later

Adobe Photoshop Elements 6 or later

Other applications No Color Management

Note:

For information on the operating systems supported by each application, visit the distributor’s website.
Setting example for Adobe Photoshop Elements 2020

Click More Options on the print screen.

Select Color Management, and then select Printer Manages Colors from Color Handling. Click OK, and
then click Print on the print screen.

More Options

Printing Choices Color Management

Custom Print Size

I n
Color Management A AL

Color Handling:  Printer Manages Colors +
Image Space: sRGB IEC61966-2.1
Printer Profile: | SS=i=mms— *

jering Intent: | P | >

' Did you remember to enable color management
in the printer preferences dialog?

0K Cancel Help

2. On the printer driver's print dialog, select Print Settings from the pop-up menu, and then select Advanced
B&W Photo as the Color setting.

3. Click Advanced Color Settings.

4. Check other settings, and then start printing.

Printing with Auto Color Correction
The printer driver for this printer comes with the Epson proprietary function PhotoEnhance that makes the most
efficient use of the color reproduction area, corrects image data to improve colors before printing.

By using PhotoEnhance, you can correct photo colors to match the subject types such as people, scenery, or night
view. You can print color data in sepia or black and white. Colors are automatically corrected simply by selecting
the print mode.
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Note:
It is recommended that you use images with a color space of sSRGB.

1.

When using applications featuring a color management function, specify how to adjust colors from these
applications.

When using applications without a color management function, start from step 2.

Depending on the type of the application, make the settings following the table below.

Application Color Management Settings

Adobe Photoshop CS3 or later Printer Manages Colors
Adobe Photoshop Lightroom 1 or later

Adobe Photoshop Elements 6 or later

Other applications No Color Management

Setting example for Adobe Photoshop Elements 2020
Click More Options on the print screen.

Select Color Management, and then select Printer Manages Colors from Color Handling. Click OK, and
then click Print on the print screen.

More Options

Printing Choices Color Management

Custom Print Size

I n
Color Management A AL

Color Handling:  Printer Manages Colors +
Image Space: sRGB IEC61966-2.1
Printer Profile: | S —— *

jering Intent: | F ptual >

' Did you remember to enable color management
in the printer preferences dialog?

0K Cancel Help

On the printer driver's print dialog, select Color Matching from the pop-up menu, and then click EPSON
Color Controls.

Note:
EPSON Color Controls is unavailable in Adobe Photoshop CS3 or later, Adobe Photoshop Lightroom 1 or latet, and
Adobe Photoshop Elements 6 or later unless the setting in step 1 is made.

Select Print Settings from the pop-up menu, select PhotoEnhance from Color Settings, and then click
Advanced Color Settings.

Choose the effects that will be applied to the print data in the Advanced Color Settings screen.

Check other settings, and then start printing.
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Printing Banners

You can print banners and panoramic pictures if you create and set print data for banner printing in your
application.

To print banners, select Roll Paper as the Paper Source in the printer driver.

You can print data created by document preparation software, image editing software, and so on. If you use image
editing software, create print data at a size supported by the given application while maintaining the printing
length and width ratio.

The following printing sizes are available.

Width SC-P900 Series: 431.8mm
SC-P700 Series: 330.2mm

Length* Max. 18m

*. The paper length can be longer if using applications that support banner printing. However, the actual print size depends
on the application, the paper size loaded in the printer, and the computer environment.

1.  On the printer driver's print dialog, select the size of the data created with the application in Paper Size.
If items on the Page Setup screen are not displayed on the Print screen due to the application being used,
display the Page Setup screen and make settings.

2. Check other settings, and then start printing.

Printing by Increasing Black Density

To print by increasing black density, use black enhance overcoat in the printer driver. This feature overcoats light
gray ink on the dark parts of printouts to increase the maximum density of black and to increase the dynamic
range.

Black enhance overcoat is only available for glossy paper. Note that it is not available for all types of glossy paper.

Image effects for black enhance overcoat
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Note:
Enabling black enhance overcoat increases black density, and disabling it increases print speed.

1. When using applications featuring a color management function, specify how to adjust colors from these
applications.
When using applications without a color management function, start from step 2.

Depending on the type of the application, make the settings following the table below.

Application Color Management Settings

Adobe Photoshop CS3 or later Printer Manages Colors
Adobe Photoshop Lightroom 1 or later

Adobe Photoshop Elements 6 or later

Other applications No Color Management

Note:

For information on the operating systems supported by each application, visit the distributor’s website.
Setting example for Adobe Photoshop Elements 2020

Click More Options on the print screen.

Select Color Management, and then select Printer Manages Colors from Color Handling. Click OK, and
then click Print on the print screen.

More Options

Printing Choices Color Management
Custom Print Size

I n
Color Management A AL

Color Handling:  Printer Manages Colors +

Image Space: sRGB IEC61966-2.1

Printer Profile: | S -

jering Intent: | F | >

' Did you remember to enable color management
in the printer preferences dialog?

0K Cancel Help

2. On the printer driver's print dialog, select Print Settings from the pop-up menu, and then select Quality
Options as Print Quality.

64



Printing > Printing Photos > Printing Using Epson Photo+

3. Select Black Enhance Overcoat.

If the check box is grayed out, move the slider for the quality level to Speed to enable the check box.

Print Settings [ |

Liiole Advanced Color Settings

Page Setup: Standard
Media Type: Use Printer Settings
Color: Color [T ]

Color Settings: EPSON Standard (sRGB) &)

Print Quality: Standard T
Speed -
Print Quality: SuperFine - 1440dpi

[ Black Enhance Overcoal ]

Quality

4. Ifyou want to further increase black density, select Max Quality (Carbon Black) as the Print Quality.

5. Check other settings, and then start printing.

Printing Using Epson Photo+

Epson Photo+ an application that performs easy edits such as automatic color correction, while also allowing you
to make manual corrections or adjust the layout.

You can install Epson Photo+ from the Epson Web site.

Epson Photo+ automatically corrects backlight and subtle skin colors allowing you to print beautiful photos easily.
You can also turn off auto correction (PhotoEnhance).

The following four steps are the main operations. For details on each operation, access the Help from the button at
the top-right of the Epson Photo+ screen. (The screenshots used in the following examples are from Windows 10.)
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1. Select a menu according to your needs.

B teson Prote. - o x
f BB Frier | EPSON 2000 Series f
A A
~ 2 e
P B | |l
Phota Photo Layout Free Layout Thuribrasil
=i\
L )
- \ 4o
co/ovD ~ewel Case Dacuments

2. Select the template or paper size depending on the selected menu.
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3. Select the photo you want to print.

Sebect Photes

€

A > PC > Wirdows () » Phote Ssmple

Intel

i

PerlLogs
Fhate, Samphe
Program Fikes >

Frogram Files (<85) pJ

Wirdews >

e —+——@ i B e carcel

4. Edit and print.

B tpson Pmotes

- o 4
= @ SR = = L L v (7]
Fie futa R e Help
a E EPSOM 000K Senes.
* [Pt M.

A Ty B
“ P Pager S

uron
W8 Reor Fapar Fasder

T, Media Tyoe
L:SJ Erwon Prisiurn Glgsy

Print Gusiity
Stands

Prirt, Page
Al phges

You can perform the following edits.

[ Color correction (light, contrast, intensity)
U Adjust layout

O Add to/crop the screen

Q Input text

0 Add stamps (Pictographs, emoticons, some types of LINE stamps)
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Printing Information About Photo Printing

Photo print information for the last 12 sheets is saved in the printer. For example, if you print three copies of a
photo, the printer saves three print histories. You can print photo information by selecting the information you
want to print. However, information about photo printing is deleted when the printer is turned off.

Thumbnails and print setting are printed for each photo. You can cut these out and save them as notes about the
print job.

1. Load the A4 size paper in the printer.

Information for three photos is printed on one A4 size paper. To print 12 sets of information, load four sheets
of paper.

2. Select on the home screen.

3. Check the thumbnails of the photos that you want to print on the Print Information Sheet screen.

e Print Information Sheet
2019-02-19 10:00:00 /|\
Sample2.jpg

Media Type Plain Paper

Max Quality
Mode EPSON Standard]...

4. Select Done and then start printing on the next screen.
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Printing Documents

Printing from a Computer - Windows

Printing Using Easy Settings

Note:
Operations may differ depending on the application. See the application’s help for details.

1. Load paper in the printer.
2. Open the file you want to print.
3. Select Print or Print Setup from the File menu.

4. Select your printer.
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5.

6.

Select Preferences or Properties to access the printer driver window.

= EPSON X000 Serves Printing Preferences
S Man [1] Layout . Uity
Select Setting: | Current Settings o Save/Del...
Media Settings
Media TYPE: | Eneon Premium Glossy o
Print Mode: | Color e Paper Config...
Level: Standard ~
[[Jelack Enhance Overcoat
Mode: EPSON Standard (sR.GB) e Advanced...
Paper Settings
Source: Rear Paper Feeder e
gi“;:f"‘“'f 44 210 x 297 mm ~ User Defined...
[ Barderless
Ink Levels
[Jerint Preview :
[JLayout Manager | ‘ ‘
Ciriver Paper Setbngs ,
[l riceity ME PK GY LGY C WM LC VLM ¥ W
Restore Default Show Settings... Version XX

Change the settings as necessary.
See the menu options for the printer driver for details.

Note:

U You can also see the online help for explanations of the setting items. Right-clicking an item displays Help.

U When you select Print Preview, you can see a preview of your document before printing.

Click OK to close the printer driver window.

Click Print.
Note:

(J When you select Print Preview, a preview window is displayed. To change the settings, click Cancel, and then repeat

the procedure from step 3.

U If you want to cancel printing, on your computer right-click on your printer in Devices and Printers, Printer, or
in Printers and Faxes. Click See what's printing, right-click on the job you want to cancel, and then select Cancel.
However, you cannot cancel a print job from the computer once it has been completely sent to the printer. In this

case, cancel the print job by using the printer’s control panel.
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Related Information

= “Available Paper and Capacities” on page 187
= “Menu Options for the Printer Driver” on page 71

Menu Options for the Printer Driver
Open the print window in an application, select the printer, and then access the printer driver window.

Note:
Menus vary depending on the option you selected.

Main Tab

Select Setting:
Save/Del:

You can add or remove your own presets for frequently used print settings. Select the preset you want
to use from the list.

Media Type:
Select the type of paper on which you print.

Print Mode:

Select whether to print in color or in monochrome.

Level:

Select the pint quality you want to use for printing. Available settings depend on the paper type
you select. When selecting higher quality, the printing speed may be slower. If you select Quality
Options, you can make detailed settings.

Gloss Smoothing:

Select this option when printing on photo paper to reduce the amount of light that is reflected
off black areas and achieve a smoother gloss. However, black density may decrease. Gloss
Smoothing is available when you have selected Photo Paper as the Media Type. This option
may not be available depending on the print quality settings.

Black Enhance Overcoat:
Select to print with enhanced image contrast and tones of black. This option can only be selected for
supported paper.

Mode:
Make the color tone settings for the prints. Available options depend on the Print Mode setting.
Clicking Advanced opens the Color Controls screen where you can select a detailed method of color
correction.

Source:

Select the paper source from which the paper is fed.
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Document Size:
Select the size of the print file set in the application. If a predefined paper size is not available, click
User Defined to set your own paper size.

Borderless:
Enlarges the print data slightly more than the paper size so that no margins are printed around the
edges of the paper. Click Expansion to select the amount of enlargement.

Print Preview:

Displays a preview of your document before printing.

Layout Manager:

When you check this box and start printing, the print jobs are arranged and displayed on the Layout
Manager dialog box. You can arrange data created by different applications in order of preference and
combine them into a single print job.

Note:
You cannot make settings other than Document Size when Layout Manager is checked. Make the detailed
print settings on the Layout Manager dialog box.

Driver Paper Settings Priority:

You can print using the paper type and the paper size set in the printer driver. The paper type, paper
size, and Paper Mismatch settings set on the printer control panel are disabled.

If you select paper which has been added by Epson Media Installer in the paper setting, this setting is
not applied.
Ink Levels:

Displays the approximate ink level.

Restore Default:

Return all settings to their factory default values. The settings on the Layout tab are also reset to their
defaults.

Show Settings:

Displays a list of items currently set on the Main and Layout tabs. You can show or hide the current
setting list screen.

Layout Tab

Select Setting:
Save/Del:

You can add or remove your own presets for frequently used print settings. Select the preset you want
to use from the list.

Orientation:

Select the orientation you want to use to print.

Rotate 180°:
Rotates pages 180 degrees before printing.
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Mirror Image:

Inverts the image so that it prints as it would appear in a mirror.

Copies:

Set the number of copies you want to print.

Collate:

Prints multi-page documents collated in order and sorted into sets.

Reverse Order:
Allows you to print from the last page so that the pages are stacked in the correct order after
printing.
Paper Size:

Select the size of the print file set in the application.

Output Size:

Select the paper size on which you want to print. If the Paper Size differs from the Output Size,
Reduce/Enlarge is selected automatically. You do not have to select it when printing without
reducing or enlarging the size of a document.

Reduce/Enlarge:

Allows you to reduce or enlarge the size of a document.

Fit to Output Size:

Automatically reduce or enlarge the document to fit to the paper size selected in Output Size.

Fit to Roll Paper WidthFit to Output Size:

Automatically reduce or enlarge the document to fit to the roll paper size selected in Output
Size. This option is available when Roll Paper is selected as the Source.

Specify Size:

Prints with a specific percentage.

Page Layout:

Allows you to print several pages on one sheet or perform poster printing. Click Settings to specify
the order in which pages are printed.

2-sided printing:

Allows you to perform 2-sided printing.

Margins:

You can specify the binding edge and the binding margins.

Folded Booklet:
Select this check box if you wish to print a single-fold booklet.
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Optimize Enlargement:
Select this check box to optimize an enlargement to achieve long poster or panoramic printing
without using a particular application. Clear this check box if text or graphics are distorted; however,
output length may be limited depending on the application.

Print Bckg Color:

Select this check box to print a background color. Click Color Settings to select a background color.

Job Settings:
Select this check box to print the settings items. Click Details to open the Job Settings dialog box to
select the setting items to print.

Reset Defaults:
Return all settings to their factory default values. The settings on the Main tab are also reset to their
defaults.

Show Settings:

Displays a list of items currently set on the Main and Layout tabs. You can show or hide the current
setting list screen.

Utility Tab

Nozzle Check:

Prints a nozzle check pattern to check if the print head nozzles are clogged.

Print Head Cleaning:
Cleans the clogged nozzles in the print head. Because this feature uses some ink, clean the print head
only if the nozzles are clogged. Print a nozzle check pattern and then select Cleaning if there are just
a few defects in the pattern. Power Cleaning consumes more ink than Cleaning. Only use this if
there are many defects in the nozzle check pattern.

EPSON Status Monitor 3:
Opens the EPSON Status Monitor 3 window. Here you can confirm the status of the printer and the
consumables.

Monitoring Preferences:

Allows you to select settings for items on the EPSON Status Monitor 3 window.

Print Queue:

Displays the jobs waiting to be printed. You can check, pause, or resume print jobs.

Printer and Option Information:
Click to display the Printer and Option Information dialog box. You can view and make settings for
the optional information.

Speed and Progress:

Allows you to make a variety of settings related to printing speed and progress. Right-click each item
to view the online help for more details.
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Menu Arrangement:
You can arrange the Select Setting and Paper Size list items. Arrange the items as you prefer, or
classify the items into groups. You can also hide the items you are not using.

Export or Import:
You can export or import the printer driver settings. It is convenient to use this feature when you
want to make the same printer driver settings to multiple computers.

Epson Media Installer:

You can add media setting to printers and printer drivers from the Internet. Click when you cannot
find the media you want to print on in the driver's media types. Depending on the media you are
using, you may not be able to download media settings.

See the related information link below for details.

Language:

Changes the language to be used on the printer driver window. To apply the settings, close the printer
driver, and then open it again.

Software Update:

Starts EPSON Software Updater to check for the latest version of applications on the Internet.

Related Information

= “Printing to Paper Types Other than Genuine Paper” on page 197

Adding Printing Presets for Easy Printing

If you create your own preset of frequently used print settings on the printer driver, you can print easily by
selecting the preset from the list.

\
...

\
...

1. On the printer driver's Main or Layout tab, set each item (such as Media Type and Source).
“Main Tab” on page 71
“Layout Tab” on page 72

2. Click Save/Del in Select Setting.

3. Enter a Name and, if necessary, enter a comment.
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5.

Click Save.

Note:
To delete an added preset, click Save/Del, select the preset name you want to delete from the list, and then delete it.

Click Print.

The next time you want to print using the same settings, select the registered setting name from Select Setting, and
click OK.

Related Information

= “Printing Using Easy Settings” on page 69

Printing on 2-Sides

The printer driver will automatically print odd pages and even pages separately. When the odd pages have been
printed, turn over the paper according to the instructions and print the even pages.
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Note:

a

a
a
g
g

This feature is not available for borderless printing.

2-sided printing is supported with the rear paper feeder only.

If you do not use paper that is suitable for 2-sided printing, the print quality may decline and paper jams may occur.
Depending on the paper and the data, ink may bleed through to the other side of the paper.

You cannot perform manual 2-sided printing unless EPSON Status Monitor 3 is enabled. If EPSON Status Monitor 3 is
disabled, access the printer driver window, click Speed and Progress on the Utility tab, and then clear Disable EPSON
Status Monitor 3.

However, it may not be available when the printer is accessed over a network or is used as a shared printer.

On the printer driver's Layout tab, select 2-sided printing.

When Roll Paper is selected as the Source setting, you cannot select 2-sided printing. In this case, set the
Source first from the Main screen.

Click Margins, make the appropriate settings, and then click OK.

Set the other items on the Main and Layout tabs as necessary, and then click OK.
“Main Tab” on page 71
“Layout Tab” on page 72
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4. Click Print.

When the first side has finished printing, a pop-up window is displayed on the computer. Follow the on-screen
instructions.

Related Information

= “Available Paper and Capacities” on page 187
= “Printing Using Easy Settings” on page 69

Printing a Booklet

You can also print a booklet that can be created by re-ordering the pages and folding the printout.

s || # 1 4

Note:
L This feature is not available with borderless printing.

QO 2-sided printing is supported with the rear paper feeder only.
U If you do not use paper that is suitable for 2-sided printing, the print quality may decline and paper jams may occut.
U Depending on the paper and the data, ink may bleed through to the other side of the paper.

O You cannot perform manual 2-sided printing unless EPSON Status Monitor 3 is enabled. If EPSON Status Monitor 3 is
disabled, access the printer driver window, click Speed and Progress on the Utility tab, and then clear Disable EPSON
Status Monitor 3.

U However, it may not be available when the printer is accessed over a network or is used as a shared printer.
1. On the printer driver's Layout tab, select 2-sided printing and Folded Booklet.

2. Click Margins, and then specify the binding edge and the binding margins.

3. Click OK.

4. Set the other items on the Main and Layout tabs as necessary, and then click OK.
“Main Tab” on page 71
“Layout Tab” on page 72
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5. Click Print.

Related Information

= “Available Paper and Capacities” on page 187
= “Printing Using Easy Settings” on page 69

Printing Several Pages on One Sheet

You can print several pages of data on a single sheet of paper.
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Note:
This feature is not available with borderless printing.

1. On the printer driver's Layout tab, and then select Page Layout and N-up.
2. Click Settings, make the appropriate settings, and then click OK.

3. Set the other items on the Main and Layout tabs as necessary, and then click OK.
“Main Tab” on page 71
“Layout Tab” on page 72

4. Click Print.

Related Information

= “Printing Using Easy Settings” on page 69
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Printing to Fit the Paper Size

Select the paper size you loaded in the printer as the Output Size setting.

&
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N

1. On the printer driver's Layout tab, make the following settings.
O Paper Size: Select the size of the print file set in the application.

O Output Size: Select the paper size you loaded in the printer.

Fit to Output Size is automatically selected.

2. Set the other items on the Main and Layout tabs as necessary, and then click OK.
“Main Tab” on page 71
“Layout Tab” on page 72

3. Click Print.

Related Information

= “Printing Using Easy Settings” on page 69

Printing to Fit to Roll Paper Width

You can print according to the width of the roll paper loaded in the printer.

1. On the printer driver's Main tab, select Roll Paper from Source.

2. Select the Layout tab, and then select a paper size from Page Size that matches the document size.
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3. Select Reduce/Enlarge and click Fit to Roll Paper Width.
4. Select the width of the roll paper loaded in the printer from Roll Width.

5. Set the other items on the Main and Layout tabs as necessary, and then click OK.
“Main Tab” on page 71
“Layout Tab” on page 72

6. Click Print.

Related Information

= “Printing Using Easy Settings” on page 69

Printing a Reduced or Enlarged Document at any Magnification

You can reduce or enlarge the size of a document by a specific percentage.

a—
= / """""
Note:

This feature is not available with borderless printing.

1. On the printer driver's Layout tab, select the document size from the Paper Size setting.
2. Select the paper size you want to print on from the Output Size setting.

3. Select Reduce/Enlarge, Specify Size, and then enter a percentage.

4. Set the other items on the Main and Layout tabs as necessary, and then click OK.
“Main Tab” on page 71
“Layout Tab” on page 72

5. Click Print.

Related Information

= “Printing Using Easy Settings” on page 69
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Printing One Image on Multiple Sheets for Enlargement (Creating a Poster)

This feature allows you to print one image on multiple sheets of paper. You can create a larger poster by taping
them together.

-

1. On the printer driver's Layout tab, select Page Layout and Poster.

=

2. Click Settings, make the appropriate settings, and then click OK.

Note:
Print Cutting Guides allows you to print a cutting guide.

3. Set the other items on the Main and Layout tabs as necessary, and then click OK.
“Main Tab” on page 71
“Layout Tab” on page 72

4. Click Print.

Related Information

= “Printing Using Easy Settings” on page 69
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Making Posters Using Overlapping Alignment Marks

Here is an example of how to make a poster when 2x2 is selected, and Overlapping Alignment Marks is selected
in Print Cutting Guides.

sheet 1 l @ l sheet 2

@
—>

sheet 3 sheet 4

1. Prepare Sheet 1 and Sheet 2. Cut off the margins of Sheet 1 along the vertical blue line through the center of
the top and bottom cross marks.
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2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily tape the two sheets
together from the back.
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3. Cut the taped sheets in two along the vertical red line through the alignment markers (this time, the line to the
left of the cross marks).
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4. Tape the sheets together from the back.
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5. Repeat steps 1 to 4 to tape Sheet 3 and Sheet 4 together.

6. Cut off the margins of Sheet 1 and Sheet 2 along the horizontal blue line through the center of the left and right
side cross marks.
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7.

Place the edge of Sheet 1 and Sheet 2 on top of Sheet 3 and Sheet 4 and align the cross marks, and then

temporarily tape them together from the back.
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8. Cut the taped sheets in two along the horizontal red line through the alignment markers (this time, the line
above the cross marks).
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9. Tape the sheets together from the back.
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10. Cut off the remaining margins along the outer guide.
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Adjusting the Print Color

You can adjust the colors used in the print job. These adjustments are not applied to the original data.

=)
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You can select from the following color correction modes.

1. On the printer driver's Main tab, select the method of color correction from the Mode setting.

(1 EPSON Standard (sRGB)

Increases the contrast in images. Use this setting for color photographs.
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(J Adobe RGB

Matches image color to the Adobe RGB. Use this setting for data that contains Adobe RGB color space
information.

(1 PhotoEnhance

PhotoEnhance is a feature that uses Epson's proprietary image analysis and processing technology to
automatically print images at a higher quality.

a ICM

Select this setting when you use the Windows ICM (Image Color Matching) feature to match colors
between devices such as the printer and screen display.

Click Advanced if you want to make your own settings.

2. Set the other items on the Main and Layout tabs as necessary, and then click OK.
“Main Tab” on page 71
“Layout Tab” on page 72

3. Click Print.

Related Information

= “Printing Using Easy Settings” on page 69

Printing Multiple Files Together (Layout Manager)
The Layout Manager function allows you to place multiple pieces of print data created in different applications on
the paper freely and print them at once.

You can create a poster or display material by placing multiple pieces of print data where you like. Also, Layout
Manager allows you to use paper effectively.

IIIIIIIII:I
3

1. Open the file you want to print in your application.

2. On the printer driver's Main tab, select Layout Manager and in Document Size set the paper size created
using the application.

Note:
The option selected for Size is the size used in the Layout Manager. The actual printing paper size is set in the screen in
step 6.

88



Printing > Printing Documents > Printing from a Computer - Mac OS

Click OK. When printing with an application, the Layout Manager screen opens.

The print data is not printed, but one page is placed on the paper of the Layout Manager screen as one object.

Leave the Layout Manager screen open and repeat steps 1 to 3 to arrange the next pieces of data.

The objects are added to the Layout Manager screen.

Arrange the objects on the Layout Manager screen.

You can drag objects to move and resize them, use tool buttons and the Object menu to align and rotate
objects on the Layout Manager screen.

You can resize and replace whole objects in the Preference or Arrangement Settings screens.

See the Layout Manager screen help for more details on each feature.

Click File > Properties, and make print settings on the printer driver screen.

Set Media Type, Source, Document Size, and so on.

Click the File menu on the Layout Manager screen, and then click Print.

Related Information

= “Printing Using Easy Settings” on page 69

Printing from a Computer - Mac OS

Printing Using Easy Settings

Note:
Operations and screens differ depending on the application. See the application’s help for details.

1.

Load paper in the printer .
Open the file you want to print.

Select Print from the File menu or another command to access the print dialog.

If necessary, click Show Details or ¥ to expand the print window.

Select your printer.
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5. Select Print Settings from the pop-up menu.

Printer:  EPSON XXXX <]
Presets: Default Settings | <]
Copies: 1
Pages: © All
From: 1 to: 1
Paper Size: A4 & 210 by 207 mm

Orientation: t i Ta
Print Settings ﬁ

iilel Advanced Color Settings
Page Setup: Standard

Media Type: Use Printer Settings Ko
Color: Color <]
Color Settings: EPSON Standard (sRGB) H
Print Quality: Standard &
Speed Quality

Print Quality: SuperFine - 1440dpi

Print Preview

cancel (NN

Note:
If the Print Settings menu is not displayed on macOS High Sierra, macOS Sierra, OS X El Capitan, OS X Yosemite, OS
X Mavericks, the Epson printer driver has not been installed correctly. Enable it from the following menu.

Select System Preferences from the Apple menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the
printer, and then add the printer again. See the following to add a printer.

“Adding the Printer (for Mac OS Only)” on page 113

macOS Mojave or later cannot access Print Settings in applications made by Apple such as TextEdit.

6. Change the settings as necessary.

See the menu options for the printer driver for details.

7. Click Print.

Note:
If you want to cancel printing, on your computer click the printer icon in the Dock. Select the job you want to cancel,

and then click next to the progress meter. However, you cannot cancel a print job from the computer once it has
been completely sent to the printer. In this case, cancel the print job by using the printer’s control panel.

Related Information

= “Available Paper and Capacities” on page 187
= “Menu Options for the Printer Driver” on page 91
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Menu Options for the Printer Driver

Open the print window in an application, select the printer, and then access the printer driver window.

Note:
Menus vary depending on the option you selected.

Menu Options for Layout

Pages per Sheet:

Select the number of pages to be printed on one sheet.

Layout Direction:

Specify the order in which the pages will be printed.

Border:

Prints a border around the pages.

Reverse page orientation:

Rotates pages 180 degrees before printing.

Flip horizontally:

Inverts an image to print as it would appear in a mirror.

Menu Options for Color Matching

ColorSync/EPSON Color Controls:

Select the method for color adjustment. These options adjusts colors between the printer and the
computer display to minimize the difference in color.

Menu Options for Paper Handling

Collate pages:

Prints multi-page documents collated in order and sorted into sets.

Pages to Print:

Select to print only odd pages or even pages.

Page Order:
Select to print from the first or the last page.

Scale to fit paper size:
Prints to fit to the paper size you loaded.

O Destination Paper Size:

Select the paper size to print on.
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O Scale down only:

Select this when you want to reduce the size only if the print data is too large for the paper size
loaded in the printer.

Menu Options for Cover Page

Print Cover Page:

Select whether or not to print a cover page. When you want to add a back cover, select After document.

Cover Page Type:

Select the contents of the cover page.

Menu Options for Print Settings

Basic:

Page Setup:
Displays the paper setting or Standard selected in Paper Size.

Media Type:
Select the type of paper on which you print.

Color:

Select whether to print in color or in monochrome.

Color Settings:
Make the color tone settings for the prints. If Advanced B&W Photo is selected as the Color setting, set
the color tone for Color Toning.

Print Quality:
Select the pint quality you want to use for printing. The options vary depending on the paper type.

Black Enhance Overcoat:
Select to print with enhanced image contrast and tones of black. Black Enhance Overcoatcan only be
selected for supported paper.

Gloss Smoothing:

Select this option when printing on photo paper to reduce the amount of light that is reflected off black
areas and achieve a smoother gloss. However, black density may decrease. Gloss Smoothing is available
when you have selected Photo Paper as the Media Type. This option may not be available depending
on the print quality settings.

High Speed:

Prints when the print head moves in both directions. The print speed is faster, but the quality may
decline.
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Finest Detail:
Depending on the Print Quality setting you select, you can turn on Finest Detail to print text, solid
graphics, and line art with very sharp edges.

Bottom Edge Print Quality Priority:

This feature improves unevenness in printing at the bottom edge of the paper. Select this when the print
results on glossy paper are uneven, such as faint bands in dark areas at the bottom edge. You can select
Bottom Edge Print Quality Priority when glossy paper is selected as the Media Type. Since priority is
given to improving the unevenness, the printing speed will be slower.

Print Preview:

Displays a preview of your document before printing.

Advanced Color Settings:

You can set the gamma and adjust brightness, contrast, and saturation.

Print Preview:

Displays a preview of your document before printing.

Menu Options for Page Layout Settings

Roll Paper Option:

You can make settings related to roll paper printing, such as Auto Rotate and Print page frame.

Expansion:

You can adjust the amount of protrusion during borderless printing.

Menu Options for Paper Configuration

Color Density:

Adjusts the strength of Color Density. Drag the slider to the right or left with your mouse to adjust the
setting. You can also type a number in the box next to the slider.

Menu Options for Supply Levels
Displays the approximate ink level.
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Adding Printing Presets for Easy Printing

If you create your own preset of frequently used print settings on the printer driver, you can print easily by
selecting the preset from the list.

N
ih...

N
...

1. Set each item such as Print Settings and Layout (Media Type, Color, and so on).
2. Click Presets to save the current settings as a preset.

3. Click OK.

Note:
To delete an added preset, click Presets > Show Presets, select the preset name you want to delete from the list, and then
delete it.

4. Click Print.

The next time you want to print using the same settings, select the registered preset name from the Presets.

Related Information

= “Printing Using Easy Settings” on page 89

Printing Several Pages on One Sheet

You can print several pages of data on a single sheet of paper.
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1. Select Layout from the pop-up menu.
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2. Set the number of pages in Pages per Sheet, the Layout Direction (page order), and Border.
“Menu Options for Layout” on page 91

3. Select other settings as necessary.

4. Click Print.

Related Information

= “Printing Using Easy Settings” on page 89

Printing to Fit the Paper Size

Select the paper size you loaded in the printer as the Destination Paper Size setting.

7
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1. Select Paper Handling from the pop-up menu.

2. Select Scale to fit paper size.

3. Select the paper size you loaded in the printer as the Destination Paper Size setting.
4. Set the other items as necessary.

5. Click Print.

Related Information

= “Printing Using Easy Settings” on page 89
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Printing a Reduced or Enlarged Document at any Magnification

You can reduce or enlarge the size of a document by a specific percentage.

B
= / """""
Note:

Operations differ depending on the application. See the application’s help for details.

1. Do one of the following.

O Select Print from the File menu of the application. Click Page Setup, and then select your printer in
Format For. Select the size of the data to be printed from Paper Size, enter a percentage in Scale, and then
click OK.

[ Select Page Setup from the File menu of the application. Select your printer in Format For. Select the size
of the data to be printed from Paper Size, enter a percentage in Scale, and then click OK. Select Print from
the File menu.

2. Select your printer in Printer.

3. Select other settings as necessary.

4. Click Print.

Related Information

= “Printing Using Easy Settings” on page 89

Adjusting the Print Color

You can adjust the colors used in the print job. These adjustments are not applied to the original data.

=

([
[ =
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Printing > Printing Documents > Printing Documents from Smart Devices (iOS)

PhotoEnhance produces sharper images and more vivid colors by automatically adjusting the contrast, saturation,
and brightness of the original image data.

Note:

PhotoEnhance adjusts the color by analyzing the location of the subject. Therefore, if you have changed the location of the
subject by reducing, enlarging, cropping, or rotating the image, the color may change unexpectedly. Selecting the borderless
setting also changes the location of the subject resulting in changes in color. If the image is out of focus, the tone may be
unnatural. If the color is changed or becomes unnatural, print in a mode other than PhotoEnhance.

1. Select Color Matching from the pop-up menu, and then select EPSON Color Controls.

2. Select Print Settings from the pop-up menu.

3. On the Basic tab, select the type of color correction from Color Settings.

4. Select the Advanced Color Settings tab, and then set the Gamma, Brightness, Contrast, Saturation, and so on.
5. Set the other items as necessary.

6. Click Print.

Related Information

= “Printing Using Easy Settings” on page 89

Printing Documents from Smart Devices (iOS)

You can print documents from a smart device such as a smartphone or tablet.

— =]

Printing Documents Using Epson Smart Panel

Note:
Operations may differ depending on the device.

1. Load paper in the printer.
“Loading Paper” on page 27

2. Set up your printer for wireless printing.

3. If Epson Smart Panel is not installed, install it.

»

“Application for Easily Operating the Printer from a Smart device (Epson Smart Panel)” on page 209
4. Connect your smart device to the same wireless network as your printer.

5. Start Epson Smart Panel.

97



Printing > Printing Documents > Printing Documents from Smart Devices (Android)

6. Tap Print Documents on the home screen.
7. Tap Select Document.
8. Tap the location of the document you want to print, and then select the document.

9. Tap Print.

Printing Documents Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, iPod touch, and Mac without the need to install
drivers or download software.

Il Works with
B3 Apple AirPrint

Note:
If you disabled paper configuration messages on your printer control panel, you cannot use AirPrint. See the link below to
enable the messages, if necessary.

1. Load paper in the printer.

“Loading Paper” on page 27

2. Set up your printer for wireless printing. See the link below.

http://epson.sn
3. Connect your Apple device to the same wireless network that your printer is using.

4. Print from your device to your printer.

Note:
For details, see the AirPrint page on the Apple website.

Related Information

= “Cannot Print Even Though a Connection has been Established (i0S)” on page 139

Printing Documents from Smart Devices (Android)

You can print documents from a smart device such as a smartphone or tablet.

— =]
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Printing > Printing Documents > Printing Documents from Smart Devices (Android)

Printing Documents Using Epson Smart Panel

Note:
Operations may differ depending on the device.

1. Load paper in the printer.
“Loading Paper” on page 27

2. Set up your printer for wireless printing.

3. If Epson Smart Panel is not installed, install it.

“Application for Easily Operating the Printer from a Smart device (Epson Smart Panel)” on page 209
4. Connect your smart device to the same wireless network as your printer.
5. Start Epson Smart Panel.
6. Tap Print Documents on the home screen.
7. Tap Select Document.
8. Tap the location of the document you want to print, and then select the document.

9. Tap Print.

Printing Using Mopria Print Service
Mopria Print Service enables instant wireless printing from Android smart phones or tablets.

s
-
Mopriay
1. Install Mopria Print Service from Google Play.

2. Load paper in the printer.

3. Set up your printer for wireless printing. See the link below.

http://epson.sn
4. Connect your Android device to the same wireless network that your printer is using.

5. Print from your device to your printer.

Note:
For more details, access the Mopria Web site at https://mopria.org.

Related Information

= “Loading Paper” on page 27
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Printing > Printing Using a Cloud Service > Registering to Epson Connect Service from the Control Panel

Printing Using a Cloud Service

By using Epson Connect service available on the Internet, you can print from your smartphone, tablet PC, or
laptop, anytime and practically anywhere. To use this service, you need to register the user and the printer in Epson
Connect.

The features available on the Internet are as follows.

(J Email Print

When you send an email with attachments such as documents or images to an email address assigned to the
printer, you can print that email and the attachments from remote locations such as your home or office printer.

(J Remote Print Driver

This is a shared driver supported by Remote Print Driver. When printing using a printer in a remote location,
you can print by changing the printer on the usual applications window.

See the Epson Connect web portal for details on how to setup or print.
https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

Registering to Epson Connect Service from the Control Panel

Follow the steps below to register the printer.

1. Select FF on the control panel.

2. Select General Settings > Web Service Settings > Epson Connect Services > Register > Start Setup to print
the registration sheet.

3. Follow the instructions on the registration sheet to register the printer.
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Maintaining the Printer > improving Print Quality > Checking and Cleaning the Print Head

Checking the Status of Consumables

You can check the approximate ink levels and the approximate service life of the maintenance box from the control
panel or the computer.

Note:
You can continue printing while the ink low message is displayed. Replace the ink cartridges when required.

Checking the Status of Consumables (Control Panel)
Select ‘ on the printer's control panel.

Checking the Status of Consumables (Windows)
1. Access the printer driver window.

2. Click EPSON Status Monitor 3 on the Utility tab.

Note:
If EPSON Status Monitor 3 is disabled, click Speed and Progress on the Utility tab, and then clear
Disable EPSON Status Monitor 3.

Checking the Status of Consumables (Mac OS)

1. Select System Preferences from the Apple menu > Printers & Scanners (or Print & Scan, Print
& Fax), and then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.
3. Click EPSON Status Monitor.

Related Information

= “It is Time to Replace the Ink Cartridges” on page 146
= “It is Time to Replace the Maintenance Box” on page 147

Improving Print Quality

Checking and Cleaning the Print Head

If the nozzles are clogged, the printouts become faint, there is visible banding, or unexpected colors appear. If the
nozzles are severely clogged, a blank sheet will be printed. When print quality has declined, first use the nozzle
check feature to check if the nozzles are clogged. If the nozzles are clogged, clean the print head.
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g Important:

1 Do not open the printer cover or turn off the printer during head cleaning. If the head cleaning is incomplete, you
may not be able to print.

U Head cleaning consumes ink and should not be performed more than necessary.
O When ink is low, you may not be able to clean the print head.

Q Ifprint quality has not improved after repeating nozzle check and head cleaning 3 times, wait for at least 6 hours
without printing, and then run the nozzle check again and repeat the head cleaning if necessary. We recommend

turning off the printer by using the O button. If print quality has still not improved, run Power Cleaning.

QO To prevent the print head from drying out, do not unplug the printer while the power is on.

Checking and Cleaning the Print Head (Control Panel)

1. Load A4-size plain paper in the printer.
“Loading Paper in the Rear Paper Feeder” on page 30

2. Select E on the printer's control panel.

3. Select Maintenance.

4. Select Print Head Nozzle Check.

5. Follow the on-screen instructions to print the nozzle check pattern.

6. Check the printed pattern to see if the print head nozzles are clogged.

B) NG C) NG

J A:

All lines are printed. Select O No further steps are needed.
U B or close to B:

Some nozzles are clogged. Select ><, and then select Head Cleaning on the next screen.

O C or worse than C:

If most lines are missing or not printed, this indicates most nozzles are clogged. Select x, and then select
Power Cleaning on the next screen.

7. Follow the on-screen instructions to perform print head cleaning or Power Cleaning.
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Maintaining the Printer > improving Print Quality > Checking and Cleaning the Print Head

8. When cleaning is finished, print the nozzle check pattern again. Repeat cleaning and printing the pattern until
all lines are printed completely.

n Important:

If print quality has not improved after repeating nozzle check and head cleaning 3 times, wait for at least 6
hours without printing, and then run the nozzle check again and repeat the head cleaning if necessary. We

recommend turning off the printer using the O button. If print quality has still not improved, run Power
Cleaning.

Related Information

= “Running Power Cleaning” on page 105

Checking and Cleaning the Print Head (Windows)

1. Load A4 -size plain paper in the printer.
“Loading Paper in the Rear Paper Feeder” on page 30

2. Access the printer driver window.
3. Click Print Head Nozzle Check on the Utility tab.

4. TFollow the on-screen instructions.

n Important:

If print quality has not improved after repeating nozzle check and head cleaning 3 times, wait for at least 6
hours without printing, and then run the nozzle check again and repeat the head cleaning if necessary. We

recommend turning off the printer using the O putton. If print quality has still not improved, run Power
Cleaning.

Related Information

= “Running Power Cleaning” on page 105

Checking and Cleaning the Print Head (Mac OS)

1. Load A4 -size plain paper in the printer.
“Loading Paper in the Rear Paper Feeder” on page 30

2. Select System Preferences from the Apple menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

3. Click Option & Supplies > Utility > Open Printer Utility.

4. Click Print Head Nozzle Check.
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Maintaining the Printer > improving Print Quality > Running Power Cleaning

5. Follow the on-screen instructions.

n Important:

If print quality has not improved after repeating nozzle check and head cleaning 3 times, wait for at least 6
hours without printing, and then run the nozzle check again and repeat the head cleaning if necessary. We

recommend turning off the printer using the O button. If print quality has still not improved, run Power
Cleaning.

Related Information

= “Running Power Cleaning” on page 105

Running Power Cleaning

The Power Cleaning feature may improve print quality in the following cases.
(J When most nozzles are clogged.

J When you have performed a nozzle check and head cleaning 3 times and waited for at least 6 hours without
printing, but print quality still did not improve.

n Important:

The Power Cleaning uses more ink than the print head cleaning.

Running Power Cleaning (Control Panel)

1. Load A4 -size plain paper in the printer.
“Loading Paper in the Rear Paper Feeder” on page 30

2. Select o the printer's control panel.
3. Select Maintenance.
4. Select Print Head Cleaning > Power Cleaning.

5. When cleaning is finished, print the nozzle check pattern again. Check that all of the lines in the nozzle check
pattern are printed correctly.

n Important:

If print quality has not improved after running Power Cleaning, wait for at least 6 hours without printing,
and then print the nozzle check pattern again. Run Head Cleaning or Power Cleaning again depending on the
printed pattern. If quality still does not improve, contact Epson support.

Related Information

= “Checking and Cleaning the Print Head” on page 102
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Maintaining the Printer > improving Print Quality > Preventing nozzle clogging

Running Power Cleaning (Windows)
1. Access the printer driver window.

2. Click Print Head Cleaning on the Utility tab.

3. Select Power Cleaning.

4. TFollow the on-screen instructions.

n Important:

If print quality has not improved after running Power Cleaning, wait for at least 6 hours without printing, and
then print the nozzle check pattern again. Run Cleaning or Power Cleaning again depending on the printed
pattern. If quality still does not improve, contact Epson support.

Related Information

= “Checking and Cleaning the Print Head” on page 102

Running Power Cleaning (Mac OS)

1. Select System Preferences from the Apple menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Option & Supplies > Utility > Open Printer Utility.
3. Click Print Head Cleaning.
4. Select Power Cleaning.

5. Follow the on-screen instructions.

g Important:

If print quality has not improved after running Power Cleaning, wait for at least 6 hours without printing, and
then print the nozzle check pattern again. Run Cleaning or Power Cleaning again depending on the printed
pattern. If quality still does not improve, contact Epson support.

Related Information

= “Checking and Cleaning the Print Head” on page 102

Preventing nozzle clogging

Always use the power button when turning the printer on and off.
Check that the power light is off before you disconnect the power cord.

The ink itself can dry out if it is not covered. Just like placing a cap on a fountain pen or an oil pen to prevent it
from drying, make sure the print head is capped properly to prevent the ink from drying.
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Maintaining the Printer > improving Print Quality > Adjusting the Paper Feed

When the power cord is unplugged or a power outage occurs while the printer is in operation, the print head may
not be capped properly. If the print head is left as it is, it will dry out causing nozzles (ink outlets) to clog.

In these cases, turn the printer on and off again as soon as possible to cap the print head.

Aligning the Print Head

1. Load A4-size Photo Quality Ink Jet Paper in the printer.
You can also use plain paper instead.

“Loading Paper in the Rear Paper Feeder” on page 30

2. Select A on the printer's control panel.
3. Select Maintenance > Print Head Alignment.

4. Follow the on-screen instructions to print an alignment pattern and select the number for the optimum
pattern.

Find and select the number for the most solid pattern in each group.

#1

Adjusting the Paper Feed

If you see banding or unevenness in your printouts and print head cleaning does not help, using this feature may
improve print quality.

1. Load paper for which you want to perform adjustments in the printer.

2. Select A on the printer's control panel.

3. Select Maintenance > Paper Feed Adjust.
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Maintaining the Printer > improving Print Quality > Adjusting the Paper Feed

4. Follow the on-screen instructions to print the patterns.

=
=

~J

5. Check the printed patterns and then select the number of the pattern with the least separated or overlapping
patterns by tapping the - or + icons.

U When there are multiple patterns that are not separated or overlapping
Select the middle number from the patterns that are not separated or overlapping.

For example, if the patterns for numbers 4, 5, and 6 are not separated or overlapping, select No. 5.

> I

4
5 -

6
7 -
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Maintaining the Printer > improving Print Quality > Cleaning the Paper Path for Ink Smears

(J When all of the patterns are separated or overlapping

Compare the patterns at the beginning and the end (No.1 and No.11), and then select the number of the
pattern with the least separation or overlapping.

11

Print the patterns again. Repeat these steps until you can select a pattern with no separation or overlapping.

Cleaning the Paper Path for Ink Smears

When the printouts are smeared or scuffed, clean the paper path inside. Cleaning sheets cannot be used for this
purpose.

n Important:

Do not use tissue paper to clean the inside of the printer. The print head nozzles may be clogged with lint.

1. Load plain paper of the following size in the rear paper feeder.
SC-P900 Series: A2
SC-P700 Series: A3 or A3+
“Loading Paper in the Rear Paper Feeder” on page 30

2. Select E on the printer's control panel.
3. Select Maintenance > Paper Guide Cleaning.

4. Follow the on-screen instructions to clean the paper path.

Note:
Repeat this procedure until the paper is not smeared with ink.
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Maintaining the Printer > Installing or Uninstalling Applications Separately > Installing the Applications Separ...

Saving Power

The printer enters sleep mode or turns off automatically if no operations are performed for a set period. You can
adjust the time before power management is applied. Any increase will affect the product's energy efficiency. Please
consider the environment before making any change.

1. Select B on the printer's control panel.
2. Select General Settings.
3. Select Basic Settings.

4. Do one of the following.

Note:
Your product may have the Power Off Settings or Power Off Timer feature depending on the location of purchase.

[ Select Sleep Timer or Power Off Settings > Power Off If Inactive or Power Off If Disconnected.
O Select Sleep Timer or Power Off Timer.

5. Select the setting.

Installing or Uninstalling Applications Separately

Connect your computer to the network and install the latest version of applications from the website. Log in to
your computer as an administrator. Enter the administrator password if the computer prompts you.

Installing the Applications Separately

Note:
When reinstalling an application, you need to uninstall it first.

1. Make sure the printer and the computer are available for communication, and the printer is connected to the
Internet.
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Maintaining the Printer > Installing or Uninstalling Applications Separately > Installing the Applications Separ...

2. Start EPSON Software Updater.

The screenshot is an example on Windows.

Eprson Softwane Updater

MNew software is available in the table below.

=0 Select your preduct S 3
Essential Product Updates
Software Status Version Sire

€ ¥

Other useful software

Software Status Version Size

€ »

Auto update sattings Total @ - MB
Exit

3. For Windows, select your printer, and then click % to check for the latest available applications.

4. Select the items you want to install or update, and then click the install button.

n Important:

Do not turn off or unplug the printer until the update is complete. Doing so may result in malfunction of the
printer.

Note:
You can download the latest applications from the Epson website.

http://www.epson.com

Related Information
= “Application for Updating Software and Firmware (EPSON Software Updater)” on page 212
= “Uninstalling Applications” on page 113

Checking if a genuine Epson printer driver is installed - Windows

You can check if a genuine Epson printer driver is installed on your computer by using one of the following
methods.

Select Control Panel > View devices and printers (Printers, Printers and Faxes). Next, click the printer icon and
then click Print server properties at the top of the screen to display the properties window.
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Maintaining the Printer > Installing or Uninstalling Applications Separately > Installing the Applications Separ...

Click the Driver tab. If your printer name is displayed in the list, a genuine Epson printer driver is installed on
your computer.

2 Devices and Printers

« © 4 H: > Control Panel » HardwareandSound » Devices and Printers > v o

File Edit View Took Help

Addadevice  Addaprinter  Seewhat'sprinting | Printserver properties | Remove device

~ Printers (19) = Print Server Properties e X

N ()

- =
A g XHHXHKANHK
XXXXX Series
Installed printer drivers:
e
- Name Processor Type fal
— EPSOMN XXXXXX Series Type 3 - User Mode
EPSON
XX
Series
-
XXX
-~
<A
v

Add... Remove... Properties

& Change Driver Settings

Sancel oy

Related Information

= “Installing the Applications Separately” on page 110

Checking if a genuine Epson printer driver is installed - Mac OS

You can check if a genuine Epson printer driver is installed on your computer by using one of the following
methods.

Select System Preferences from the Apple menu > Printers & Scanners (or Print & Scan, Print & Fax), and then

select the printer. Click Options & Supplies, and if the Options tab and Utility tab are displayed on the window, a
genuine Epson printer driver is installed on your computer.

Printers & Scanners

General Supply Levels

Open Printer Utility
Print Test Page

Clean Print Heads

cancel  (EEEND
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Related Information

= “Installing the Applications Separately” on page 110

Adding the Printer (for Mac OS Only)

1. Select System Preferences from the Apple menu > Printers & Scanners (or Print & Scan, Print & Fax).
2. Click +, and then select your printer on the screen displayed.
3. Select your printer from Use.

4. Click Add.

Note:
If your printer is not listed, check that it is correctly connected to the computer and that the printer is on.

Uninstalling Applications

Log in to your computer as an administrator. Enter the administrator password if the computer prompts you.

Uninstalling Applications - Windows

1. Press the ) button to turn off the printer.
2. Quit all running applications.

3. Open Control Panel:
U Windows 10

Click on the start button, and then select Windows System > Control Panel.

O Windows 8.1/Windows 8
Select Desktop > Settings > Control Panel.

O Windows 7
Click the start button and select Control Panel.

4. Open Uninstall a program (or Add or Remove Programs):

Select Uninstall a program in Programs.

5. Select the application you want to uninstall.
You cannot uninstall the printer driver if there is any print jobs. Delete or wait to be printed the jobs before
uninstalling.

6. Uninstall the applications:
Click Uninstall/Change or Uninstall.

Note:
If the User Account Control window is displayed, click Continue.
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7. Follow the on-screen instructions.

Uninstalling Applications - Mac OS

1. Download the Uninstaller using EPSON Software Updater.

Once you have downloaded the Uninstaller, you do not need to download it again each time you uninstall the
application.

2. Press the ) button to turn off the printer.

3. To uninstall the printer driver, select System Preferences from the Apple menu > Printers & Scanners (or
Print & Scan, Print & Fax), and then remove the printer from the enabled printers list.

4. Quit all running applications.
5. Select Go > Applications > Epson Software > Uninstaller.

6. Select the application you want to uninstall, and then click Uninstall.

g Important:

The Uninstaller removes all drivers for Epson inkjet printers on the computer. If you use multiple Epson inkjet
printers and you only want to delete some drivers, delete all of them first, and then install the necessary printer
driver again.

Note:

If you cannot find the application you want to uninstall in the application list, you cannot uninstall using the
Uninstaller. In this situation, select Go > Applications > Epson Software, select the application you want to uninstall,
and then drag it to the trash icon.

Related Information

= “Application for Updating Software and Firmware (EPSON Software Updater)” on page 212

Updating Applications and Firmware

You may be able to clear certain problems and improve or add functions by updating the applications and the
firmware. Make sure you use the latest version of the applications and firmware.

1. Make sure that the printer and the computer are connected, and the computer is connected to the internet.

2. Start EPSON Software Updater, and update the applications or the firmware.

g Important:

Do not turn off the computer or the printer until the update is complete; otherwise, the printer may
malfunction.
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Note:

If you cannot find the application you want to update in the list, you cannot update using the EPSON Software Updater.
Check for the latest versions of the applications from your local Epson website.

http://www.epson.com

Related Information

= “Application for Updating Software and Firmware (EPSON Software Updater)” on page 212

Updating the Printer's Firmware Using the Control Panel

If the printer is connected to the Internet, you can update the printer's firmware using the control panel. By
updating the firmware, the printer's performance may improve, or new functions may be added. You can also set
the printer to regularly check for firmware updates and notify you if any are available.

1. Select I on the printer's control panel.

2. Select General Settings > Firmware Update > Update.

Note:
Enable Notification to set the printer to reqularly check for available firmware updates.

3. Check the message displayed on the screen and select Start Checking.

4. Check the message displayed on the screen and select Start.

The firmware is updated when new firmware is found. Once the update has started, it cannot be interrupted.

g Important:

U Do not turn off or unplug the printer until the update is complete. Doing so may result in malfunction of the
printer.

O If the firmware update is not completed or is unsuccessful, the printer does not start up normally and
"Recovery Mode" is displayed on the LCD screen the next time the printer is turned on. In this situation,
you need to update the firmware again using a computer. Connect the printer to the computer with a
USB cable. While "Recovery Mode" is displayed on the printer, you cannot update the firmware over a
network connection. On the computet, access your local Epson website, and then download the latest printer
firmware. See the instructions on the website for the next steps.

Transporting and Storing the Printer

When you need to store the printer or transport it when moving or for repairs, follow the steps below to pack the
printer.

1. Turn off the printer by pressing the O button.
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2. Make sure the power light turns off, and then unplug the power cord.

n Important:

Unplug the power cord when the power light is off. Otherwise, the print head may not return to the home
position causing the ink to dry, and printing may become impossible.

3. Disconnect all cables such as the power cord and USB cable.
4. Remove all of the paper from the printer.

5. Open the printer cover. Secure the print head to the case with tape.
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7. Prepare to pack the printer as shown below.

8. Pack the printer in its box, using the protective materials.

g Important:

U When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

U Do not remove the ink cartridges from the product when storing or transporting the product.

When you use the printer again, make sure you remove the tape securing the print head. If print quality has
declined the next time you print, clean and align the print head.

Related Information

= “Checking and Cleaning the Print Head” on page 102
= “Aligning the Print Head” on page 107
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Cleaning the Cooling Fan Filter

If there is excessive dust on the cooling fan filter, the printer may not cool properly. This can cause unstable
printer behavior and lead to print quality deterioration. Use a cleaning tool like a small vacuum cleaner to regularly

remove dust from the filter.
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SoIving Problems > The Printer Does Not Work as Expected > The Printer Does Not Turn On or Off

The Printer Does Not Work as Expected

The Printer Does Not Turn On or Off

Power Does Not Turn On

One of the following situations may be the cause.

| The power cord is not properly plugged into the electrical outlet.
Solutions

Make sure the power cord is securely plugged in.

I The O button was not pressed for long enough.

Solutions

Hold down the O button for a little longer.

Power Does Not Turn Off

I The O button was not pressed for long enough.

Solutions

Hold down the ) button for a little longer. If you still cannot turn off the printer, unplug the power cord.

Then plug the power cord back in and turn the printer back on and off by pressing the Q) button, in order
avoid drying out the print head.

Power Turns Off Automatically

| The Power Off Settings or Power Off Timer feature is enabled.

Solutions

0 Select I > General Settings > Basic Settings > Power Off Settings, and then disable the Power Off
If Inactive and Power Off If Disconnected settings.

0 Select IF > General Settings > Basic Settings, and then disable the Power Off Timer Setting.

Note:
Your product may have the Power Off Settings or Power Off Timer feature depending on the location of purchase.
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Paper Does Not Feed Properly

No Paper Feeds

The following causes can be considered.

| Theinstallation location is inappropriate.
Solutions

Place the printer on a flat surface and operate in the recommended environmental conditions.

= “Environmental Specifications” on page 226

| Unsupported paper is being used.
Solutions
Use paper supported by this printer.

= “Available Paper and Capacities” on page 187
= “Unavailable Paper Types” on page 197

| Paper handling is inappropriate.
Solutions

Follow paper handling precautions.

= “Paper Handling Precautions” on page 27

| Too many sheets are loaded in the printer.
Solutions

Do not load more than the maximum number of sheets specified for the paper.

= “Available Paper and Capacities” on page 187

| The paper settings on the printer are incorrect.
Solutions

Make sure the paper size and paper type settings match the actual paper size and paper type loaded in the
printer.

= “Paper Size and Type Settings” on page 28

A paper with a width that cannot be detected correctly is being used.
Solutions

If you use transparent, colored, or pre-printed paper, the width of the paper may not be detected. Add the
paper information, and then disable the Paper Size Check feature using Epson Media Installer.

Start Epson Media Installer, and then add the paper information you want to print. Edit the paper
information, and then clear the Paper Size Check checkbox.

= “Adding paper information (print settings)” on page 197
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= “Editing paper information” on page 201

Paper Feeds at a Slant

One of the following situations may be the cause.

| Theinstallation location is inappropriate.
Solutions

Place the printer on a flat surface and operate in the recommended environmental conditions.

= “Environmental Specifications” on page 226

| Unsupported paper is being used.
Solutions
Use paper supported by this printer.

= “Available Paper and Capacities” on page 187
= “Unavailable Paper Types” on page 197

| Paper handling is inappropriate.
Solutions

Follow paper handling precautions.

= “Paper Handling Precautions” on page 27

| The paper is loaded incorrectly.
Solutions

Load paper in the correct direction, and slide the edge guides against the edges of the paper.
= “Loading Paper” on page 27
| Too many sheets are loaded in the printer.

Solutions

Do not load more than the maximum number of sheets specified for the paper.

= “Available Paper and Capacities” on page 187

| The paper settings on the printer are incorrect.
Solutions

Make sure the paper size and paper type settings match the actual paper size and paper type loaded in the
printer.

= “Paper Size and Type Settings” on page 28

Several Sheets of Paper are Fed at a Time

One of the following situations may be the cause.
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| Theinstallation location is inappropriate.
Solutions

Place the printer on a flat surface and operate in the recommended environmental conditions.

= “Environmental Specifications” on page 226

| Unsupported paper is being used.
Solutions
Use paper supported by this printer.

= “Available Paper and Capacities” on page 187
= “Unavailable Paper Types” on page 197

| Paper handling is inappropriate.
Solutions

Follow paper handling precautions.

= “Paper Handling Precautions” on page 27

| The paper is moist or damp.
Solutions

Load new paper.

| static electricity is causing sheets of paper to stick to each other.
Solutions

Fan the paper before loading. If the paper still does not feed, load one sheet of paper at a time.

| Too many sheets are loaded in the printer.
Solutions

Do not load more than the maximum number of sheets specified for the paper.

= “Available Paper and Capacities” on page 187

| The paper settings on the printer are incorrect.
Solutions

Make sure the paper size and paper type settings match the actual paper size and paper type loaded in the
printer.

= “Paper Size and Type Settings” on page 28

| Multiple sheets of paper feed at the same time during manual 2-sided printing.
Solutions

Remove any paper that is loaded in the paper source before you reload the paper.
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Paper Does Not Feed Properly from the Front Paper Feeder

| Paper has been fed at an angle from the front paper feeder.
Solutions

After inserting paper, make sure the railing edge of the paper is aligned with the line on the front paper
feeder.

Roll Paper Does Not Feed Properly

| Front paper feeder opens when loading roll paper.
Solutions

Close the front paper feeder, and load roll paper.

The CD/DVD Tray is Ejected when You Try to Load It

| The disc has not been attached properly.
Solutions

Reattach the disc properly.

= “Loading a CD/DVD” on page 38

| The CD/DVD tray was inserted before the printer was ready.
Solutions

Do not insert the CD/DVD tray until you are instructed to do so. Otherwise, an error occurs and the tray
is ejected.

Cannot Print

Cannot Print from Windows

Make sure the computer and the printer are connected correctly.

The cause and solution to the problem differ depending on whether or not they are connected.

Checking the Connection Status

Use EPSON Status Monitor 3 to check the connection status for the computer and the printer.

1. Access the printer driver.

J Windows 10

Click on the start button, and then select Windows System > Control Panel > View devices and printers
in Hardware and Sound. Right-click on your printer, or press and hold it and then select Printing
preferences
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J Windows 8.1/Windows 8

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound.
Right-click on your printer, or press and hold it and then select Printing preferences

O Windows 7
Click the start button, and select Control Panel > View devices and printers in Hardware and Sound.
Right-click on your printer and select Printing preferences.

2. Click the Utility tab.

3. Click EPSON Status Monitor 3.
If EPSON Status Monitor 3 is disabled, click Speed and Progress on the Utility tab, and then clear Disable
EPSON Status Monitor 3.
When the remaining ink levels are displayed, a connection has been successfully established between the computer
and the printer.
Check the following if a connection has not been established.

J The printer is not recognized over a network connection

“Cannot connect to a Network” on page 125
U The printer is not recognized using a USB connection

“The Printer Cannot Connect by USB (Windows)” on page 128
Check the following if a connection has been established.

[ The printer is recognized, but printing cannot be performed.

“Cannot Print Even Though a Connection has been Established (Windows)” on page 128

Cannot connect to a Network

The problem could be one of the following issues.

| Something is wrong with the network devices for Wi-Fi connection.

Solutions

Turn off the devices you want to connect to the network. Wait for about 10 seconds, and then turn
on the devices in the following order; wireless router, computer or smart device, and then printer.
Move the printer and computer or smart device closer to the wireless router to help with radio wave
communication, and then try to make network settings again.

ocooo/
Y
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| Devices cannot receive signals from the wireless router because they are too far apart.
Solutions

After moving the computer or the smart device and the printer closer to the wireless router, turn off the
wireless router, and then turn it back on.

| When changing the wireless router, the settings do not match the new router.
Solutions

Reconfigure the settings so that they match the new wireless router.

= “When Replacing the Wireless Router” on page 163

| The SSIDs connected from the computer or smart device and computer are different.
Solutions

When you are using multiple wireless routers at the same time or the wireless router has multiple SSIDs
and devices are connected to different SSIDs, you cannot connect to the wireless router.

Connect the computer or smart device to the same SSID as the printer.

A SSIDT:XXXXX-G1 7 - N SSID1XXKGT
— SSID2:XXXXX-G2 SSID2:XXXXX-G2
—
=== fff 9
) * EPSON B
SSIDT:XXXXX-G1 SSID2:XXXXX-G2 SSID2:XXXXX-G2

| A privacy separator on the wireless router is available.
Solutions

Most wireless routers have a privacy separator feature that blocks communication between connected
devices. If you cannot communicate between the printer and the computer or smart device even if they
are connected to the same network, disable the privacy separator on the wireless router. See the manual
provided with the wireless router for details.

| TheIP address is incorrectly assigned.
Solutions

If the IP address assigned to the printer is 169.254. XXX XXX, and the subnet mask is 255.255.0.0, the IP
address may not be assigned correctly.

Select FFl > General Settings > Network Settings > Advanced on the printer’s control panel, and then
check the IP address and the subnet mask assigned to the printer.

Restart the wireless router or reset the network settings for the printer.

= “Re-setting the Network Connection” on page 163
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| Thereis a problem with the network settings on the computer.

Solutions

Tr
co

Check the network connection of the computer. See the documentation provided with the computer for

y accessing any website from your computer to make sure that your computer's network settings are

rrect. If you cannot access any website, there is a problem on the computer.

details.

Efficient Ethernet).

I The printer has been connected by Ethernet using devices that support IEEE802.3az (Energy

Solutions

When you connect the printer by Ethernet using devices that support IEEE802.3az (Energy Efficient
Ethernet), the following problems may occur depending on the hub or router that you are using.

Q
Q
Q

Follow the steps below to disable IEEE802.3az for the printer and then connect.

1.

10.

11.

12.

13

If the problem still occurs, devices other than the printer may be causing the problem.

Connection becomes unstable, the printer is connected and disconnected again and again.

Cannot connect to the printer.

The communication speed becomes slow.

Remove the Ethernet cable connected to the computer and the printer.

When IEEE802.3az for the computer is enabled, disable it.

See the documentation provided with the computer for details.
Connect the computer and the printer with an Ethernet cable directly.

On the printer, print a network connection report.

“Printing a Network Connection Report” on page 179
Check the printer's IP address on the network connection report.

On the computer, access Web Config.
Launch a Web browser, and then enter the printer's IP address.

“Running Web Config on a Web Browser” on page 211

Select the Network tab > Wired LAN.

Select OFF for IEEE 802.3az.

Click Next.

Click OK.

Remove the Ethernet cable connected to the computer and the printer.

If you disabled IEEE802.3az for the computer in step 2, enable it.

. Connect the Ethernet cables that you removed in step 1 to the computer and the printer.
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The Printer Cannot Connect by USB (Windows)

The following causes can be considered.

| The USB cable is not plugged into the electrical outlet correctly.
Solutions

Connect the USB cable securely to the printer and the computer.

| Thereis a problem with the USB hub.
Solutions

If you are using a USB hub, try to connect the printer directly to the computer.

| Thereis a problem with the USB cable or the USB inlet.
Solutions

Connect the USB cable to a different port, or change the USB cable.

Cannot Print Even Though a Connection has been Established (Windows)

One of the following situations may be the cause.

| A genuine Epson printer driver has not been installed.
Solutions

If a genuine Epson printer driver (EPSON XXXXX) has not been installed, the available functions are
limited. We recommend using a genuine Epson printer driver.

= “Checking if a genuine Epson printer driver is installed - Windows” on page 111

= “Checking if a genuine Epson printer driver is installed - Mac OS” on page 112

| Thereis a problem with the software or data.
Solutions

U If you are printing a large size image, the computer may run out of memory. Print the image at a lower
resolution or a smaller size.

O If you have tried all of the solutions and have not solved the problem, try uninstalling and then

reinstalling the printer driver

= “Installing or Uninstalling Applications Separately” on page 110

| Thereis a problem with the printer's status.
Solutions

Click EPSON Status Monitor 3 on the printer driver's Utility tab, and then check the printer status. If
EPSON Status Monitor 3 is disabled, click Speed and Progress on the Utility tab, and then clear Disable
EPSON Status Monitor 3.
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| Thereis still a job waiting to be printed.
Solutions

Click Print Queue on the printer driver's Utility tab. If unnecessary data remains, select Cancel all
documents from the Printer menu.

= EPSON XXXX X

2= Main Layout #* Utility
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J The printer is pending or offline.
Solutions
Click Print Queue on the printer driver's Utility tab.

If the printer is offline or pending, clear the offline or pending setting from the Printer menu.

EPSON JCOGOU0D0( Series o x
Pricker Ducument View
Eestus Dwner Pages  Sise Submitzed
| Set s Defuutt Printer
Printing Preferences..

Pase Prineng
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| The printer is not selected as the default printer.
Solutions

Right-click the printer icon in Control Panel > View devices and printers (or Printers, or Printers and
Faxes) and click Set as default printer.

Note:

If there are multiple printer icons, select the correct one based on the connection type, as described below.
USB connection: EPSON XXXX Series

Network connection: EPSON XXXX Series (network)

If you install the printer driver multiple times, copies of the printer driver may be created. If copies such
as "EPSON XXXX Series (copy 1)" are created, right-click the copied driver icon, and then click Remove
Device.
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| The printer portis not set correctly.

Solutions
Click Print Queue on the printer driver's Utility tab.

Make sure the printer port is set correctly as shown below in Property > Port from the Printer menu.

USB connection: USBXXX, Network connection: EpsonNet Print Port

Suddenly the Printer Cannot Print over a Network Connection

The problem could be one of the following issues.

| The network environment has been changed.

Solutions

When you have changed the network environment, such as the wireless router or provider, try making
network settings for the printer again.

Connect the computer or smart device to the same SSID as the printer.

= “Re-setting the Network Connection” on page 163

| Something is wrong with the network devices for Wi-Fi connection.
Solutions

Turn off the devices you want to connect to the network. Wait for about 10 seconds, and then turn
on the devices in the following order; wireless router, computer or smart device, and then printer.

Move the printer and computer or smart device closer to the wireless router to help with radio wave
communication, and then try to make network settings again.

ocooo/

| The printer is not connected to the network.

Solutions

Select I > General Settings > Network Settings > Connection Check, and then print the network

connection report. If the report shows that the network connection failed, check the network connection
report and then follow the printed solutions.

= “Printing a Network Connection Report” on page 179

| Thereis a problem with the network settings on the computer.
Solutions

Try accessing any website from your computer to make sure that your computer's network settings are
correct. If you cannot access any website, there is a problem on the computer.
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Check the network connection of the computer. See the documentation provided with the computer for

details.

| Thereis still a job waiting to be printed.

Solutions

Click Print Queue on the printer driver's Utility tab. If unnecessary data remains, select Cancel all

documents from the Printer menu.
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| The printer is pending or offline.
Solutions

Click Print Queue on the printer driver's Utility tab.

Submitted

If the printer is offline or pending, clear the offline or pending setting from the Printer menu.

EPSON XOOGOUND0C Series o x
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Properties
Close.

l The printer is not selected as the default printer.

Solutions

Right-click the printer icon in Control Panel > View devices and printers (or Printers, or Printers and

Faxes) and click Set as default printer.

Note:

If there are multiple printer icons, select the correct one based on the connection type, as described below.

USB connection: EPSON XXXX Series
Network connection: EPSON XXXX Series (network)
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If you install the printer driver multiple times, copies of the printer driver may be created. If copies such
as "EPSON XXXX Series (copy 1)" are created, right-click the copied driver icon, and then click Remove
Device.

| The printer portis not set correctly.
Solutions
Click Print Queue on the printer driver's Utility tab.
Make sure the printer port is set correctly as shown below in Property > Port from the Printer menu.

USB connection: USBXXX, Network connection: EpsonNet Print Port

Cannot Print from Mac OS

Make sure the computer and the printer are connected correctly.

The cause and solution to the problem differ depending on whether or not they are connected.

Checking the Connection Status
Use EPSON Status Monitor to check the connection status for the computer and the printer.

1. Select System Preferences from the Apple menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click EPSON Status Monitor.

When the remaining ink levels are displayed, a connection has been successfully established between the computer
and the printer.

Check the following if a connection has not been established.

O The printer is not recognized over a network connection

“Cannot connect to a Network” on page 132
 The printer is not recognized using a USB connection

“The Printer Cannot Connect by USB (Mac OS)” on page 135
Check the following if a connection has been established.

U The printer is recognized, but printing cannot be performed.

“Cannot Print Even Though a Connection has been Established (Mac OS)” on page 135

Cannot connect to a Network

The problem could be one of the following issues.

| Something is wrong with the network devices for Wi-Fi connection.
Solutions

Turn off the devices you want to connect to the network. Wait for about 10 seconds, and then turn
on the devices in the following order; wireless router, computer or smart device, and then printer.
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Move the printer and computer or smart device closer to the wireless router to help with radio wave
communication, and then try to make network settings again.

cooo/

| Devices cannot receive signals from the wireless router because they are too far apart.
Solutions

After moving the computer or the smart device and the printer closer to the wireless router, turn off the
wireless router, and then turn it back on.

| When changing the wireless router, the settings do not match the new router.
Solutions

Reconfigure the settings so that they match the new wireless router.
= “When Replacing the Wireless Router” on page 163

| The SSIDs connected from the computer or smart device and computer are different.
Solutions

When you are using multiple wireless routers at the same time or the wireless router has multiple SSIDs
and devices are connected to different SSIDs, you cannot connect to the wireless router.

Connect the computer or smart device to the same SSID as the printer.

2
\\

SSIDT:XXXXX-G1
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| A privacy separator on the wireless router is available.
Solutions

Most wireless routers have a privacy separator feature that blocks communication between connected
devices. If you cannot communicate between the printer and the computer or smart device even if they
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are connected to the same network, disable the privacy separator on the wireless router. See the manual
provided with the wireless router for details.

| TheIP address is incorrectly assigned.
Solutions

If the IP address assigned to the printer is 169.254. XXX.XXX, and the subnet mask is 255.255.0.0, the IP
address may not be assigned correctly.

Select FFl > General Settings > Network Settings > Advanced on the printer’s control panel, and then
check the IP address and the subnet mask assigned to the printer.

Restart the wireless router or reset the network settings for the printer.

= “Re-setting the Network Connection” on page 163

| Thereis a problem with the network settings on the computer.
Solutions

Try accessing any website from your computer to make sure that your computer's network settings are
correct. If you cannot access any website, there is a problem on the computer.

Check the network connection of the computer. See the documentation provided with the computer for
details.

| The device connected to the USB 3.0 port causes radio frequency interference.
Solutions

When you connect a device to the USB 3.0 port on a Mac, radio frequency interference may occur. Try
the following if you cannot connect to wireless LAN (Wi-Fi) or if operations become unstable.

O Place the device that is connected to the USB 3.0 port further away from the computer.
O Connect to the SSID with the 5 GHz range.

= “Making Wi-Fi Settings by Entering the SSID and Password” on page 167

The printer has been connected by Ethernet using devices that support IEEE802.3az (Energy
Efficient Ethernet).

Solutions

When you connect the printer by Ethernet using devices that support IEEE802.3az (Energy Efficient
Ethernet), the following problems may occur depending on the hub or router that you are using.

1 Connection becomes unstable, the printer is connected and disconnected again and again.
(O Cannot connect to the printer.

(J The communication speed becomes slow.

Follow the steps below to disable IEEE802.3az for the printer and then connect.
1. Remove the Ethernet cable connected to the computer and the printer.

2. When IEEE802.3az for the computer is enabled, disable it.

See the documentation provided with the computer for details.

3. Connect the computer and the printer with an Ethernet cable directly.
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4. On the printer, print a network connection report.

“Printing a Network Connection Report” on page 179
5. Check the printer's IP address on the network connection report.

6. On the computer, access Web Config.
Launch a Web browser, and then enter the printer's IP address.

“Running Web Config on a Web Browser” on page 211
7.  Select the Network tab > Wired LAN.
8. Select OFF for IEEE 802.3az.
9. Click Next.
10. Click OK.
11. Remove the Ethernet cable connected to the computer and the printer.
12. If you disabled IEEE802.3az for the computer in step 2, enable it.

13. Connect the Ethernet cables that you removed in step 1 to the computer and the printer.

If the problem still occurs, devices other than the printer may be causing the problem.

The Printer Cannot Connect by USB (Mac OS)

The following causes can be considered.

| The USB cable is not plugged into the electrical outlet correctly.
Solutions

Connect the USB cable securely to the printer and the computer.

| Thereis a problem with the USB hub.
Solutions

If you are using a USB hub, try to connect the printer directly to the computer.

| Thereis a problem with the USB cable or the USB inlet.
Solutions

Connect the USB cable to a different port, or change the USB cable.

Cannot Print Even Though a Connection has been Established (Mac OS)

One of the following situations may be the cause.
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A genuine Epson printer driver has not been installed.
Solutions

If a genuine Epson printer driver (EPSON XXXXX) has not been installed, the available functions are
limited. We recommend using a genuine Epson printer driver.

= “Checking if a genuine Epson printer driver is installed - Windows” on page 111

= “Checking if a genuine Epson printer driver is installed - Mac OS” on page 112

| Thereis a problem with the software or data.
Solutions

U If you are printing a large size image, the computer may run out of memory. Print the image at a lower
resolution or a smaller size.

U If you have tried all of the solutions and have not solved the problem, try uninstalling and then

reinstalling the printer driver

= “Installing or Uninstalling Applications Separately” on page 110

| Thereis a problem with the status of the printer.
Solutions
Make sure the printer status is not Pause.

Select System Preferences from the Apple menu > Printers & Scanners (or Print & Scan, Print & Fax),
and then double-click the printer. If the printer is paused, click Resume.

Suddenly the Printer Cannot Print over a Network Connection

The problem could be one of the following issues.

| The network environment has been changed.
Solutions

When you have changed the network environment, such as the wireless router or provider, try making
network settings for the printer again.

Connect the computer or smart device to the same SSID as the printer.

= “Re-setting the Network Connection” on page 163
| Something is wrong with the network devices for Wi-Fi connection.

Solutions

Turn off the devices you want to connect to the network. Wait for about 10 seconds, and then turn
on the devices in the following order; wireless router, computer or smart device, and then printer.
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Move the printer and computer or smart device closer to the wireless router to help with radio wave
communication, and then try to make network settings again.

cooo/
|

| The printer is not connected to the network.

Solutions

Select A > General Settings > Network Settings > Connection Check, and then print the network
connection report. If the report shows that the network connection failed, check the network connection
report and then follow the printed solutions.

= “Printing a Network Connection Report” on page 179

| Thereis a problem with the network settings on the computer.
Solutions

Try accessing any website from your computer to make sure that your computer's network settings are
correct. If you cannot access any website, there is a problem on the computer.

Check the network connection of the computer. See the documentation provided with the computer for
details.

Cannot Print from Smart Device

Make sure the smart device and the printer are connected correctly.

The cause and solution to the problem differ depending on whether or not they are connected.

Checking the Connection Status
Use Epson Smart Panel to check the connection status for the smart device and the printer.

Search for and install Epson Smart Panel from App Store or Google Play if it is not already installed.
1.  On the smart device, start Epson Smart Panel.

2. Check that the printer image or the remaining ink levels are displayed on the home screen.

When the printer image or the remaining ink levels are displayed, a connection has been successfully
established between the smart device and the printer.

If the they are not displayed, a connection has not been established between the smart device and the printer.

Check the following if a connection has not been established.
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(J The printer is not recognized over a network connection

“Cannot connect to a Network” on page 138

Check the following if a connection has been established.

 The printer is recognized, but printing cannot be performed.

“Cannot Print Even Though a Connection has been Established (iOS)” on page 139

Cannot connect to a Network

The problem could be one of the following issues.

| Something is wrong with the network devices for Wi-Fi connection.

Solutions

Turn off the devices you want to connect to the network. Wait for about 10 seconds, and then turn
on the devices in the following order; wireless router, computer or smart device, and then printer.
Move the printer and computer or smart device closer to the wireless router to help with radio wave
communication, and then try to make network settings again.

ocooo/
Y

| Devices cannot receive signals from the wireless router because they are too far apart.
Solutions
After moving the computer or the smart device and the printer closer to the wireless router, turn off the

wireless router, and then turn it back on.

] When changing the wireless router, the settings do not match the new router.
Solutions

Reconfigure the settings so that they match the new wireless router.

= “When Replacing the Wireless Router” on page 163

| The SSIDs connected from the computer or smart device and computer are different.

Solutions

When you are using multiple wireless routers at the same time or the wireless router has multiple SSIDs
and devices are connected to different SSIDs, you cannot connect to the wireless router.
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Connect the computer or smart device to the same SSID as the printer.
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| A privacy separator on the wireless router is available.
Solutions

Most wireless routers have a privacy separator feature that blocks communication between connected
devices. If you cannot communicate between the printer and the computer or smart device even if they
are connected to the same network, disable the privacy separator on the wireless router. See the manual
provided with the wireless router for details.

| ThelP address is incorrectly assigned.
Solutions

If the IP address assigned to the printer is 169.254. XXX XXX, and the subnet mask is 255.255.0.0, the IP
address may not be assigned correctly.

Select Il > General Settings > Network Settings > Advanced on the printer’s control panel, and then
check the IP address and the subnet mask assigned to the printer.

Restart the wireless router or reset the network settings for the printer.

= “Re-setting the Network Connection” on page 163

| Thereis a problem with the network settings on the smart device.
Solutions

Try accessing any website from your smart device to make sure that your smart device's network settings
are correct. If you cannot access any website, there is a problem on the smart device.

Check the network connection of the computer. See the documentation provided with the smart device
for details.

Cannot Print Even Though a Connection has been Established (iOS)

One of the following situations may be the cause.

| Paper Setup Auto Display is disabled.
Solutions

Enable Paper Setup Auto Display in the following menu.
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= > General Settings > Printer Settings > Paper Setup Auto Display

J AirPrintis disabled.
Solutions

Enable the AirPrint setting in Web Config.

= “Application for Configuring Printer Operations (Web Config)” on page 211

Suddenly the Printer Cannot Print over a Network Connection

The problem could be one of the following issues.

l The network environment has been changed.
Solutions

When you have changed the network environment, such as the wireless router or provider, try making
network settings for the printer again.

Connect the computer or smart device to the same SSID as the printer.

= “Re-setting the Network Connection” on page 163

| Something is wrong with the network devices for Wi-Fi connection.
Solutions

Turn off the devices you want to connect to the network. Wait for about 10 seconds, and then turn
on the devices in the following order; wireless router, computer or smart device, and then printer.
Move the printer and computer or smart device closer to the wireless router to help with radio wave
communication, and then try to make network settings again.

cooo/
|

| The printer is not connected to the network.

Solutions
Select A > General Settings > Network Settings > Connection Check, and then print the network
connection report. If the report shows that the network connection failed, check the network connection

report and then follow the printed solutions.

= “Printing a Network Connection Report” on page 179
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| Thereis a problem with the network settings on the smart device.
Solutions

Try accessing any website from your smart device to make sure that your smart device's network settings
are correct. If you cannot access any website, there is a problem on the smart device.

Check the network connection of the computer. See the documentation provided with the smart device
for details.

Cannot Operate the Printer as Expected

Operations are Slow

Printing Is Too Slow

One of the following situations may be the cause.

| Unnecessary applications are running.
Solutions

Close any unnecessary applications on your computer or smart device.

| The print quality setting is too high.
Solutions

Lower the quality setting.

| Bidirectional printing is disabled.
Solutions

Enable the bidirectional (or high speed) setting. When this setting is enabled, the print head prints while
moving in both directions, and the printing speed increases.

O Windows

Select Quality Options as the Level setting on the printer driver's Main tab, and then select High
Speed.

O Mac OS
Select Print Settings from the print dialog's pop-up menu, and then select High Speed.

| There may be network connection problems with the wireless router.
Solutions

Reboot the wireless router while taking into consideration other users connected to the network. If this
does not solve the problem, place the printer closer to your wireless router or see the documentation
provided with the router.
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| The printer is printing high-density data such as photos on plain paper.
Solutions

If you are printing high-density data such as photos on plain paper, printing may take some time in order
to maintain print quality. This is not a malfunction.

Printing Slows Down Dramatically During Continuous Printing

The printer has slowed down to prevent the printer mechanism from overheating and being
damaged.

Solutions

You can continue printing. To return to normal printing speed, leave the printer idle for at least 30
minutes with the power turned on.

LCD Screen Gets Dark

| The printeris in sleep mode.

Solutions

Press the () button on the control panel to return the LCD screen to its former state.

The Output Tray has Come Off

Insert the output tray straight into the printer. If the output tray stops halfway, insert and remove it several times.

The Root Certificate Needs to be Updated

l The root certificate has expired.
Solutions

Run Web Config, and then update the root certificate.
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Cannot Cancel Printing from a Computer Running Mac OS X v10.6.8

| Thereis a problem with your AirPrint setup.
Solutions

Run Web Config, and then select Port9100 as the Top Priority Protocol setting in AirPrint Setup. Select
System Preferences from the Apple menu > Printers & Scanners (or Print & Scan, Print & Fax), remove
the printer, and then add the printer again.

= “Application for Configuring Printer Operations (Web Config)” on page 211

A Message is Displayed on the LCD Screen

If an error message is displayed on the LCD screen, follow the on-screen instructions or the solutions below to
solve the problem.

Error Messages

Solutions

The combination of the IP address and the subnet
mask is invalid. See your documentation for more
details.

Enter the correct IP address or default gateway. Contact the person
who setup the network for assistance.

Ink is low.

You can continue printing until you are prompted to replace the ink
cartridges. However, note that the printer cannot print if any of the ink
cartridges is expended. Prepare new cartridges as soon as possible.

Ink cartridge(s) are low. Print job may not print
completely.

Select Continue printing or Replace before printing.

When you select Continue printing, the printer stops printing
indicating that it is time to replace the ink cartridge. In this case,
Select Replace now, and then replace the cartridge. Printing is
resumed after you replace the cartridge, but the color may differ
slightly. To avoid this, select No, cancel printing.

You need to replace Ink Cartridge(s).

To ensure you receive premium print quality and to help protect your
print head, a variable ink safety reserve remains in the cartridge when
your printer indicates it is time to replace the cartridge. Replace the
cartridge when you are prompted to do so.

“Replacing Ink Cartridge” on page 147

To use cloud services, update the root certificate
from the Epson Web Config utility.

Run Web Config, and then update the root certificate.

“Running Web Config on a Web Browser” on page 211

The printer's Ink Pad is nearing the end of its
service life. It is not a user-replaceable part. Please
contact Epson support.

If it reached the end, borderless printing becomes
unavailable. Printing with border is available.

Contact Epson or an authorised Epson service provider to replace the
ink pad. It is not a user-serviceable part.

Tap OK to resume printing.

“Where to Get Help” on page 231
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Error Messages

Solutions

The printer's Ink Pad has reached the end of its
service life. It is not a user-replaceable part. Please
contact Epson support.

Cannot run borderless printing until the part is
replaced. Printing with border is available.

The ink pad has reached the end of its service

life. It is not a user-replaceable part. Please contact
Epson support. If you use it as is, printing speed on
XX may slow down.

Contact Epson or an authorised Epson service provider to replace the
ink pad. It is not a user-serviceable part.

You cannot perform borderless printing until the part is replaced. You
can still print with borders. However, if you use it as it is, the printing
speed on glossy paper may be reduced.

“Where to Get Help” on page 231

Printer error. Turn the power off and on again. If
the problem persists, contact Epson Support.

Do the following.

1. Open the printer cover and remove any paper or protective
material inside the printer. Insert the front paper feeder completely.

“Paper Gets Jammed” on page 144
2. Close the printer cover and turn the power off and on again.

If the error message is still displayed after turning the power off and
on again, contact Epson support.

“Where to Get Help” on page 231

Paper Setup Auto Display is set to Off. Some
features may not be available. For details, see your
documentation.

If Paper Setup Auto Display is disabled, you cannot use AirPrint.

Have you loaded the following paper in the XX?

Change the print settings or load paper that matches the print
settings in the paper source displayed on the LCD screen, and then
change the paper settings.

If you do not want to display this message from the next time, select

E > General Settings > Printer Settings > Error Notice, and then
set Paper Mismatch to Off.

Recovery Mode

Update Firmware

The printer has started in recovery mode because the firmware
update failed. Follow the steps below to try to update the firmware
again.

1. Connect the computer and the printer with a USB cable. (During
recovery mode, you cannot update the firmware over a network
connection.)

2. Visit your local Epson website for further instructions.

Paper Gets Jammed

Check the error displayed on the control panel and follow the instructions to remove the jammed paper including
any torn pieces. Next, clear the error. The LCD screen displays an animation that shows you how to remove

jammed paper.

A Caution:

Never touch the buttons on the control panel while your hand is inside the printer. If the printer starts operating, it
could cause an injury. Be careful not to touch the protruding parts to avoid injury.
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g Important:

(J Remove the jammed paper carefully. Removing the paper vigorously may cause damage to the printer.

0 After you have removed the jammed paper from the rear paper feeder, we recommend turning the printer off and
on before you use it again. When you pull out the paper, the state of the rear paper feeder may change causing
the paper to not be loaded correctly or paper may not be fed at all.

Note:
When removing jammed paper from the inside of the printer, pull out the front paper feeder so that you can easily remove
the jammed paper.

Preventing Paper Jams

Check the following if paper jams occur frequently.

O Place the printer on a flat surface and operate in the recommended environmental conditions.

“Environmental Specifications” on page 226

J Use the paper supported by this printer.
“Available Paper and Capacities” on page 187

1 Follow paper handling precautions.
“Paper Handling Precautions” on page 27

U Load paper in the correct direction, and slide the edge guide against the edge of the paper.
“Loading Paper” on page 27

1 Do not load more than the maximum number of sheets specified for paper.

(J Load one sheet of paper at a time if you have loaded several sheets of paper.

J Make sure the paper size and paper type settings match the actual paper size and paper type loaded in the
printer.

“List of Paper Types” on page 29

U Insert the front paper feeder completely while you are not using it. If it is not inserted completely, paper may get
jammed when the printer feeds paper from the rear paper feeder.
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It is Time to Replace the Ink Cartridges

Ink Cartridge Handling Precautions

Storing precautions for ink
U Epson recommends storing ink cartridges in a cool and dark place.

U For best results, Epson recommends using up ink cartridges before the best before date printed on the package,
or within six months of opening the package, whichever is earlier.

(J After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at
least three hours before using it.

0 Do not open an ink cartridge package until you are ready to install the ink cartridge in the product.

1 Do not drop or knock it against hard objects; otherwise, the ink may leak.

Handling precautions for replacing ink cartridges

0 Do not touch the IC chip in the ink cartridge. Otherwise, you may not be able to perform operations or print
properly.
O Install all ink cartridges; otherwise you cannot print.

U Do not turn off the printer during ink charging. If the ink charging is incomplete, you may not be able to print.

J Removed ink cartridges may have ink around the ink supply port, so be careful not to get any ink on the
surrounding area when removing the cartridges.

U This printer uses ink cartridges equipped with a green chip that monitors information such as the amount of
remaining ink for each cartridge. This means that even if the cartridge is removed from the printer before it is
expended, you can still use the cartridge after reinserting it back into the printer.

U To ensure you receive premium print quality and to help protect your print head, a variable ink safety reserve
remains in the cartridge when your printer indicates to replace the cartridge. The yields quoted for you do not
include this reserve.

U Do not disassemble or remodel the ink cartridge, otherwise you may not be able to print normally.
U Do not move the print head by hand; otherwise, the printer may be damaged.

O While cartridges are in storage, keep the ink supply ports free of dust. The ink supply port has a valve in it so it
does not need to be capped.

U Do not allow foreign objects to fall into the cartridge installation section.

(O When the printer is powered off with the Q) (power) button, the print head is automatically capped to prevent
the ink from drying. Do not pull out the power plug or turn off the breaker while the power is on.
U If one of the installed ink cartridges is expended, printing cannot be performed.

U Ifan ink cartridge is expended while printing, you can continue printing after replacing the ink cartridge.

U If you continue to use ink cartridges that are running low, you may need to replace the ink cartridge while
printing. If you replace an ink cartridge while printing, especially on glossy paper, colors on the printout may be
uneven depending on how the ink dries. For best results, we recommend replacing the cartridge before printing.

U You can still use the removed ink cartridge in the future until the ink cartridge is expended.
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Consumption of ink

1 All colors of ink are used during head cleaning and other non-printing maintenance operations to ensure that
the print heads remain in good condition.

O Even for monochrome printing, all the ink colors are used in an operation designed to maintain the printing
and print head quality.

1 Depending on the paper type and print quality settings, colored inks may also be used for high-density blacks in
monochrome or grayscale printing.

O The ink supplied with your printer is used during initial setup. In order to produce the highest quality prints,
the printer needs to be and will be fully charged with ink. After setup is complete, the ink remaining in the
cartridges, and the service life of the maintenance box will be limited. Even if ink levels are low, or the service
life of the maintenance box is nearing an end, you can continue to print until the printer displays replacement
instructions. However, we recommend being prepared with replacement ink cartridges and a maintenance box.

U Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the
frequency of your prints and environmental conditions such as temperature.

Replacing Ink Cartridge

When a message is displayed prompting you to replace the ink cartridge, select How To and then view the
animations displayed on the control panel to learn how to replace the ink cartridge.

Related Information

= “Ink Cartridge Codes for SC-P900 Series” on page 203
= “Ink Cartridge Codes for SC-P700 Series” on page 204
= “Ink Cartridge Handling Precautions” on page 146

It is Time to Replace the Maintenance Box

Maintenance Box Handling Precautions

Read the following instructions before replacing the maintenance box.

U Do not touch the green chip on the side of the maintenance box. Doing so may prevent normal operation and
printing.

U Do not replace the maintenance box during printing; otherwise, ink may leak.

U Do not remove the maintenance box or open its cover except when replacing the maintenance box; otherwise
ink may leak.

U Do not reuse a maintenance box which has been removed and left detached for a long period. Ink inside the box
will have solidified and no more ink can be absorbed.

U Do not tilt the used maintenance box until after it is sealed in the plastic bag; otherwise ink may leak.
U Do not store the maintenance box in high or freezing temperatures.

J Keep the maintenance box out of direct sunlight.

U Do not drop the maintenance box or subject it to strong shocks.

U Do not touch the openings in the maintenance box as you may get smeared with ink.
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U If you are using a maintenance box that is near the end of its service life, you may need to replace it while
printing. If you replace the maintenance box while printing, especially on glossy paper, colors on the printout
may be uneven depending on how the ink dries. For best results, we recommend replacing the cartridge before
printing.

Replacing a Maintenance Box

In some print cycles a very small amount of surplus ink may be collected in the maintenance box. To prevent ink
leakage from the maintenance box, the printer is designed to stop printing when the absorbing capacity of the
maintenance box has reached its limit. Whether and how often this is required will vary according to the number
of pages you print, the type of material that you print and the number of cleaning cycles that the printer performs.

When a message is displayed prompting you to replace the maintenance box, refer to the animations displayed
on the control panel. The need for replacement of the box does not mean that your printer has ceased to operate
in accordance with its specifications. The Epson warranty does not cover the cost of this replacement. It is a
user-serviceable part.

Maintenance Error OK

The Maintenance Box is at the end of its service life.
You need to replace it.

Product Number
C9357

I/il\l Maintenance Box Cov

S oer

@ Cancel Print

Note:
U When it is full, you cannot print and clean the print head until the maintenance box is replaced to avoid ink leakage.

U When the following screen is displayed, the part cannot be replaced by users. Contact Epson support. You cannot perform
borderless printing until the part is replaced. You can still print with borders. However, if you use it as it is, the printing
speed on glossy paper may be reduced.

Information

The printer's Ink Pad has reached the end of its service
life. It is not a user-replaceable part. Please contact Epson
support.

Cannaot run borderless printing until the part is replaced.
Printing with border is available.

Related Information

= “Maintenance Box Code” on page 206

= “Maintenance Box Handling Precautions” on page 147
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Print Quality is Poor

Color Missing, Banding, or Unexpected Colors Appear in Printout

e

| The print head nozzles may be clogged.
Solutions

Perform a nozzle check to see if the print head nozzles are clogged. Perform a nozzle check, and then
clean the print head if any of the print head nozzles are clogged. If you have not used the printer for a
long time, the print head nozzles may be clogged and ink drops may not be discharged.

= “Checking and Cleaning the Print Head” on page 102

The paper may be advancing differently than before during printing due to vibration or if
the printer was moved.

Solutions

Adjust the paper feed.

= “Adjusting the Paper Feed” on page 107

| Printing is paused.
Solutions

Do not open the printer cover or the front paper feeder during printing. If you open the printer cover
or the front paper feeder during printing, printing is paused and it may cause unexpected colors in the
printout.

Blurry Prints, Vertical Banding, or Misalignment
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The following causes can be considered.
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| The print head position is out of alignment.

Solutions

On the printer's control panel, select Il > Maintenance > Print Head Alignment to align the print
head.

| The bidirectional printing setting is enabled.
Solutions
If print quality does not improve even after aligning the print head, disable the bidirectional setting.

During bidirectional (or high speed) printing, the print head prints while moving in both directions, and
vertical lines may be misaligned. Disabling this setting may slow down printing speed but improve print
quality.

O Windows

Select Quality Options as the Level setting on the printer driver's Main tab, and then clear High
Speed.

O Mac OS
Select Print Settings from the print dialog's pop-up menu, and then clear High Speed.

The Printout Comes Out as a Blank Sheet

I—

| The paper size in the print settings is incorrect.
Solutions

Make sure the paper size in the print settings matches the actual paper size.

| Multiple sheets of paper are fed into the printer at the same time.
Solutions

See the following to prevent multiple sheets of paper from being fed into the printer at the same time.

= “Several Sheets of Paper are Fed at a Time” on page 122

| The print head nozzles may be clogged.
Solutions

Perform the nozzle check, and then run the head cleaning or Power Cleaning if the print head nozzles are
clogged.

= “Checking and Cleaning the Print Head” on page 102
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Paper Is Smeared or Scuffed

One of the following situations may be the cause.

| The paper is loaded incorrectly.
Solutions

When horizontal banding (perpendicular to the printing direction) appears, or the top or bottom of the
paper is smeared, load paper in the correct direction and slide the edge guides to the edges of the paper.

= “Loading Paper” on page 27

| The paper path is smeared.
Solutions
When vertical banding (parallel to the printing direction) appears, or the paper is smeared, clean the

paper path.

= “Cleaning the Paper Path for Ink Smears” on page 109

| The paperis curled.
Solutions

Place the paper on a flat surface to check if it is curled. If it is, flatten it.

| The print head is rubbing the surface of the paper.
Solutions

When printing on thick paper, the print head is close to the printing surface and the paper may be
scuffed. In this case, enable the reduce scuff setting.

On the printer's control panel, select = > General Settings > Printer Settings, and then enable Thick
Paper.

If the edge of the paper is folded or curled, it may be scuffed by the print head. Flatten the paper if
necessary.

| The back of the paper was printed before the side that had already been printed was dry.
Solutions

When performing manual 2-sided printing, make sure that the ink is completely dry before reloading the
paper.
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Printed Photos are Sticky

| The wrong side of the photo paper was used.
Solutions

Make sure the paper size in the printer settings matches the actual paper size. If you print on the wrong
side of the photo paper, you need to clean the paper path.

= “Cleaning the Paper Path for Ink Smears” on page 109

Images or Photos Contain Unexpected Colors

One of the following situations may be the cause.

| The print head nozzles may be clogged.
Solutions

Perform a nozzle check to see if the print head nozzles are clogged. Perform a nozzle check, and then
clean the print head if any of the print head nozzles are clogged. If you have not used the printer for a
long time, the print head nozzles may be clogged and ink drops may not be discharged.

= “Checking and Cleaning the Print Head” on page 102

| Color correction has been applied.
Solutions

When printing from the Windows printer driver, the Epson auto photo adjustment setting
(PhotoEnhance) is applied by default depending on the paper type. Try change the setting.

On the Windows printer driver's Main tab, select Advanced in Mode. Change the Scene Correction
setting from Auto Correct to any other option. If changing the setting does not work, use any color
correction method other than PhotoEnhance in Mode.

= “Adjusting the Print Color” on page 87
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Colors in the Printout Differ from Those on the Display

| The color properties for the display device you are using have not been adjusted correctly.
Solutions

Display devices such as computer screens have their own display properties. If the display is unbalanced,
the image are not displayed with proper brightness and colors. Adjust the properties of the device. Next,
perform the following.

O Windows
Select EPSON Standard (sRGB) as the Mode setting on the printer driver's Main tab.

J Mac OS

Select EPSON Standard (sRGB) as the Color Settings setting from the print dialog's Print Settings
menu.

| Thedisplay device is reflecting external light.
Solutions

Avoid direct sunlight and view the image in an environment where the appropriate lighting is assured.

| Thedisplay device has a high resolution.
Solutions

Colors may differ from what you see on smart devices such as smart phones or tablets with high-
resolution displays.

| Thedisplay device and the printer have a different process of producing colors.
Solutions

Colors on a display are not quite identical to those on paper because the display device and the printer
have a different process of producing colors. Adjust the color properties so that the colors match more
closely.
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Cannot Print Without Margins

| The borderless feature is not enabled in the print settings.
Solutions

Enable the borderless feature in the print settings. If you select a paper type that does not support
borderless printing, you cannot select Borderless. Select a paper type that supports borderless printing.

O Windows

Select Borderless on the printer driver's Main tab.

J Mac OS

Select a borderless paper size from Paper Size.

= “Available Paper and Capacities” on page 187

The Edges of the Image are Cropped During Borderless Printing

| Because the image is slightly enlarged, the protruding area is cropped.
Solutions
Select a smaller enlargement setting.

J Windows

Click Expansion next to the Borderless checkbox on the printer driver's Main tab, and then change
the settings.

J Mac OS

Change the Expansion setting from the print dialog's Page Layout Settings menu.
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The Position, Size, or Margins of the Printout Are Incorrect

N

|

P\

One of the following situations may be the cause.

| The paper is loaded incorrectly.
Solutions

Load paper in the correct direction, and slide the edge guides against the edges of the paper.

= “Loading Paper” on page 27

| The paper size in the printer settings is incorrect.

Solutions

Make sure the paper size in the printer settings matches the actual paper size.

| The margin setting inthe application software is not within the printable area.

Solutions
Adjust the margin setting in the application so that it falls within the printable area.

= “Printable Area” on page 220

Printed Characters Are Incorrect or Garbled
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One of the following situations may be the cause.

]| The USB cable is not connected correctly.

Solutions

Connect the USB cable securely to the printer and the computer.

| Thereis a job waiting to be printed.
Solutions

Cancel any paused print jobs.
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| The computer has been manually put into Hibernate or Sleep mode while printing.
Solutions

Do not put the computer manually into Hibernate or Sleep mode while printing. Pages of garbled text
may be printed the next time you start the computer.

The Printed Image Is Inverted

| Theimage is set to invert horizontally in the print settings.
Solutions
Clear any mirror image settings in the printer driver or the application.

O Windows

Clear Mirror Image on the printer driver’s Layout tab.

J Mac OS

Clear Flip Horizontal from the print dialog's Layout menu.

Mosaic-Like Patterns Appear in the Printout

| Low resolution images or photos were printed.
Solutions

When printing images or photos, print using high-resolution data. Images on web sites are often low
resolution even if they look good enough on the display, and so print quality may decline when you print
them.

Vertical lines Appears on Roll Paper
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l Rollers on the roll paper unit are smeared.

Solutions

If you are printing on glossy roll paper with the SC-P900 Series printer and uneven vertical lines appear,
remove the paper from the roll paper unit, and clean the rollers using a dry, soft, clean cloth. Rotate the
rollers as you wipe them to clean the entire surface.

| Thereis dust or other debris on the paper.
Solutions

Remove the dust or debris from the surface of your paper before loading it.

The Top Edge of the Paper is Scratched

| If multiple sheets of paper are loaded, they may scratch each other.
Solutions

Load one sheet of paper at a time.
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Eject Roller Marks Appear on Printouts

| Roller marks may appear when you use some glossy paper types.
Solutions

Select Front Paper Feeder - No Eject Roller(Glossy Paper) in the Paper Setting menu, then load paper
in the front paper feeder. This feature is only available for glossy paper. When you use this feature,
borderless printing is not available and there will be 2 cm margins at the top and bottom of the printouts.

Some Parts of Pre-printed Paper Cannot be Printed

| The printer does not recognize the pre-printed parts of the paper as printable.
Solutions
Add the paper information, and then disable the Paper Size Check feature using Epson Media Installer.
Start Epson Media Installer, and then add the paper information you want to print. Edit the paper
information, and then clear the Paper Size Check checkbox.
= “Adding paper information (print settings)” on page 197
= “Editing paper information” on page 201

Uneven Colors Appear at the Bottom Edge of Glossy Paper

When the print results on glossy paper are uneven, such as faint bands in dark areas at the bottom edge, enable
Bottom Edge Print Quality Priority. Since priority is given to improving the unevenness, the printing speed will
be slower.

J Windows

Select Quality Options as the Level setting on the printer driver's Main tab, and then select Bottom Edge Print
Quality Priority.

J Mac OS

Select Print Settings from the print dialog's pop-up menu, and then select Quality Options as the Print
Quality setting. Select Bottom Edge Print Quality Priority.
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Cannot Solve Problem

If you cannot solve the problem after trying all of the solutions, contact Epson support.

If you cannot solve printing problems, see the following related information.

Related Information

= “Cannot Solve Printing Problems” on page 159

Cannot Solve Printing Problems

Try the following problems in order starting at the top until you solve the problem.

(J Make sure you match the paper type loaded in the printer and the paper type set on the printer to the paper
type settings in the printer driver.

“Paper Size and Type Settings” on page 28
J Use a higher quality setting on the control panel or the printer driver.
O Reinstall the ink cartridges already installed in the printer.
Reinstalling the ink cartridges may clear clogging in the print head nozzles and allow the ink to flow smoothly.

However, because the ink is consumed when the ink cartridge is reinstalled, a message asking you to replace the
ink cartridge may be displayed depending on the amount of ink remaining.

“It is Time to Replace the Ink Cartridges” on page 146
U Align the print head.
“Aligning the Print Head” on page 107
U Run a nozzle check to see if the print head nozzles are clogged.

If there are missing segments in the nozzle check pattern, the nozzles may be clogged. Repeat head cleaning and
the nozzle check alternately 3 times and check if the clogging has cleared.

Note that print head cleaning uses some ink.
“Checking and Cleaning the Print Head” on page 102
U Turn off the printer, wait for at least 6 hours, and then check if the clogging has cleared.
If the problem is clogging, leaving the printer for a while without printing may solve the problem.
You can check the following items while the printer is off.
O Check that you are using genuine Epson ink cartridges.

Try to use genuine Epson ink cartridges. This product is designed to adjust colors based on the use of genuine
Epson ink cartridges. The use of non-genuine ink cartridges may cause print quality to decline.

“Consumable Products Information” on page 203

(J Make sure that there are no paper fragments left inside the printer.

When you remove the paper, do not touch the translucent film with your hand or the paper.
O Check the paper.

Check if the paper is curled or loaded with the printable side facing up.

“Paper Handling Precautions” on page 27

“Available Paper and Capacities” on page 187

“Unavailable Paper Types” on page 197
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(J Make sure that you are not using an old ink cartridge.

For best results, Epson recommends using up ink cartridges before the best before date printed on the package,
or within six months of opening the package, whichever is earlier.

U If you turn off the printer, wait for at least 6 hours, and if print quality has still not improved, run Power
Cleaning.

“Running Power Cleaning” on page 105
If you cannot solve the problem by checking the solutions above, you may need to request repairs. Contact Epson

support.

Related Information
= “Before Contacting Epson” on page 232
= “Contacting Epson Support” on page 232
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Connecting to a Printer that has been Connected to
the Network

When the printer has already been connected to the network, you can connect a computer or a smart device to the
printer over the network.

Using a Network Printer from a Second Computer

We recommend using the installer to connect the printer to a computer. You can run the installer using one of the
following methods.

[ Setting up from the website
Access the following website, and then enter the product name. Go to Setup, and then start setting up.

https://epson.sn

[ Setting up using the software disc (only for the models that come with a software disc and users with Windows
computers with disc drives.)

Insert the software disc into the computer, and then follow the on-screen instructions.

Selecting the Printer

Follow the on-screen instructions until the following screen is displayed, select the printer name you want to
connect to, and then click Next.
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Follow the on-screen instructions.
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Using a Network Printer from a Smart Device

You can connect a smart device to the printer using one of the following methods.

Connecting over a wireless router
Connect the smart device to the same Wi-Fi network (SSID) as the printer.
See the following for more details.

“Making Settings for Connecting to the Smart Device” on page 164

Connecting by Wi-Fi Direct
Connect the smart device to the printer directly without a wireless router.
See the following for more details.

“Connecting a Smart Device and Printer Directly (Wi-Fi Direct)” on page 170

Re-setting the Network Connection

This section explains how to make the network connection settings and change the connection method when
replacing the wireless router or the computer.

When Replacing the Wireless Router
When you replace the wireless router, make settings for the connection between the computer or the smart device
and the printer.

You need to make these settings if you change your Internet service provider and so on.

Making Settings for Connecting to the Computer

We recommend using the installer to connect the printer to a computer. You can run the installer using one of the
following methods.

[ Setting up from the website
Access the following website, and then enter the product name. Go to Setup, and then start setting up.

http://epson.sn

O Setting up using the software disc (only for the models that come with a software disc and users with Windows
computers with disc drives.)

Insert the software disc into the computer, and then follow the on-screen instructions.

Selecting the Connection Methods

Follow the on-screen instructions until the following screen is displayed.
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Select Change connection method for printer (for new network router or changing USB to network, etc.) on
the Select Your Operation screen, and then click Next.
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Follow the on-screen instructions.
If you cannot connect, see the following to try to solve the problem.
U Windows: “Cannot connect to a Network” on page 125

1 Mac OS: “Cannot connect to a Network” on page 132

Making Settings for Connecting to the Smart Device

You can use the printer from a smart device when you connect the printer to the same Wi-Fi network (SSID) as the
smart device. To use the printer from a smart device, set up from the following website. Access to the website from
the smart device that you want to connect to the printer.

http://epson.sn > Setup

When Changing the Computer

When changing the computer, make connection settings between the computer and the printer.

Making Settings for Connecting to the Computer
We recommend using the installer to connect the printer to a computer. You can run the installer using one of the
following methods.

O Setting up from the website
Access the following website, and then enter the product name. Go to Setup, and then start setting up.

https://epson.sn
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[ Setting up using the software disc (only for the models that come with a software disc and users with Windows
computers with disc drives.)

Insert the software disc into the computer, and then follow the on-screen instructions.

Follow the on-screen instructions.

Changing the Connection Method to the Computer

This section explains how to change the connection method when the computer and the printer have been
connected.

Changing the Network Connection from Ethernet to Wi-Fi

Change the Ethernet connection to Wi-Fi connection from the printer's control panel. The changing connection
method is basically the same as the Wi-Fi connection settings.

Related Information

= “Making Wi-Fi Settings from the Control Panel” on page 167

Changing the Network Connection from Wi-Fi to Ethernet

Follow the steps below to change from a Wi-Fi connection to an Ethernet connection.

1. Tap = on the printer's control panel.

2. Tap General Settings > Network Settings > Wired LAN Setup.
3. Tap Start Setup.

4. Check the message, and then tap OK.

5. Connect the printer to the router with an Ethernet cable.

Changing from USB to a Network Connection

Using the installer and re-set up in a different connection method.

O Setting up from the website
Access the following website, and then enter the product name. Go to Setup, and then start setting up.

http://epson.sn

O Setting up using the software disc (only for the models that come with a software disc and users with Windows
computers with disc drives.)

Insert the software disc into the computer, and then follow the on-screen instructions.

Selecting Change the Connection Methods

Follow the on-screen instructions until the following screen is displayed.
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Select Change connection method for printer (for new network router or changing USB to network, etc.) on
the Select Your Operation screen, and then click Next.
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Select the network connection that you want to use, Connect via wireless network (Wi-Fi) or Connect via wired
LAN (Ethernet), and then click Next.
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Follow the on-screen instructions.
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Making Wi-Fi Settings from the Control Panel

You can make network settings from the printer's control panel in several ways. Choose the connection method
that matches the environment and conditions that you are using.

If you know the information for the wireless router such as SSID and password, you can make settings manually.
If the wireless router supports WPS, you can make settings by using push button setup.

After connecting the printer to the network, connect to the printer from the device that you want to use (computer,
smart device, tablet, and so on.)

Making Wi-Fi Settings by Entering the SSID and Password

You can set up a Wi-Fi network by entering the information necessary to connect to a wireless router from the
printer's control panel. To set up using this method, you need the SSID and password for a wireless router.

Note:
If you are using a wireless router with its default settings, the SSID and password are on the label. If you do not know the
SSID and password, see the documentation provided with the wireless router.

1. Tap (B8 on the home screen.

2. Tap Wi-Fi (Recommended).
If the printer has already been connected by Ethernet, tap Router.

3. Tap Start Setup.

If the network connection is already set up, the connection details are displayed. Tap Change Settings to
change the settings.

If the printer has already been connected by Ethernet, tap Change to Wi-Fi connection., and then tap Yes
after confirming the message.

4. Tap Wi-Fi Setup Wizard.

5. Select the SSID for the wireless router.

Note:
O Ifthe SSID you want to connect to is not displayed on the printer’s control panel, tap Search Again to update the list.
If it is still not displayed, tap Enter Manually, and then enter the SSID directly.

QO Ifyou do not know the network name (SSID) check if the information is written on the label of the wireless router.
If you are using the wireless router with its default settings, use the SSID on the label. If you cannot find any
information, see the documentation provided with the wireless router.
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6. Tap the Enter Password field, and then enter the password.

Note:
L The password is case-sensitive.

QO Ifyou do not know the password, check if the information is written on the label of the wireless router. On the label,

"o

the password may be written "Network Key", "Wireless Password", and so on. If you are using the wireless router
with its default settings, use the password written on the label.

7. When you have setup finished, tap Start Setup.

8. Tap Close.
The screen automatically closes after a specific length of time if you do not tap Close.

Note:
If you fail to connect, load A4 size plain paper, and then tap Print Check Report to print a connection report.

9. Tap Close on the network connection settings screen.

Related Information

= “Entering Characters” on page 25
= “Checking the Network Connection Status” on page 178

Making Wi-Fi Settings by Push Button Setup (WPS)

You can automatically set up a Wi-Fi network by pressing a button on the wireless router. If the following
conditions are met, you can set up by using this method.

O The wireless router is compatible with WPS (Wi-Fi Protected Setup).

O The current Wi-Fi connection was established by pressing a button on the wireless router.

1. Tap (B8 on the home screen.

2. Tap Wi-Fi (Recommended).
If the printer has been already connected by Ethernet, tapRouter.

3. Tap Start Setup.

If the network connection is already set up, the connection details are displayed. Tap Change Settings to
change the settings.

If the printer has been already connected by Ethernet, tap Change to Wi-Fi connection., and then tap Yes
after confirming the message.

4. Tap Push Button Setup(WPS).
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5.

8.

Hold down the [WPS] button on the wireless router until the security light flashes.

\/

o

If you do not know where the [WPS] button is, or there are no buttons on the wireless router, see the
documentation provided with your wireless router for details.

O O O O

Tap Start Setup.

Tap Close.
The screen automatically closes after a specific length of time if you do not tap Close.

Note:
If connection fails, restart the wireless router, move it closer to the printet, and try again. If it still does not work, print a
network connection report and check the solution.

Tap Close on the network connection settings screen.

Related Information

= “Checking the Network Connection Status” on page 178

Making Wi-Fi Settings by PIN Code Setup (WPS)

You can automatically connect to an wireless router by using a PIN code. You can use this method to set up if an
wireless router is capable of WPS (Wi-Fi Protected Setup). Use a computer to enter a PIN code into the wireless

router.

1. Tap (B8 on the home screen.

2. Tap Wi-Fi (Recommended).
If the printer has been already connected by Ethernet, tap Router.

3. Tap Start Setup.
If the network connection is already set up, the connection details are displayed. Tap Change Settings to
change the settings.
If the printer has been already connected by Ethernet, tap Change to Wi-Fi connection., and then tap Yes
after confirming the message.

4. Tap Others > PIN Code Setup(WPS).
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5. Use your computer to enter the PIN code (an eight digit number) displayed on the printer's control panel into
the wireless router within two minutes.

Note:
See the documentation provided with your wireless router for details on entering a PIN code.

6. Tap Start Setup on the printer's control panel.

7. Tap Close.
The screen automatically closes after a specific length of time if you do not tap Close.

Note:
If connection fails, restart the wireless router, move it closer to the printer, and try again. If it still does not work, print a
connection report and check the solution.

8. Tap Close on the network connection settings screen.

Related Information

= “Checking the Network Connection Status” on page 178

Connecting a Smart Device and Printer Directly (Wi-Fi
Direct)

Wi-Fi Direct (Simple AP) allows you to connect a smart device directly to the printer without a wireless router and
print from the smart device.

About Wi-Fi Direct

Use this connection method when you are not using Wi-Fi at home or at the office, or when you want to connect
the printer and the computer or smart device directly. In this mode, the printer acts as a wireless router and you
can connect the devices to the printer without having to use a standard wireless router. However, devices directly
connected to the printer cannot communicate with each other through the printer.

ffr/_\
l e EPSON J
|
]
= = =

The printer can be connected by Wi-Fi or Ethernet, and Wi-Fi Direct (Simple AP) connection simultaneously.
However, if you start a network connection in Wi-Fi Direct (Simple AP) connection when the printer is connected
by Wi-Fi, the Wi-Fi is temporarily disconnected.
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Connecting to an iPhone, iPad or iPod touch using Wi-Fi Direct

This method allows you to connect the printer directly to an iPhone, iPad or iPod touch without a wireless router.
The following conditions are required to use this function. If your environment does not match these conditions,
you can connect by selecting Other OS Devices. See the related information link below for details on connecting.

0 iOS 11 or later
J Using the standard camera application to scan the QR code

O Epson Smart Panel version 1.0 or later

Epson printing app, such as Epson Smart Panel, is used to print from a smart device. Install Epson printing app on
the smart device in advance.

Note:
You only need to make these settings for the printer and the smart device that you want to connect to once. Unless you
disable Wi-Fi Direct or restore the network settings to their defaults, you do not need to make these settings again.

1. Tap (B8 on the home screen.
2. Tap Wi-Fi Direct.
3. Tap Start Setup.

4. TapiOS.

Cther OF Devices

LGhamga

The QR code is displayed on the printer's control panel.

SrArphons Connssl

andand Camara app

Sea Dascrip®on Crihar Mathods
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5.  On your iPhone, iPad or iPod touch, start the standard Camera app, and then scan the QR code displayed on
the printer's control panel in PHOTO mode.

Use the Camera app for iOS 11 or later. You cannot connect to the printer using the Camera app for iOS 10
or earlier. Also, you cannot connect using an app for scanning QR codes. If you cannot connect, select Other
Methods on the printer's control panel. See the related information link below for details on connecting.

6. Tap the notification displayed on the screen of the iPhone, iPad or iPod touch.

8. On the printer's control panel, select Next.

9. On the iPhone, iPad or iPod touch, start Epson printing app.

Examples of Epson printing apps

Epson Smart
Panel
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10. On the Epson printing app screen, tap Printer is not selected..

On the Epson Smart Panel, the smart device automatically connects to the printer when it starts.

11. Select the printer that you want to connect to.

See the information displayed on the printer's control panel to select the printer.
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12. On the printer's control panel, select Complete.

For smart devices that have been connected to the printer before, select the network name (SSID) on the smart
device's Wi-Fi screen to connect them again.

Related Information

= “Application for Easily Operating the Printer from a Smart device (Epson Smart Panel)” on page 209
= “Connecting to Devices other than iOS and Android using Wi-Fi Direct” on page 175

Connecting to Android Devices using Wi-Fi Direct

This method allows you to connect the printer directly to your Android device without a wireless router. The
following conditions are required to use this function.

(J Android 4.4 or later

O Epson Smart Panel version 1.0 or later

Epson Smart Panel is used to print from a smart device. Install Epson Smart Panel on the smart device in advance.

Note:
You only need to make these settings for the printer and the smart device that you want to connect to once. Unless you
disable Wi-Fi Direct or restore the network settings to their defaults, you do not need to make these settings again.

1. Tap (B8 on the home screen.
2. Tap Wi-Fi Direct.

3. Tap Start Setup.
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4. Tap Android.

u L Select 05

Ao el

5. On the smart device, start Epson printing app.

Examples of Epson printing apps

EPSON

Epson Smart
Panel

6. On the Epson printing app screen, tap Printer is not selected..

On the Epson Smart Panel, the smart device automatically connects to the printer when it starts.

7. Select the printer that you want to connect to.

See the information displayed on the printer's control panel to select the printer.

n Clasa Smarphane connec!

pwing printer in Epson Smart Pansd
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Note:
Printers may not been displayed depending on the Android device. If printers are not displayed, connect by selecting
Other OS Devices. See the related information link below for connecting.

8.  When the device connection approval screen is displayed, select Approve.

9. On the printer's control panel, select Complete.
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For smart devices that have been connected to the printer before, select the network name (SSID) on the smart
device's Wi-Fi screen to connect them again.

Related Information

= “Application for Easily Operating the Printer from a Smart device (Epson Smart Panel)” on page 209
= “Connecting to Devices other than iOS and Android using Wi-Fi Direct” on page 175

Connecting to Devices other than iOS and Android using Wi-Fi
Direct

This method allows you to connect the printer directly to smart devices without a wireless router.

Note:
You only need to make these settings for the printer and the smart device that you want to connect to once. Unless you
disable Wi-Fi Direct or restore the network settings to their defaults, you do not need to make these settings again.

1. Tap [ o1 the home screen.
2. Tap Wi-Fi Direct.
3. Tap Start Setup.

4. Tap Other OS Devices.

Oeher OS5 Devicas

The Network Name (SSID) and Password for Wi-Fi Direct for the printer are displayed.
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5.  On the smart device's Wi-Fi screen, select the SSID shown on the printer's control panel, and then enter the
password.

{ Battinas Wi-Fi Eror the patsworsd Tor =
Cancel Enter Password Join

Wi-Fi
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6. On the printer's control panel, select Next.
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7. On the printing app screen for the smart device, select the printer that you want to connect to.

See the information displayed on the printer's control panel to select the printer.

u Closn Smarphane connect
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8. On the printer's control panel, select Complete.

For smart devices that have been connected to the printer before, select the network name (SSID) on the smart
device's Wi-Fi screen to connect them again.

Disconnecting Wi-Fi Direct (Simple AP) Connection

There are two methods available to disable a Wi-Fi Direct (Simple AP) connection; you can disable all connections
by using the printer's control panel, or disable each connection from the computer or the smart device. When you
want to disable all connections, see the related information link below for details.

n Important:

When Wi-Fi Direct (Simple AP) connection disabled, all computers and smart devices connected to the printer in
Wi-Fi Direct (Simple AP) connection are disconnected.

Note:
If you want to disconnect a specific device, disconnect from the device instead of the printer. Use one of the following
methods to disconnect the Wi-Fi Direct (Simple AP) connection from the device.

U Disconnect the Wi-Fi connection to the printer's network name (SSID).

[ Connect to another network name (SSID).

Related Information
= “Changing the Wi-Fi Direct (Simple AP) Settings Such as the SSID” on page 177

Changing the Wi-Fi Direct (Simple AP) Settings Such as the SSID

o E—
— —
- e~
0 0)

When Wi-Fi Direct (simple AP) connection is enabled, you can change the settings from > Wi-Fi Direct

> Start Setup > Change, and then the following menu items are displayed.
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Change Network Name

Change the Wi-Fi Direct (simple AP) network name (SSID) used for connecting to the printer to your arbitrary
name. You can set the network name (SSID) in ASCII characters that is displayed on the software keyboard on the
control panel. You can enter up to 22 characters.

When changing the network name (SSID), all connected devices are disconnected. Use the new network name
(SSID) if you want to re-connect the device.

Change Password

Change the Wi-Fi Direct (simple AP) password for connecting to the printer to your arbitrary value. You can set
the password in ASCII characters that is displayed on the software keyboard on the control panel. You can enter 8
to 22 characters.

When changing the password, all connected devices are disconnected. Use the new password if you want to
re-connect the device.

Change Frequency Range
Change the frequency range of Wi-Fi Direct used for connecting to the printer. You can select 2.4 GHz or 5 GHz.
When changing the frequency range, all connected devices are disconnected. Re-connect the device.

Note that you cannot re-connect from devices that do not support 5 GHz frequency range when changing to 5
GHz.

Depending on the region, this setting may not be displayed.

Disable Wi-Fi Direct

Disable Wi-Fi Direct (simple AP) settings of the printer. When disabling it, all devices connected to the printer in
Wi-Fi Direct (Simple AP) connection are disconnected.

Restore Default Settings
Restore all Wi-Fi Direct (simple AP) settings to their defaults.
The Wi-Fi Direct (simple AP) connection information of the smart device saved to the printer is deleted.

Note:
You can also set up from the Network tab > Wi-Fi Direct on Web Config for the following settings.

U Enabling or disabling Wi-Fi Direct (simple AP)
U Changing network name (SSID)
U Changing password
U Changing the frequency range
Depending on the region, this setting may not be displayed.
( Restoring the Wi-Fi Direct (simple AP) settings

Checking the Network Connection Status

You can check the network connection status in the following way.
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Checking the Network Connection Status from the Control Panel

You can check the network connection status using the network icon or the network information on the printer’s
control panel.

Checking the Network Connection Status using the Network Icon

You can check the network connection status and strength of the radio wave using the network icon on the
printer's home screen.

Related Information

= “Guide to the Network Icon” on page 22

Displaying Detailed Network Information on the Control Panel

When your printer is connected to the network, you can also view other network-related information by selecting
the network menus you want to check.

1. Tap F on the printer's control panel.
2. Select General Settings > Network Settings > Network Status.

3. To check the information, select the menus that you want to check.

(1 Wired LAN/Wi-Fi Status

Displays the network information (device name, connection, signal strength, obtain IP address, and so on)
for Ethernet or Wi-Fi connections.

(J Wi-Fi Direct Status

Displays whether Wi-Fi Direct (Simple AP) is enabled or disabled for Wi-Fi Direct (Simple AP)
connections.

(J Print Status Sheet

Prints a network status sheet. The information for Ethernet, Wi-Fi, Wi-Fi Direct (Simple AP), and so on is
printed on two or more pages.

Printing a Network Connection Report
You can print a network connection report to check the status between the printer and the wireless router.

1. Load papers.

2. Tap = on the printer's control panel.
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3. Tap General Settings > Network Settings > Connection Check.

The connection check starts.
4. Tap Print Check Report.

5. Follow the instructions on the printer's screen to print the network connection report.

If an error has occurred, check the network connection report, and then follow the printed solutions.

6. Tap Close.

Messages and Solutions on the Network Connection Report

Check the messages and error codes on the Network Connection Report, and then follow the solutions.
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Spcurity Kay/Pasaword Chack Urschign osd
IP Mddress Chack Unohec ked
Detalled IP Setup Cheak Unchecked

Hetswork Status

Printer Kams EPSOM XXXXXX
Printer Madel XX-XXX Saries
IF Address 169.25%4.137.8
Subnet Mask 255.255.0.0
Dafault Cateway

Mabwork Nasa (S5ID) Epsoniet
Sasusley Hone

Sigrnal Strength Poar

MAC Address FR:DO:27:40:C0:AC

a. Error code

b. Network Environment Message

Related Information

= “E-1” on page 181

= “E-2, E-3, E-7” on page 181
= “E-5” on page 182

= “E-6” on page 182
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= “E-8” on page 182

= “E-9” on page 183

= “E-10” on page 183

= “E-11” on page 183

= “E-12” on page 184

= “E-13” on page 184

= “Message on the Network Environment” on page 185

E-1

Solutions:
0 Make sure the Ethernet cable is securely connected to your printer and to your hub or other network device.
J Make sure your hub or other network device is turned on.

Q If you want to set up a Wi-Fi connection, reselect the Wi-Fi settings because they are currently disabled.

E-2, E-3, E-7

Solutions:

(J Make sure your wireless router is turned on.

U Confirm that your computer or device is connected correctly to the wireless router.

[ Turn off the wireless router. Wait for about 10 seconds, and then turn it on.

J Place the printer closer to your wireless router and remove any obstacles between them.

U If you have entered the SSID manually, check if it is correct. Check the SSID from the Network Status part on
the network connection report.

O If an wireless router has multiple SSIDs, select the SSID that is displayed. When the SSID is using a non-
compliant frequency, the printer does not display them.

0 If you are using push button setup to establish a network connection, make sure your wireless router supports
WPS. You cannot use push button setup if your wireless router does not support WPS.

0 Makes sure your SSID uses only ASCII characters (alphanumeric characters and symbols). The printer cannot
display an SSID that contains non-ASCII characters.

J Makes sure you know your SSID and password before connecting to the wireless router. If you are using a
wireless router with its default settings, the SSID and password are located on a label on the wireless router.
If you do not know your SSID and password, contact the person who set up the wireless router, or see the
documentation provided with the wireless router.

U If you are connecting to an SSID generated from a tethering smart device, check for the SSID and password in
the documentation provided with the smart device.

QO If your Wi-Fi connection suddenly disconnects, check for the conditions below. If any of these conditions are
applicable, reset your network settings by downloading and running the software from the following website.

http://epson.sn > Setup

U Another smart device was added to the network using push button setup.

U The Wi-Fi network was set up using any method other than push button setup.
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Related Information

= “Making Settings for Connecting to the Computer” on page 164
= “Making Wi-Fi Settings from the Control Panel” on page 167

E-5

Solutions:

Make sure the wireless router’s security type is set to one of the following. If it is not, change the security type on
the wireless router, and then reset the printer’s network settings.

QO WEP-64 bit (40 bit)
O WEP-128 bit (104 bit)
O WPA PSK (TKIP/AES)”

0 WPA2 PSK (TKIP/AES)"
O WPA (TKIP/AES)

O WPA2 (TKIP/AES)

0 WPA3-SAE (AES)

* WPA PSK is also known as WPA Personal. WPA2 PSK is also known as WPA2 Personal.

E-6

Solutions:

O Check if MAC address filtering is disabled. If it is enabled, register the printer’s MAC address so that it is not
filtered. See the documentation provided with the wireless router for details. You can check the printer's MAC
address from the Network Status part on the network connection report.

U If your wireless router is using shared authentication with WEP security, make sure the authentication key and
index are correct.

U If the number of connectable devices on the wireless router is less than the number of network devices that you
want to connect, make settings on the wireless router to increase the number of connectable devices. See the
documentation provided with the wireless router to make settings.

Related Information

= “Making Settings for Connecting to the Computer” on page 164

E-8

Solutions:
J Enable DHCP on the wireless router if the printer’s Obtain IP Address setting is set to Auto.

U If the printer’s Obtain IP Address setting is set to Manual, the IP address you manually set is invalid due to out
of range (for example: 0.0.0.0). Set a valid IP address from the printer’s control panel.
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Related Information

= “Network Settings” on page 216

E-9

Solutions:
Check the following.
O Devices are turned on.

O You can access the Internet and other computers or network devices on the same network from the devices you
want to connect to the printer.

If still does not connect your printer and network devices after confirming the above, turn oft the wireless router.
Wait for about 10 seconds, and then turn it on. Then reset your network settings by downloading and running the
installer from the following website.

http://epson.sn > Setup

Related Information

= “Making Settings for Connecting to the Computer” on page 164

E-10

Solutions:
Check the following.
(1 Other devices on the network are turned on.

O Network addresses (IP address, subnet mask, and default gateway) are correct if you have set the printer’s
Obtain IP Address to Manual.

Reset the network address if they are incorrect. You can check the IP address, subnet mask, and default gateway
from the Network Status part on the network connection report.

If DHCP is enabled, change the printer’s Obtain IP Address setting to Auto. If you want to set the IP address
manually, check the printer’s IP address from the Network Status part on the network connection report, and then
select Manual on the network settings screen. Set the subnet mask to [255.255.255.0].

If still does not connect your printer and network devices, turn off the wireless router. Wait for about 10 seconds,

and then turn it on.

Related Information

= “Network Settings” on page 216

E-11

Solutions:

Check the following.
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1 The default gateway address is correct if you set the printer’s TCP/IP Setup setting to Manual.

(J The device that is set as the default gateway is turned on.

Set the correct default gateway address. You can check the default gateway address from the Network Status part
on the network connection report.

Related Information

= “Network Settings” on page 216

E-12

Solutions:
Check the following.
(3 Other devices on the network are turned on.

1 The network addresses (IP address, subnet mask, and default gateway) are correct if you are entering them
manually.

J The network addresses for other devices (subnet mask and default gateway) are the same.

(J The IP address does not conflict with other devices.

If still does not connect your printer and network devices after confirming the above, try the following.

U Turn off the wireless router. Wait for about 10 seconds, and then turn it on.

1 Make network settings again using the installer. You can run it from the following website.
http://epson.sn > Setup

J You can register several passwords on a wireless router that uses WEP security type. If several passwords are
registered, check if the first registered password is set on the printer.

Related Information

= “Network Settings” on page 216
= “Making Settings for Connecting to the Computer” on page 164

E-13

Solutions:
Check the following.
(1 Network devices such as a wireless router, hub, and router are turned on.

1 The TCP/IP Setup for network devices has not been set up manually. (If the printer’s TCP/IP Setup is set
automatically while the TCP/IP Setup for other network devices is performed manually, the printer’s network
may differ from the network for other devices.)

If it still does not work after checking the above, try the following.

(J Turn off the wireless router. Wait for about 10 seconds, and then turn it on.
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O Make network settings on the computer that is on the same network as the printer using the installer. You can
run it from the following website.

http://epson.sn > Setup

U You can register several passwords on a wireless router that uses the WEP security type. If several passwords are
registered, check if the first registered password is set on the printer.

Related Information

= “Network Settings” on page 216
= “Making Settings for Connecting to the Computer” on page 164

Message on the Network Environment

Message

Solution

The Wi-Fi environment needs to be
improved. Turn the wireless router off and
then turn it on. If the connection does not
improve, see the documentation for the
wireless router.

After moving the printer closer to the wireless router and removing any
obstacles between them, turn off the wireless router. Wait for about

10 seconds, and then turn it on. If it still does not connect, see the
documentation supplied with the wireless router.

*No more devices can be connected.
Disconnect one of the connected devices
if you want to add another one.

Computer and smart devices that can be connected simultaneously are
connected in full in the Wi-Fi Direct (Simple AP) connection. To add another
computer or smart device, disconnect one of the connected devices or
connect it to the other network first.

You can confirm the number of wireless devices which can be connected
simultaneously and the number of connected devices by checking the
network status sheet or the printer’s control panel.

The same SSID as Wi-Fi Direct exists in the
environment. Change the Wi-Fi Direct SSID
if you cannot connect a smart device to the

On the printer’s control panel, go to Wi-Fi Direct Setup screen and select the
menu to change the setting. You can change the network name following
after DIRECT-XX-. Enter within 22 characters.

printer.

Printing a Network Status Sheet
You can check the detailed network information by printing it.

1. Load papers.

2. Tap = on the printer's control panel.

3. Tap General Settings > Network Settings > Network Status.
4. Tap Print Status Sheet.

5. Check the message, and then print the network status sheet.

6. Tap Close.
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Paper Information

Available Paper and Capacities

Genuine Epson Paper for SC-P900 Series

Epson recommends using genuine Epson paper to ensure high-quality printouts.

Note:

The availability of paper varies by location. For the latest information on paper available in your area, contact Epson

support.

Even if "/" is attached to borderless printing availability, borderless printing may not be possible depending on the
Level selected in the printer driver.

Paper suitable for printing documents =

Media Name Size Loading ICC Profile Borderless Black ink
Capacity
(Sheets)
Bright White Ink Jet A3 40 Epson_SC- Ve Matte Black
Paper P900_700_Sta
A4 80 ndard.icc

* You can specify and perform borderless printing; however, margins may appear or the print quality may decline due to the
paper expanding or contracting.

Paper suitable for printing photos N

Media Name Size Loading ICC Profile Borderless Black ink
Capacity
(Sheets)
Premium Glossy A2 1 Epson_SC- v Photo Black
Photo Paper P900_700_Eps
A3+, A3, 11x14in. 10 onPremiumGlo
ssy.icc
Letter, A4, 20
8x10in., 16:9 wide
size(102x181 mm)
13x18 cm (5x7in.), 30
10x15 cm (4x6in.)
Premium Semigloss A2 1 Epson_SC- v Photo Black
Photo Paper P900_700_Eps
A3+, A3 10 onPremiumSe
migloss.icc
Letter, A4, 13x18 cm 20
(5x7in.)
10x15 cm (4x6 in.) 30
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Media Name Size Loading ICC Profile Borderless Black ink
Capacity
(Sheets)
Photo Paper Glossy A3+, A3, 11x17in. 10 Epson_SC- v Photo Black
P900_700_Pho
Letter, A4, 13x18 cm 30 toPaperGlossy.i
(5x7in.), 10x15 cm cc
(4x6 in.)
Watercolor Paper - A3+ 1 Epson_SC- v Matte Black
Radiant White P900_700_Wat

ercolorPaperRa
diantWhite.icc

Velvet Fine Art Paper 17x221in., A2, A3+,A3, | 1 Epson_SC- v Matte Black
Letter, A4 P900_700_Velv
etFineArtPaper.
icc
UltraSmooth Fine Art 17x22in., A2, A3+ 1 Epson_SC- 4 Matte Black
Paper P900_700_Ultr
aSmoothFineA
rtPaper.icc
Matte Paper- A3+, A3 10 Epson_SC- v Matte Black
Heavyweight P900_700_Arc
Letter, A4, 8x10in. 30 hivalMattePap
er.icc
Epson Premium A3+, A3 10 Epson_SC- v Photo Black
Luster Photo Paper P900_700_Pre
A4 30 miumLusterPh

otoPaper.icc

Paper suitable for printing documents and photos Ed

Media Name Size Loading ICC Profile Borderless Black ink
Capacity
(Sheets)
Archival Matte Paper 17x22in., A2 1 Epson_SC- v Matte Black
P900_700_Arc
A3+, A3, 11x14in. 10 hivalMattePap
ericc
Letter, A4, 8x10in. 30
Photo Quiality Ink Jet 17x22in., A2 10 Epson_SC- Ve Matte Black
Paper P900_700_Sta
A3+, A3, 11x17in,, 50 ndard.icc
Legal
Letter, A4 60
Double-Sided Matte Letter, A4 1 Epson_SC- - Matte Black
Paper P900_700_Arc
hivalMattePap
ericc
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*

Depending on the image you are printing and the condition of the paper, ink may adhere to the edges of the paper and

cause stains or print quality deterioration on borderless printouts. If you see print quality issues, disable the borderless
printing feature and try printing again.

Various other paper types =

Media Name Size Loading ICC Profile Borderless Black ink
Capacity
(Sheets)

Photo Quiality Self A4 1 Epson_SC- - Matte Black
Adhesive Sheets P900_700_Sta

ndard.icc
Epson Proofing Paper A3+ 1 Epson_SC- 4 Photo Black
White Semimatte P900_700_Pro

ofingPaperWhi

teSemimatte.ic

d

Roll Paper 6>

Media Name Size Size Borderless Black ink
Premium Glossy 406 mm/16" Epson_SC- v Photo Black
Photo Paper (250) P900_700_Eps

onPremiumGlo

ssy.icc
Premium Semigloss 406 mm/16" Epson_SC- v Photo Black
Photo Paper (250) P900_700_Eps

onPremiumSe

migloss.icc
Premium Luster Photo | 329 mm/13", 406 mm/16" Epson_SC- Ve Photo Black
Paper (260) P900_700_Pre

miumLusterPh

otoPaper.icc
Premium Semimatte 406 mm/16" Epson_SC- v Photo Black
Photo Paper (260) P900_700_Eps

onPremiumSe

migloss.icc
Enhanced Matte 432 mm/17" Epson_SC- Ve Matte Black
Paper P900_700_Arc

hivalMattePap

er.icc
Epson Proofing Paper 329 mm/13",432 mm/17" Epson_SC- Vel Photo Black
White Semimatte P900_700_Pro

ofingPaperWhi

teSemimatte.ic
C

*  There are no left and right borders.
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Genuine Epson Paper for SC-P700 Series

Epson recommends using genuine Epson paper to ensure high-quality printouts.

Note:

The availability of paper varies by location. For the latest information on paper available in your area, contact Epson

support.

Even if "/" is attached to borderless printing availability, borderless printing may not be possible depending on the
Level selected in the printer driver.

Paper suitable for printing documents 5

Media Name Size Loading ICC Profile Borderless Black ink
Capacity
(Sheets)
Bright White Ink Jet A3 40 Epson_SC- Ve Matte Black
Paper P900_700_Sta
A4 80 ndard.icc

* You can specify and perform borderless printing; however, margins may appear or the print quality may decline due to the
paper expanding or contracting.

Paper suitable for printing photos N

Media Name Size Loading ICC Profile Borderless Black ink
Capacity
(Sheets)

Premium Glossy A3+, A3, 11x14in. 10 Epson_SC- v Photo Black
Photo Paper P900_700_Eps

Letter, A4, 20 onPremiumGlo

8x10in., 16:9 wide ssy.icc

size(102x181 mm)

13x18 cm (5x7in.), 30

10x15 cm (4x6in.)
Premium Semigloss A3+ A3 10 Epson_SC- v Photo Black
Photo Paper P900_700_Eps

Letter, A4, 13x18 cm 20 onPremiumSe

(5x7in.) migloss.icc

10x15 cm (4x6in.) 30
Photo Paper Glossy A3+, A3, 11x17in 10 Epson_SC- v Photo Black

P900_700_Pho

Letter, A4, 13x18 cm 30 toPaperGlossy.i

(5x7in.), 10x15 cm cc

(4x6in.)
Watercolor Paper - A3+ 1 Epson_SC- v Matte Black

Radiant White

P900_700_Wat
ercolorPaperRa
diantWhite.icc
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Media Name Size Loading ICC Profile Borderless Black ink
Capacity
(Sheets)
Velvet Fine Art Paper A3+, A3, Letter, A4 1 Epson_SC- v Matte Black
P900_700_Velv
etFineArtPaper.
icc
UltraSmooth Fine Art A3+ 1 Epson_SC- v Matte Black
Paper P900_700_Ultr
aSmoothFineA
rtPaper.icc
Matte Paper- A3+, A3 10 Epson_SC- 4 Matte Black
Heavyweight P900_700_Arc
Letter, A4, 8x10in. 30 hivalMattePap
er.icc
Epson Premium A3+, A3 10 Epson_SC- v Photo Black
Luster Photo Paper P900_700_Pre
A4 30 miumLusterPh
otoPaper.icc
Paper suitable for printing documents and photos El
Media Name Size Loading ICC Profile Borderless Black ink
Capacity
(Sheets)
Archival Matte Paper A3+, A3, 11x14in. 10 Epson_SC- 4 Matte Black
P900_700_Arc
Letter, A4, 8x10in. 30 hivalMattePap
er.icc
Photo Quiality Ink Jet A3+, A3, 11x17in., 50 Epson_SC- Ve Matte Black
Paper Legal P900_700_Sta
ndard.icc
Letter, A4 60
Double-Sided Matte Letter, A4 1 Epson_SC-900 - Matte Black

Paper

_700_Archival
MattePaper.icc

* Depending on the image you are printing and the condition of the paper, ink may adhere to the edges of the paper and
cause stains or print quality deterioration on borderless printouts. If you see print quality issues, disable the borderless
printing feature and try printing again.

Various other paper types =

Media Name Size Loading ICC Profile Borderless Black ink
Capacity
(Sheets)
Photo Quality Self A4 1 Epson_SC- - Matte Black
Adhesive Sheets P900_700_Sta
ndard.icc
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Media Name Size Loading ICC Profile Borderless Black ink
Capacity
(Sheets)
Epson Proofing Paper A3+ 1 Epson_SC- v Photo Black
White Semimatte P900_700_Pro
ofingPaperWhi
teSemimatte.ic
C
Roll Paper &>
Media Name Size Size Borderless Black ink
Premium Luster Photo | 329 mm/13" Epson_SC- Ve Photo Black
Paper (260) P900_700_Pre

miumLusterPh
otoPaper.icc

Epson Proofing Paper 329 mm/13" Epson_SC- Vel Photo Black
White Semimatte P900_700_Pro

ofingPaperWhi

teSemimatte.ic

C

*  There are no left and right borders.

Commercially Available Paper for SC-P900 Series

Even if "/" is attached to borderless printing availability, borderless printing may not be possible depending on the
Level selected in the printer driver.

g Important:

O Although plain paper and recycled paper manufactured by other companies can be loaded and fed in the printer
as long as they meet the following specifications, Epson cannot guarantee the print quality.

O Although other paper types manufactured by other companies can be loaded in the printer as long as they meet
the following specifications, Epson cannot guarantee the paper feeding and print quality.
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Name Size Capacity Thickness Source Borderless
Plain paper (cut sheets) US C(17x22in.), USB (11x17 50*1 0.08 to Rear paper v2
in.), A2, A3+, B4 0.11Tmm (64 feeder
to 90g/m?)
B3 -
A3 40*1 /2
Half Letter, B5, A5 120*3 -
Legal, Letter, A6 s2
A4 80" /"2
Non-standard sizes 50°1 -
Width: 89 to 431.8 mm
Length: 127 to 1200 mm
Roll paper Width: 210 mm (A4 width) to 1 0.08t0 0.7 Roll paper /25
431.8 mm (17" width) mm unit

Length: 55 to 3276.7 mm™*

Outer diameter: smaller than
150mm
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Name

Size

Capacity

Thickness

Source

Borderless

Thick paper

US C(17x22in.), A2,41x51 cm
(16x201in.), A3+, USB (11x17
in.), A3, 279x356 mm (11x14
in.), JIS B4, 254x305 mm
(10x12in.), Letter, A4, Legal,
20x25 cm (8x10in.), 13x20
cm (5x8in.), 13x18 cm (5x7in.),
16:9 wide size(102x181 mm),
10x15 cm (4x6in.), 9x13 cm
(3.5x5 in.), A6, Postcard

36x43 cm (14x17 in.), 30x30
cm (12x12in.), JIS B3, Half
Letter, JIS B5, Postcard Double,
A5

Non-standard sizes
Width: 89 to 431.8 mm
Length: 127 to 1200 mm

1

0.11t0 0.5
mm

Rear paper
feeder™®

e

US C(17x22in.), A2, 41x51
cm (16x20in.), A3+, US B
(11x17in.), A3, 279x356 mm
(11x14in.), JIS B4, 254x305
mm (10x12 in.), Letter, A4,
Legal

36x43 cm (14x17 in.), 30x30
cm (12x12in.), JIS B3

Non-standard sizes
Width: 203.2 to 431.8 mm
Length: 279.4 to 3276.7 mm

0.5t00.7
mm

Front paper
feeder (Fine
Art)

e

US C(17x22in.), A2,41x51 cm
(16x201in.), JIS B3, 36x43 cm
(14x17in.), 30x30 cm (12x12
in.), A3+, USB (11x17in.), A3,
279x356 mm (11x14in.), JIS
B4, 254x305 mm (10x12in.),
Legal, Letter, A4

Non-standard sizes
Width: 203.2 to 431.8 mm
Length: 279.4 to 3276.7 mm

0.7t0 1.5
mm

Front paper
feeder
(Poster
Board)

CD/DVD

Premium surface

12cm

Disk tray

CD/DVD

12cm

Disk tray

*1:  The number of sheets that can be set varies depending on the paper thickness. The total thickness of the loaded paper
must not exceed 5mm.

*2: You can specify and perform borderless printing; however, margins may appear or the print quality may decline due to the
paper expanding or contracting. See the manual supplied with the paper and adjust settings as appropriate.
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*3:

*4;
*5:
*6:

Commercially Available Paper for SC-P700 Series

The max length you can set in printer driver is 18 m.
There are no left and right borders.

If feeding fails, load paper into the front paper feeder.

The number of sheets that can be set varies depending on the paper thickness. The total thickness of the loaded paper
must not exceed 12mm.

Even if "/" is attached to borderless printing availability, borderless printing may not be possible depending on the
Level selected in the printer driver.

Important:

U Although plain paper and recycled paper manufactured by other companies can be loaded and fed in the printer
as long as they meet the following specifications, Epson cannot guarantee the print quality.

O Although other paper types manufactured by other companies can be loaded in the printer as long as they meet
the following specifications, Epson cannot guarantee the paper feeding and print quality.

Name Size Capacity Thickness Source Borderless
Plain paper (cut sheets) USB(11x17in.), A3+, B4 50°1 0.08 to Rear paper /2
0.11Tmm (64 feeder

A3 40" to 90g/m?) /2
Half Letter, B5, A5 12073 -
Legal, Letter, A6 s2
A4 80°3 /2
Non-standard sizes 50*1 -
Width: 89 to 330.2 mm
Length: 127 to 1200 mm

Roll paper Width: 210 mm (A4 width) to 1 0.08t0 0.7 Roll paper s25
330.2 mm (13" width) mm unit

Length: 55 to 3276.7 mm™

Outer diameter: smaller than
84mm
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Name

Size

Capacity

Thickness

Source

Borderless

Thick paper

A3+,USB (11x17in.), A3,
279x356 mm (11x14in.), JIS
B4, 254x305 mm (10x12in.),
Letter, A4, Legal, 20x25 cm
(8x10in.), 13x20 cm (5x8in.),
13x18 cm (5x7in.), 16:9 wide
size(102x181 mm), 10x15 cm
(4x6in.), 9x13 cm (3.5x5 in.),
A6, Postcard

1

30x30 cm (12x12 in.), Half
Letter, JIS B5, Postcard Double,
A5

Non-standard sizes
Width: 89 to 330.2 mm
Length: 127 to 1200 mm

0.11t0 0.5
mm

Rear paper
feeder™®

e

A3+, USB (11x17in.), A3,
279x356 mm (11x14in.),
254x305 mm (10x12in.),
Letter, A4, Legal, JIS B4

30x30 cm (12x12in.)

Non-standard sizes
Width: 203.2 to 330.2 mm
Length: 279.4 to 3276.7 mm

0.5t0 0.7
mm

Front paper
feeder (Fine
Art)

a

30x30 cm (12x12in.), A3+, US
B (11x17in.), A3, 279x356 mm
(11x14in.), JIS B4, 254x305
mm (10x12 in.), Legal, Letter,
A4

Non-standard sizes
Width: 203.2 to 330.2 mm
Length: 279.4 to 3276.7 mm

0.7t0 1.5
mm

Front paper
feeder
(Poster
Board)

Premium surface
CD/DVD

12cm

Disk tray

CD/DVD

12¢cm

Disk tray

*1:  The number of sheets that can be set varies depending on the paper thickness. The total thickness of the loaded paper

must not exceed 5mm.

*2:  You can specify and perform borderless printing; however, margins may appear or the print quality may decline due to the

paper expanding or contracting. See the manual supplied with the paper and adjust settings as appropriate.

*3:  The number of sheets that can be set varies depending on the paper thickness. The total thickness of the loaded paper

must not exceed 12mm.

*4:  The max length you can set in printer driver is 18 m.

*5:  There are no left and right borders.

*6:  If feeding fails, load paper into the front paper feeder.
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Unavailable Paper Types

Do not use the following papers. Using these types of paper causes paper jams and smears on the printout.
J Papers that are wavy

[ Papers that are torn or cut

(O Papers that are folded

O Papers that are damp

O Papers that are too thick or too thin

1 Papers that have stickers

0 Printing on anything except for inkjet paper, which is slow-drying, may cause print stains.
Printing to Paper Types Other than Genuine Paper

Adding paper information (print settings)

You need the optimum paper settings to make full use of the paper's capabilities. When printing on paper other
than genuine paper, add the paper information (media settings) to the printer and select the paper setting that best
suits the paper.

You need to download and install Epson Media Installer from the Epson web site.

n Important:

U Use a computer that is connected to the Internet, and perform operations after connecting your computer to the
printer.

U Paper information is added to your computer and printer over the Internet from a dedicated Epson server.

1. Display the add paper information screen from Epson Print Layout or the printer driver.

O Epson Print Layout
Select Media Type > Download Media.

Printer | EPSOMN

Paper Size | A4 210 x 297 mm

Paper Source | Roll Paper

Quality | Quality

¥ Black Enhance Overcoat
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U Windows
Select Epson Media Installer on the Utility tab of the printer driver.

You can also start it from a shortcut icon on the computer's desktop.

0 Mac OS
Start Epson Media Installer as shown below.

Applications > Epson Software > Epson Utilities > Epson Media Installer.app

A list of paper information that can be added is displayed.

B Epson Media Installer — O X
Media Management Media Download @
Printer Region Media Vendor Media Type
EPSON SC-P7500 Series - Local - EPSON ~ All ~
Media Vendor Media Name Media Type Notifications Status Last Updated
EPSON Backlit (High density print) Other ©Not Registered 1/22/2020 9:56:00 AM
EPSON Backlit Other & Mot Registered 1/22/2020 9:56:00 AM
EPSON Proof Paper 3 Proofing Paper ©Not Registered 1/21/2020 6:30:00 PM
EPSON Proof Paper 2 Proofing Paper © Mot Registered 1/21/2020 6:30:00 PM
EPSON Proof Paper 1 Proofing Paper ©Not Registered 1/21/2020 6:30:00 PM
EPSON Premium Semigloss Photo Paper(170) Photo Paper CNot Acquired |12/10/2019 3:05:00 PM
EPSON Premium Luster Photo Paper(260) Photo Paper (ONot Acquired |[12/10/2019 2:55:00 PM
EPSON Plain Paper Plain Paper (ONot Acquired |12/10/2019 3:25:00 PM
EPSON Backlight Film Roll PK Other ONot Acquired |12/10/2019 3:35:00 PM
EPSON Backlight Film Roll MK Other (CNot Acquired |12/10/2019 3:32:00 PM
EPSON Fine Art Matte FineArt Paper CNot Acquired |12/10/2019 3:22:00 PM
EPSON Washi FineArt Paper (ONot Acquired |[12/10/2019 3:21:00 PM
EPSON Washi <Thin> FineArt Paper (Not Acquired |12/10/2019 3:20:00 PM
EPSON Baryta Photo Paper CONot Acquired [12/10/2019 3:06:00 PM
EPSON Canvas Matte Canvas (INot Acquired |12/10/2019 3:24:00 PM
EPSON Canvas Satin Canvas Mot Acquired [12/10/2019 3:22:00 PM
EPSON Enhanced Low Adhesive Synthetic Paper Other CONot Acquired |12/10/2019 3:31:00 PM
EPSON Enhanced Adhesive Synthetic Paper Other (ONot Acquired |[12/10/2019 3:31:00 PM
EPSON Enhanced Synthetic Faper Other CONot Acquired [12/10/2019 3:30:00 PM
EPSON Enhanced Matte Poster Board Other (INot Acquired |12/10/2019 3:28:00 PM
EPSON Velvet Fine Art Paper FineArt Paper (Not Acquired |12/10/2019 3:19:00 PM
EPSON UltraSmooth Fine Art paper FineArt Paper CNot Acquired |12/10/2019 3:17:00 PM
EPSON Watercolor Paper - Radiant White FineArt Paper (ONot Acquired |[12/10/2019 3:12:00 PM
EPSON Epson Proofing Paper Commercial Proofing Paper CNot Acquired [12/10/2019 3:06:00 PM
EPSON Epson Proofing Paper White Semimatte Proofing Paper (Not Acquired [12/10/2019 3:06:00 PM
EPSON Photo Quality Inkjet Paper Matte Paper (Mot Acquired |12/10/2019 3:11:00 PM
EPSON Singleweight Matte Paper Matte Paper ONot Acquired |12/10/2019 3:10:00 PM
EPSON Archival Matte Paper Matte Paper (CONot Acquired |12/10/2019 3:09:00 PM| ¥

If the target paper information is not available, see the paper manufacturer's website and set the paper.
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2.

Add the paper information.
Select the target paper and click Download and Register.

B Epson Media Installer — O X
Media Management Media Download
Printer Region Media Vendor Media Type
EPSON SC-P7500 Series - Local - EPSON ~ All ~
Media Vendor Media Name Media Type Notifications Status Last Updated
EPSON Backlit (High density print) Other ©Not Registered 1/22/2020 9:56:00 AM
EPSON Backlit Other &) Mot Registered 1/22/2020 9:56:00 AM
EPSON Proof Paper 3 Proofing Paper ©Not Registered 1/21/2020 6:30:00 PM
EPSON Proof Paper 2 Proofing Paper © Mot Registered 1/21/2020 6:30:00 PM
EPSON Proof Paper 1 Proofing Paper ©Not Registered 1/21/2020 6:30:00 PM
EPSON Premium Semigloss Photo Paper(170) Photo Paper CNot Acquired |12/10/2019 3:05:00 PM
EPSON Premium Luster Photo Paper(260) Photo Paper (ONot Acquired |12/10/2019 2:55:00 PM
EPSON Plain Paper Plain Paper (ONot Acquired |12/10/2019 3:25:00 PM
EPSON Backlight Film Roll PK Other ONot Acquired |12/10/2019 3:35:00 PM
EPSON Backlight Film Roll MK Other (Not Acquired |12/10/2019 3:32:00 PM
EPSON Fine Art Matte FineArt Paper CNot Acquired |12/10/2019 3:22:00 PM
EPSON Washi FineArt Paper (ONot Acquired |[12/10/2019 3:21:00 PM
EPSON Washi <Thin> FineArt Paper (ONot Acquired |12/10/2019 3:20:00 PM
EPSON Baryta Photo Paper CONot Acquired [12/10/2019 3:06:00 PM
EPSON Canvas Matte Canvas (INot Acquired |12/10/2019 3:24:00 PM
EPSON Canvas Satin Canvas Mot Acquired |12/10/2019 3:22:00 PM
EPSON Enhanced Low Adhesive Synthetic Paper Other CONot Acquired |12/10/2019 3:31:00 PM
EPSON Enhanced Adhesive Synthetic Paper Other (ONot Acquired |12/10/2019 3:31:00 PM
EPSON Enhanced Synthetic Faper Other CONot Acquired [12/10/2019 3:30:00 PM
EPSON Enhanced Matte Poster Board Other (INot Acquired |12/10/2019 3:28:00 PM
EPSON Velvet Fine Art Paper FineArt Paper (ONot Acquired |12/10/2019 3:19:00 PM
EPSON UltraSmooth Fine Art paper FineArt Paper CNot Acquired |12/10/2019 3:17:00 PM
EPSON Watercolor Paper - Radiant White FineArt Paper (ONot Acquired |[12/10/2019 3:12:00 PM
EPSON Epson Proofing Paper Commercial Proofing Paper CNot Acquired |12/10/2019 3:06:00 PM
EPSON Epson Proofing Paper White Semimatte Proofing Paper (Not Acquired [12/10/2019 3:06:00 PM
EPSON Photo Quality Inkjet Paper Matte Paper (Mot Acquired |12/10/2019 3:11:00 PM
EPSON Singleweight Matte Paper Matte Paper CNot Acquired |12/10/2019 3:10:00 PM
EPSON Archival Matte Paper Matte Paper (CONot #

You can select the added paper information from Epson Print Layout, printer drivers, and the paper setting
menus on the printer's control panel.

Select the target paper in the paper type setting in Epson Print Layout or the printer driver, and then print.

To use the paper information that has been added by Epson Media Installer correctly,the paper type selected in
Epson Print Layout or the printer driver must also be selected on the paper setting screen on the control panel.
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If you have added paper information, you can use the added paper's ICC profile in Epson Print Layout, printer
drivers, and other applications.

More Options X

Printing Choices Color Management

Custom Print Size
Color Management

Color Handling: | printer Manages Colors

Trrana Snaras cRGR TECAR10ARAD 1

Rendering Intent: | Perceptual A4

;. Did you remember to enable color management
in the printer preferences dialog?

Printer Preferences...

oK Cancel Help

n Important:

If you uninstall and reinstall the printer driver, reregister your paper information using Epson Media Installer.
Otherwise, the paper information may not appear in Epson Print Layout, the printer driver, or other applications.

To reregister the paper information, start Epson Media Installer and select Media Management > Refresh

B Epson Media Installer — O X
Media Management Media Download @
A TR R =
Printer
EPSON SC-P7500 Series & Refresh
Media Type Media Name MNotificationsStatus Editable Removable
Photo Paper Premium Luster Photo Paper (260) ONot Acquired
Photo Paper Premium Glossy Photo Paper (250) (ONot Acquired
Photo Paper Premium Semigloss Photo Paper (250) ONot Acquired
Photo Paper Premium Semimatte Photo Paper (260) (Not Acquired
Photo Paper Premium Glossy Photo Paper (170} CNot Acquired
Photo Paper Premium Semigloss Photo Paper (170) ONot Acquired
Photo Paper Premium Glossy Photo Paper CINaot Acquired
Photo Paper Premium Semigloss Photo Paper (ONot Acquired
Photo Paper Premium Luster Photo Paper (ONot Acquired
Photo Paper Photo Paper Gloss 250 @ Registered
Photo Paper Baryta CONot Acquired
4 ]
Proofing Paper Epson Proofing Paper White Semimatte (ONot Acquired
Proofing Paper Epson Proofing Paper Commercial ONot Acquired
FineArt Paper ‘Velvet Fine Art Paper (ONot Acquired
FineArt Paper ‘Watercolor Paper - Radiant White (ONot Acquired
FineArt Paper UltraSmooth Fine Art Paper (ONot Acquired
FineArt Paper Fine Art Matte CONot Acquired
FineArt Paper ‘Washi Thin CONot Acquired
FineArt Paper ‘Washi CNot Acquired
FineArt Paper EMATest_FineArtPaper Li] @ Registered
Matte Paper Doubleweight Matte Paper ONot Acquired
Matte Paper Singleweight Matte Paper (ONot Acquired
Matte Paper Phote Quality Ink Jet Paper CONot Acquired
Matte Paper Enhanced Matte Paper CONot Acquired
Matte Paper Archival Matte Paper CNot Acquired
Canvas Canvas Satin OMNot Acquired
Canvas Canvas Matte (ONat Acauired
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Editing paper information
You can edit the paper information and print using your favorite settings.

1. Start Epson Media Installer, and select Media Management. Select the paper settings (media settings) that you

want to edit, and then select .

B Epson Media Installer - m} X

Media Management Media Download @
of O =2 G
Printer
EPSON SC-P7500 Series v Refresh

Media Type Media Name NotificationsStatus Editable Removable

Photo Paper Premium Luster Photo Paper (260) ONot Acquired Gl

Photo Paper Premium Glossy Photo Paper (250) CINot Acquired

Photo Paper Premium Semigloss Photo Paper (250) (ONot Acquired

Photo Paper Premium Semimatte Photo Paper (260) (ONot Acquired

Photo Paper Premium Glossy Photo Paper (170) (ONot Acquired

Photo Paper Premium Semigloss Photo Paper (170) CONot Acquired

Photo Paper Premium Glossy Photo Paper (Mot Acquired

Photo Paper Premium Semigloss Photo Paper (CONot Acquired

Photo Paper Premium Luster Photo Paper ONot Acquired

Photo Paper Photo Paper Gloss 250 @ Registered

Photo Paper Baryta (ONot Acquired

Photo Paper ________ Photo Paper Gloss250(Copy) __ ____________________________ -Regsteed .

Proofing Paper Epson Proofing Paper White Semimatte (ot Acquired

Proofing Paper Epson Proofing Paper Commercial (ONot Acquired

FineArt Paper Velvet Fine Art Paper CINot Acquired

FineArt Paper Watercolor Paper - Radiant White (ONot Acquired

FineArt Paper UltraSmooth Fine Art Paper ONot Acquired

Finedrt Paper Fine Art Matte (ONot Acquired

FineArt Paper Washi Thin (ONot Acquired

FineArt Paper Washi (Mot Acquired

FineArt Paper EMATest_FineArtPaper i) @ Registered [

Matte Paper Doubleweight Matte Paper ONot Acquired

Matte Paper Singleweight Matte Paper CINot Acquired

Matte Paper Photo Quality Ink Jet Paper (ONot Acquired

Matte Paper Enhanced Matte Paper (ONot Acquired

Matte Paper Archival Matte Paper (Not Acquired

Canvas Canvas Satin (ONot Acquired

Canvas Canvas Matte CINot Acauired -

i

2. Select the paper information that you copied, and then select

Note:
The edits are only performed on the copied paper information (media settings). You cannot edit the original paper
information directly. You can copy paper information for paper with the status Registered.
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3.

Specify each setting on the editing screen, and then select OK.

8
Media Setting Name Baryta(Copy)
Media Type Photo Paper v
| Plzten Gap 0.9 ¥ | mm
Drying Time per Pass 100 sec (0.0 - 10.0)
| Paper Thickness 0.10 rm (0,10 - 1.50)
Paper Size Check
Paper Feed Offset -0.70 % (-0.70 - 0.70)
Paper Feed Offset(Bottom) |0.70 % (-0.70 - 0.70)
ICC Profile
RGB Profile |P200 EPSON_Barytaice Browse
m Cancel

Items

Setting Explanation

Media Setting Name

Specify a name for the media settings.

Media Type Set the category name for the paper. This is displayed to the paper type display in
the printer driver or on the printer's control panel.

Platen Gap Specify the interval (platen gap) of the print head and the paper. If the paper is
smeared, increase the value. If running Print Head Alignment on the printer does
not improve graininess or blurring in the print outs, decrease the value.

Drying Time per Pass Specify the length of time to stop the print head after each pass to help the ink dry.

Depending on the paper, the ink may not dry easily. Specify a longer drying time
when ink dripping or bleeding occurs in the print outs. Note that setting a longer
drying time will increase the overall print time.

Paper Thickness

Specify the paper thickness.

Paper Size Check

We recommend selecting this setting. Clear this checkbox if a paper error is
displayed even if you have loaded the paper correctly. Note that if you clear this
checkbox, the following occurs.

QO Printing may be performed beyond the edges of the paper and the inside of the
printer may be stained with ink.

(1 Borderless printing is disabled

Paper Feed Offset

Specify this setting when banding (horizontal band-like patterns or uneven colors)
cannot be resolved even after checking and cleaning the print head or performing
Print Head Alignment on the printer. If the speed of the paper feed is too slow,
dark banding will occur. In this situation, adjust the paper feed in the positive (+)
direction. If the paper feed is too fast, white banding will occur. In this situation,
adjust the paper feed in the negative (-) direction.

Paper Feed Offset(Bottom)

Specify the value for paper feed offset for the printing area up to approximately 39
mm from the end of cut paper.

ICC Profile

Allows you to specify the ICC profile for other paper types.
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4. Select the edited paper from paper type in Epson Print Layout or the printer driver, and then print.

Consumable Products Information

Ink Cartridge Codes for SC-P900 Series

The following are the codes for genuine Epson ink cartridges.

For Europe, Australia and New Zealand

Ink color Product number
PK (Photo Black) T47A1
C(Cyan) T47A2
VM(Vivid Magenta) T47A3
Y (Yellow) T47A4
LC (Light Cyan) T47A5
VLM(Vivid Light Magenta) T47A6
GY(Gray) T47A7
MK(Matte Black) T47A8
LGY(Light Gray) T47A9
V(Violet) T47AD

For Hong Kong and Mongolia

Ink color Product number
PK (Photo Black) T47C1
C(Cyan) T47C2
VM(Vivid Magenta) T47C3
Y (Yellow) T47C4
LC (Light Cyan) T47C5
VLM(Vivid Light Magenta) T47C6
GY(Gray) T47C7
MK(Matte Black) T47C8
LGY(Light Gray) T47C9
V(Violet) T47CD

For Asian Countries except Hong Kong and Mongolia
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Ink color Product number
PK (Photo Black) T47E1
C(Cyan) T47E2
VM(Vivid Magenta) T47E3
Y (Yellow) TA47E4
LC (Light Cyan) T47E5
VLM(Vivid Light Magenta) T47E6
GY(Gray) TA7E7
MK(Matte Black) TA7E8
LGY(Light Gray) T47E9
V(Violet) T47ED

Epson recommends the use of genuine Epson ink cartridges. Epson cannot guarantee the quality or reliability of
non-genuine ink. The use of non-genuine ink may cause damage that is not covered by Epson’s warranties, and
under certain circumstances, may cause erratic printer behavior. Information about non-genuine ink levels may

not be displayed.

Note:
O Ink cartridge codes may vary by location. For the correct codes in your area,contact Epson support.

' Not all cartridges are available in all regions.

O For users in Europe, visit the following website for information on Epson's ink cartridge yields.
http://www.epson.eu/pageyield

O Although the ink cartridges may contain recycled materials, this does not affect printer function or performance.

O Specifications and appearance of the ink cartridge are subject to change without prior notice for improvement.

Ink Cartridge Codes for SC-P700 Series

The following are the codes for genuine Epson ink cartridges.

For Europe, Australia and New Zealand

Ink color Product number
PK (Photo Black) T4651
C(Cyan) T46S52
VM(Vivid Magenta) T46S3
Y (Yellow) T4654
LC (Light Cyan) T46S5
VLM(Vivid Light Magenta) T4656
GY(Gray) T46S7
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Ink color Product number
MK(Matte Black) T4658
LGY(Light Gray) T4659
V(Violet) T46SD
For Hong Kong
Ink color Product number
PK (Photo Black) T46V1
C(Cyan) T46V2
VM(Vivid Magenta) T46V3
Y (Yellow) T46V4
LC (Light Cyan) T46V5
VLM(Vivid Light Magenta) T46V6
GY(Gray) T46V7
MK(Matte Black) T46V8
LGY(Light Gray) T46V9
V(Violet) T46VD

For Asian Countries except Hong Kong

Ink color Product number
PK (Photo Black) T46X1
C(Cyan) T46X2
VM(Vivid Magenta) T46X3
Y (Yellow) T46X4
LC (Light Cyan) T46X5
VLM(Vivid Light Magenta) T46X6
GY(Gray) T46X7
MK(Matte Black) T46X8
LGY(Light Gray) T46X9
V(Violet) T46XD

Epson recommends the use of genuine Epson ink cartridges. Epson cannot guarantee the quality or reliability of
non-genuine ink. The use of non-genuine ink may cause damage that is not covered by Epson’s warranties, and
under certain circumstances, may cause erratic printer behavior. Information about non-genuine ink levels may
not be displayed.
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Note:
O Ink cartridge codes may vary by location. For the correct codes in your area,contact Epson support.

U Not all cartridges are available in all regions.

L For users in Europe, visit the following website for information on Epson's ink cartridge yields.
http://www.epson.eu/pageyield

O Although the ink cartridges may contain recycled materials, this does not affect printer function or performance.

O Specifications and appearance of the ink cartridge are subject to change without prior notice for improvement.

Maintenance Box Code

The maintenance box can be purchased and replaced by the user. Epson recommends the use of a genuine Epson
maintenance box.

The following is the code for the genuine Epson maintenance box.

C9357

g Important:

Once a maintenance box has been installed in a printer it cannot be used with other printers.

Software Information

This section introduces the network services and software products available for your printer from the Epson
website.

Software for Printing

Application for Printing from a Computer (Windows Printer Driver)

The printer driver controls the printer according to the commands from an application. Making settings on the
printer driver provides the best printing results. You can also check the status of the printer or keep it in top
operating condition using the printer driver utility.

You can change the language of the printer driver. Select the language you want to use from the Language setting
on the Utility tab.

Accessing the printer driver from applications
To make settings that apply only to the application you are using, access from that application.
Select Print or Print Setup from the File menu. Select your printer, and then click Preferences or Properties.

Note:
Operations differ depending on the application. See the application’s help for details.

Accessing the printer driver from the control panel

To make settings that apply to all of the applications, access from the control panel.
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J Windows 10

Click on the start button, and then select Windows System > Control Panel > View devices and printers in
Hardware and Sound. Right-click on your printer, or press and hold it and then select Printing preferences

J Windows 8.1/Windows 8

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound. Right-click
on your printer, or press and hold it and then select Printing preferences

O Windows 7

Click the start button, and select Control Panel > View devices and printers in Hardware and Sound.
Right-click on your printer and select Printing preferences.

Accessing the printer driver from the printer icon on the task bar
The printer icon on the desktop task bar is a shortcut icon allowing you to quickly access the printer driver.

If you click the printer icon and select Printer Settings, you can access the same printer settings window as the one
displayed from the control panel. If you double-click this icon, you can check the status of the printer.

Note:
If the printer icon is not displayed on the task bar, access the printer driver window, click Monitoring Preferences on the
Utility tab, and then select Register the shortcut icon to the taskbar.

Starting the utility
Access the printer driver window. Click the Utility tab.

Related Information

= “Menu Options for the Printer Driver” on page 71

Making Operation Settings for the Windows Printer Driver

You can make settings such as enabling EPSON Status Monitor 3.
1. Access the printer driver window.
2. Click Speed and Progress on the Utility tab.

3. Make the appropriate settings, and then click OK.

See the online help for explanations of the setting items.

Application for Printing from a Computer (Mac OS Printer Driver)
The printer driver controls the printer according to the commands from an application. Making settings on the

printer driver provides the best printing results. You can also check the status of the printer or keep it in top
operating condition using the printer driver utility.

Accessing the printer driver from applications

Click Page Setup or Print on the File menu of your application. If necessary, click Show Details (or ¥) to expand
the print window.
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Note:
Depending on the application being used, Page Setup may not be displayed in the File menu, and the operations for
displaying the print screen may differ.See the application’s help for details.

Starting the utility

Select System Preferences from the Apple menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Utility > Open Printer Utility.

Related Information

= “Menu Options for the Printer Driver” on page 91

Guide to Mac OS Printer Driver

Epson Printer Utility

You can run a maintenance feature such as nozzle check and print head cleaning, and by starting EPSON Status
Monitor, you can check printer status and error information.

(@) Epson Printer Utility 4

G

Buy Epson Ink

EPSON XXXX Series

Version X.XX(X. %K)

Ready
© Connected ‘Update
CPSON Status Nozzle Check Head Cleaning
Moniter
Printer List

Application for Printing to Easily Layout and Print Photos (Epson Print
Layout)

Epson Print Layout is an application that allows you to print retouched and processed photos using a simple
procedure. It can also be used as plug-in software for Adobe Photoshop, Adobe Lightroom, Nikon ViewNX-i, and

SILKYPIX. For details on supported applications and supported data formats, see the manual that supplied with
Epson Print Layout.

You can download Epson Print Layout from the Epson website. You can also install it using EPSON Software
Updater.

http://www.epson.com
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Note:
QO To use this application the printer driver for this printer must be installed.

U See to the software manual for details on how to start from commercially available application software such as Adobe
Photoshop and Adobe Lightroom.

O You can use Epson Print Layout on iPad. This allows you to move your project to other locations.

Q Search for and install Epson Print Layout from the App Store.

Related Information

= “Installing the Applications Separately” on page 110
= “Application for Updating Software and Firmware (EPSON Software Updater)” on page 212

Application for Quick and Fun Printing from a Computer (Epson Photo+)

Epson Photo+ is an application that allows you to easily print images with a variety of layouts. You can also
perform image correction and adjust the position while viewing a preview of your document. You can also
brighten up your images by adding text and stamps wherever you like. You can also print a CD/DVD jacket

for CD/DVD case. When printing on genuine Epson photo paper, the ink performance is maximized creating a
beautiful finish with excellent coloring.

See the application's help for details. You can download Epson Photo+ from the Epson website.
http://www.epson.com

Note:
To use this application the printer driver for this printer must be installed.

Starting on Windows

U Windows 10
Click the start button, and then select Epson Software > Epson Photo+.

J Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

J Windows 7

Click the start button, and select All Programs or Programs > Epson Software > Epson Photo+.

Starting on Mac OS
Select Go > Applications > Epson Software > Epson Photo+.

Related Information

= “Installing the Applications Separately” on page 110

Application for Easily Operating the Printer from a Smart device (Epson Smart
Panel)
Epson Smart Panel is an application that allows you to perform printer operations easily including printing from a

smart device such as a smartphone or tablet. You can connect the printer and smart device over a wireless network,
check the ink levels and printer status, and check for solutions if an error occurs.
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Search for and install Epson Smart Panel from App Store or Google Play.

:1|;JI

EPSON

Guide to the Epson Smart Panel Screen

Start Epson Smart Panel from your smart device and select the item you want to use from the home screen.

The following screens are subject to change without notice. The contents may vary depending on the product.

Print Photos

A
( OF)
'\.,F' D’,_J'

Select Photo

— O

= displays notices and how to use the application. =+ starts registering a printer.

Displays the printer name and ink levels.

When you select the menu you want to use, the screen of the menu is displayed.

o o 0|

i displays the printer information. o allows you to make application settings such as changing the screen
display.
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Software for Making Settings or Managing Devices

Application for Configuring Printer Operations (Web Config)

Web Config is an application that runs in a web browser, such as Microsoft Edge and Safari, on a computer or
smart device. You can confirm the printer status or change the network service and printer settings. To use the
Web Config, connect the printer and the computer or device to the same network.

The following browsers are supported. Use the latest version.
Microsoft Edge, Internet Explorer, Firefox, Chrome, Safari

Note:
You may be asked to enter the administrator password while operating Web Config. See the related information below for
more details.

Related Information

= “Default Value of the Administrator Password” on page 14

Running Web Config on a Web Browser

1. Check the printer's IP address.

Select the network icon on the printer's home screen, and then select the active connection method to confirm
the printer's IP address.

li\gzec'an also check the IP address by printing the network connection report.
2. Launch a Web browser from a computer or smart device, and then enter the printer's IP address.
Format:
IPv4: http://the printer's IP address/
IPv6: http://[the printer's IP address]/
Examples:
IPv4: http://192.168.100.201/
IPv6: http://[2001:db8::1000:1]/

Since the printer uses a self-signed certificate when accessing HT'TPS, a warning is displayed on the browser
when you start Web Config; this does not indicate a problem and can be safely ignored.

Related Information

= “Printing a Network Connection Report” on page 179

Running Web Config on Windows
When connecting a computer to the printer using WSD, follow the steps below to run Web Config.

211



Product Information > software Information > Software for Updating

1. Open the printer list on the computer.

J Windows 10

Click on the start button, and then select Windows System > Control Panel > View devices and printers
in Hardware and Sound.

J Windows 8.1/Windows 8

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound (or
Hardware).

O Windows 7

Click the start button, and select Control Panel > View devices and printers in Hardware and Sound.
2. Right-click on your printer and select Properties.

3. Select the Web Service tab and click the URL.

Since the printer uses a self-signed certificate when accessing HI'TPS, a warning is displayed on the browser
when you start Web Config; this does not indicate a problem and can be safely ignored.

Running Web Config on Mac OS

1. Select System Preferences from the Apple menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.
2. Click Options & Supplies> Show Printer Webpage.

Since the printer uses a self-signed certificate when accessing HTTPS, a warning is displayed on the browser
when you start Web Config; this does not indicate a problem and can be safely ignored.

Software for Updating

Application for Updating Software and Firmware (EPSON Software Updater)

EPSON Software Updater is an application that installs new software, and updates firmware and manuals over the
Internet. If you want to check for update information regularly, you can set the interval for checking for updates in
EPSON Software Updater's Auto Update Settings.

Starting on Windows
U Windows 10
Click the start button, and then select Epson Software > EPSON Software Updater.
O Windows 8.1/Windows 8
Enter the application name in the search charm, and then select the displayed icon.
0 Windows 7
Click the start button, and then select All Programs (or Programs) > Epson Software > EPSON Software
Updater.

Note:
You can also start EPSON Software Updater by clicking the printer icon on the task bar on the desktop, and then selecting
Software Update.
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Starting on Mac OS
Select Go > Applications > Epson Software > EPSON Software Updater.

Related Information

= “Installing the Applications Separately” on page 110

Menu List

Select FFl on the home screen of the printer to view the menus.

Paper Setting:

You can also display this menu by selecting .E on the home screen.

Eject:

Lr
You can also display this menu by selecting on the home screen. This menu name changes to
Cut/Eject when roll paper is loaded.

Ink Levels:

You can also display this menu by selecting m on the home screen.

Maintenance:

You can also display this menu by selecting on the home screen.

Print Information Sheet:

You can also display this menu by selecting on the home screen.

General Settings:

You can make various settings.
Web Movie Manuals:

Scan the displayed QR code to access instructional videos.

Related Information

= “Home Screen Configuration” on page 21

= “General Settings” on page 214
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General Settings

Select General Settings from I on the home screen of the printer to make various settings.

Screen Customization

Select the menus on the control panel as described below.

= > General Settings > Screen Customization

Background Color:

Change the background color of the LCD screen.

Home Screen:

Set the default screen you want to display as the home screen.

Standard:

Displays information such as paper settings, ejection status, and ink info.

Supply Status:

Displays the approximate ink levels and the approximate service life of the maintenance box.

Print Screen:

Set the default screen you want to display when printing.

Photo:

Diplays thumbnails of images when you print using printer driver and Epson Print Layout.

Print Settings:
Displays print settings for the printer driver and Epson Print Layout.

Print Status:

Displays the approximate ink levels and a progress bar when printing.

Printer Settings

Select the menus on the control panel as described below.

= > General Settings > Printer Settings

Paper Setup Auto Display:

Select On to display the Paper Setting screen when loading paper in the rear paper feeder. If you
disable this feature, you cannot print from an iPhone, iPad, or iPod touch using AirPrint.
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Error Notice:

Paper Mismatch:

Displays a warning if the paper settings (print settings) for the print job do not match the
printer's paper settings made when you loaded the paper. This setting prevents misprinting.
However, the paper setting screen is not displayed when Paper Setup Auto Display is disabled
in the following menus. If you disable this feature, you cannot print from an iPhone, iPad, or
iPod touch using AirPrint.

General Settings > Printer Settings > Paper Setup Auto Display

Detect Paper Meandering:

Select On to display a message when paper is fed at an angle.

Horizontal Centered:

Select On to print the image in the center of the paper.

Thick Paper:

Select On to prevent ink from smearing on your printouts.

Basic Settings

Select the menus on the control panel as described below.

= > General Settings > Basic Settings

Inside Light:

Select Auto to turn on the interior light automatically when printing.

LCD Brightness:
Adjust the brightness of the LCD screen.

Sounds:
Adjust the volume and select the type of the sound.
O Mute
O Button Press
O Error Tone

O Sound Type

Sleep Timer:
Adjust the time period to enter a sleep mode (energy saving mode) when the printer has not
performed any operations. The LCD screen turns black when the setting time passes.

Power Off Settings:

Your product may have this feature or the Power Off Timer feature depending on the location of
purchase.
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3 Power Off If Inactive

Select this setting to turn the printer off automatically if it is not used for a specified period of
time. Any increase will affect the product’s energy efficiency. Please consider the environment
before making any change.

(3 Power Off If Disconnected

Select this setting to turn the printer off after a specified period of time when all ports including
the USB port are disconnected. This feature may not be available depending on your region.

See the following website for the specified period of time.

https://www.epson.eu/energy-consumption

Power Off Timer:

Your product may have this feature or the Power Off Settings feature depending on the location of
purchase.

Select this setting to turn the printer off automatically when it is not used for a specified period

of time. You can adjust the time before power management is applied. Any increase will affect the

product’s energy efficiency. Please consider the environment before making any change.
Date/Time Settings:

0 Date/Time

Enter the current date and time.
O Daylight Saving Time
Select the summer time setting that applies to your area.

1 Time Difference

Enter the time difference between your local time and UTC (Coordinated Universal Time).

Language:

Select the language used on the LCD screen.

Length Unit:

Select the length unit.

Related Information

= “Saving Power” on page 110

Network Settings

Select the menus on the control panel as described below.
= > General Settings > Network Settings

Wi-Fi Setup:

Set up or change wireless network settings. Choose the connection method from following and then
follow the instructions on the control panel.

Wi-Fi (Recommended):
(O Wi-Fi Setup Wizard
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J Push Button Setup(WPS)
O Others

U PIN Code Setup(WPS)
(O Wi-Fi Auto Connect

[ Disable Wi-Fi
You may be able to resolve network problems by disabling the Wi-Fi settings or making

o E—
— —
- e~
0 0)

the Wi-Fi settings again. Tap > Wi-Fi (Recommended) > Change Settings >
Others > Disable Wi-Fi > Start Setup.
Wi-Fi Direct:
Q ios
O Android
O Other OS Devices
J Change

U Change Network Name
(1 Change Password

(1 Disable Wi-Fi Direct

(1 Restore Default Settings

Wired LAN Setup:
Set up or change a network connection that uses a LAN cable and router. When this is being used,
Wi-Fi connections are disabled.
Network Status:
Displays or prints the current network settings.
O Wired LAN/Wi-Fi Status
(O Wi-Fi Direct Status
O Print Status Sheet

Connection Check:

Checks the current network connection and prints a report. If there are any problems with the
connection, see the report for solutions.

Advanced:
Make the following detailed settings.
O Device Name
Q TCP/IP

O Proxy Server

Web Service Settings

Select the menus on the control panel as described below.
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= > General Settings > Web Service Settings

Epson Connect Services:

Displays whether the printer is registered and connected to Epson Connect. You can register to the
service by selecting Register and follow the instructions. When you have registered, you can change the
following settings.

O Suspend/Resume
O Unregister

For details, see the following web site.
https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

Customer Research

Select the menus on the control panel as described below.

= > General Settings > Customer Research

Select Approve to provide product usage information such as the number of prints to Seiko Epson Corporation.

Restore Default Settings

Select the menus on the control panel as described below.

= > General Settings > Restore Default Settings

Reset the settings in the following menus to their defaults.
O Network Settings

O All Except Network Settings

U Clear All Data and Settings

Printer Status/Print

Select the menus on the control panel as described below.

= > General Settings > Printer Status/Print

Print Status Sheet:

Configuration Status Sheet:

Print information sheets showing the current printer status and settings.

Supply Status Sheet:

Print information sheets showing the status of consumables.
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Usage History Sheet:

Print information sheets showing the usage history of the printer.

Network:

Displays the current network settings. You can also print the status sheet.

Problem Checklist:

Print sheets to check for printer problems. If the printer malfunctions, print the "customer diagnosis
sheets (3 sheets)" and fill in the required information on the first and second sheets. Including the
third nozzle check result with the first two sheets can make repairs smoother.

Firmware Version:

Displays the current firmware version of your printer.

Firmware Update

Select the menus on the control panel as described below.

= > General Settings > Firmware Update

Update:

Check if the latest version of the firmware has been uploaded to the network server. The firmware is
updated when new firmware is found. Once the update has started, it cannot be interrupted.

Notification:

Select On to receive a notification if a firmware update is available.

Related Information

= “Updating the Printer's Firmware Using the Control Panel” on page 115

Product Specifications

Printer Specifications

Type Printer Inkjet

Print Head Nozzle Placement Black ink nozzles: 360

Color ink nozzles: 180 for each color
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Printable Area

Printable Area for Single Sheets

Print quality may decline in the shaded areas due to the printer's mechanism.

Printing with borders

AL jC A 3mm
B 3mm
f C 33 mm
D 36 mm
o
N

*: The margin is 20.0 mm when printing on poster board or using Front Paper Feeder - No Eject Roller(Glossy
Paper) feature.

Borderless printing”

A A 36 mm
B 39 mm
' C 3mm
B
H H
C C

*: Borderless printing is not supported with poster board and Front Paper Feeder - No Eject Roller(Glossy Paper).

Printable Area for Roll Paper

Print quality may decline in the shaded areas due to the printer's mechanism.
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Printing with borders

B B A 50mm
H H
LA B 3mm
c* 14mm

' D* 50mm

Q0

*: 0 mm for continuous print jobs.

Borderless printing

[A A 50mm

B* 14mm

' c* 50mm
[B
[C

*: 0 mm for continuous print jobs.

Printable Area for CD/DVD

Print quality may decline in the shaded areas due to the printer's mechanism.

A 18 mm (0.71in.)
B 43 mm (1.69in.)
C 116 mm (4.57 in.)
D 120 mm (4.72in.)
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Interface Specifications

For Computer SuperSpeed USB

Network Specifications

Wi-Fi Specifications

See the following table for Wi-Fi specifications.

Countries or regions except for those listed below

Table A

Ireland, UK, Austria, Germany, Liechtenstein, Switzerland,
France, Belgium, Luxemburg, Netherlands, Italy, Portugal,
Spain, Denmark, Finland, Norway, Sweden, Iceland, Australia,
New Zealand, China, Hong Kong, Mongolia, Taiwan, South
Korea

Table B

Guade Loupe, Martinique, Mayotte, New Caledonia,
SaintPierre,Miquelon, Reunion, French Polynesia, French
Guyana, Wallis Futuna

If you can select the following menu, see Table B. If you
cannot, see Table A.

E >General Settings > Network Settings > Wi-Fi
Setup > Wi-Fi Direct > Start Setup > Change > Change
Frequency Range

*When you select the menu above, Wi-Fi Direct turns on.
If you want to turn off Wi-Fi Direct, select E >General

Settings > Network Settings > Wi-Fi Setup > Wi-Fi Direct
> Start Setup > Change > Disable Wi-Fi Direct

Table A

Standards IEEE802.11b/g/n"

Frequency Range 2.4 GHz

Channels

1/2/3/4/5/6/7/8/9/10/11/12/13

Coordination Modes

Infrastructure, Wi-Fi Direct (Simple AP)*2*3

Security Protocols™

WEP (64/128bit), WPA2-PSK (AES)*®, WPA3-SAE (AES)

*1:
*2:
*3:
*4:
*5:

Only available for the HT20
Not supported for IEEE 802.11b

Wi-Fi Direct supports WPA2-PSK (AES) only.

Infrastructure and Wi-Fi Direct modes or an Ethernet connection can be used simultaneously.

Complies with WPA2 standards with support for WPA/WPA2 Personal.
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Table B

Standards

IEEE802.11a/b/g/n"1/ac

Frequency Ranges

IEEE802.11b/g/n: 2.4 GHz, IEEE802.11a/n/ac: 5 GHz

Channels

Wi-Fi 24GHz 1/2/3/4/5/6/7/8/9/10/11/12"2/13"2
5 GHZ™3 W52 (36/40/44/48),
W53 (52/56/60/64),
W56 (100/104/108/112/116/120/124/128/132/136/140),
W58 (149/153/157/161/165)
Wi-Fi Direct | 2.4 GHz 1/2/3/4/5/6/7/8/9/10/11/1272/13"2
5 GHZ™3 W52 (36/40/44/48)

W58 (149/153/157/161/165)

Connection Modes

Infrastructure, Wi-Fi Direct (Simple AP)

*4*5

Security Protocols"®

WEP (64/128bit), WPA2-PSK (AES)*7, WPA3-SAE (AES)

*1:  Only available for the HT20

*2:  Not available in Taiwan

*3:  The availability of these channels and use of the product outdoors over these channels varies by location. For more

information, see http://support.epson.net/wifisghz/

*4.  Not supported for IEEE 802.11b

*5:  Infrastructure and Wi-Fi Direct modes or an Ethernet connection can be used simultaneously.

*6:  Wi-Fi Direct only supports WPA2-PSK (AES) .

*7.  Complies with WPA2 standards with support for WPA/WPA2 Personal.

Ethernet Specifications

Standards

IEEE802.3i (10BASE-T)""
IEEE802.3u (100BASE-TX)"

IEEE802.3az (Energy Efficient Ethernet)*2

Communication Mode

Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100Mbps
Full duplex, 100Mbps Half duplex

Connector

RJ-45

*1  Use a category 5e or higher STP (Shielded twisted pair) cable to prevent risk of radio interference.

*2  The connected device should comply with IEEE802.3az standards.
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Network Functions and IPv4/IPv6

Functions Supported Remarks
Network Printing EpsonNet Print (Windows) IPv4 v -

Standard TCP/IP (Windows) IPv4, IPv6 v -

WSD Printing (Windows) IPv4, IPv6 v Windows Vista or

later

Bonjour Printing (Mac OS) IPv4, IPv6 4 -

IPP Printing (Windows, Mac IPv4, IPv6 4 -

0S)

PictBridge Printing (Wi-Fi) IPv4 - Digital camera

Epson Connect (Email Print, IPv4 4 -

Remote Print)

AirPrint (iOS, Mac OS) IPv4, IPv6 v iOS 5 or later, Mac

0S Xv10.7 or later

Network Scanning Epson Scan 2 IPv4, IPv6 - -
Epson ScanSmart IPv4 - -
Event Manager IPv4 - _
Epson Connect (Scan to IPv4 - -
Cloud)
AirPrint (Scan) IPv4, IPv6 - -

Fax Send a fax IPv4 - -
Receive a fax IPv4 - -
AirPrint (Faxout) IPv4, IPv6 - -

Security Protocol

SSL/TLS

HTTPS Server/Client, IPPS

SNMPv3

Supported Third Party Services

AirPrint

iOS 5 or later/Mac OS X v10.7.x or later
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Dimensions

SC-P900 Series

Dimensions

Storage

O Width: 615 mm (24.2 in.)
1 Depth:368 mm (14.5in.)
O Height: 199 mm (7.8 in.)

Printing

0 Width: 615 mm (24.2 in.)
1 Depth: 905 mm (35.6in.)
O Height: 520 mm (20.5 in.)

Weight

Approx. 14.8 kg (32.6 Ib) (Without the ink cartridges and the power cord.)
Approx. 15.9 kg (35.1 Ib) (With the ink cartridges and the power cord.)

SC-P700 Series

Dimensions

Storage

O Width: 515 mm (20.3 in.)
1 Depth:368 mm (14.5in.)
U Height: 185 mm (7.3 in.)

Printing

O Width: 515 mm (20.3 in.)
1 Depth: 769 mm (30.3in.)
O Height: 420 mm (16.5in.)

Weight

Approx. 12.6 kg (27.8 Ib) (Without the ink cartridges and the power cord.)
Approx. 13.7 kg (30.2 Ib) (With the ink cartridges and the power cord.)

Electrical Specifications

SC-P900 Series

Power Supply Rating AC100-240V AC100-120V AC 220-240V
Rated Frequency Range 50-60 Hz 50-60 Hz 50-60 Hz
Rated Current 1.3t00.7 A 1.2A 0.7 A

Power Consumption
(with USB Connection)

Printing: Approx. 24.0 W
(ISO/IEC24712)

Ready mode: Approx. 8.0 W
Sleep mode: Approx. 1.1 W
Power off: Approx. 0.14 W

Printing: Approx. 24.0 W
(ISO/IEC24712)

Ready mode: Approx. 8.0 W
Sleep mode: Approx. 1.1 W
Power off: Approx. 0.08 W

Printing: Approx. 24.0 W (ISO/
IEC24712)

Ready mode: Approx. 8.0 W
Sleep mode: Approx. 1.1 W
Power off: Approx. 0.18 W
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Note:

L Check the label on the printer for its voltage.

U For European users, see the following Website for details on power consumption.

http://www.epson.eu/energy-consumption

SC-P700 Series

Power Supply Rating AC100-240V AC100-120V AC 220-240V
Rated Frequency Range 50-60 Hz 50-60 Hz 50-60 Hz
Rated Current 1.3t00.7 A 1.2A 0.7 A

Power Consumption
(with USB Connection)

Printing: Approx. 22.0 W
(ISO/IEC24712)

Ready mode: Approx. 8.0 W
Sleep mode: Approx. 1.1 W
Power off: Approx. 0.14 W

Printing: Approx. 22.0 W
(ISO/IEC24712)

Ready mode: Approx. 8.0 W
Sleep mode: Approx. 1.1 W
Power off: Approx. 0.08 W

Printing: Approx. 22.0 W (ISO/
IEC24712)

Ready mode: Approx. 8.0 W
Sleep mode: Approx. 1.1 W
Power off: Approx. 0.18 W

Note:

1 Check the label on the printer for its voltage.

1 For European users, see the following Website for details on power consumption.

http://www.epson.eu/energy-consumption

Environmental Specifications

Humidity: 5 to 85% RH (without condensation)

Operation Use the printer within the range shown in the following graph.
%
80
55
20
10 27 35 °
Temperature: 10 to 35°C (50 to 95°F)
Humidity: 20 to 80% RH (without condensation)
Storage Temperature: -20 to 40°C (-4 to 104°F)"

* You can store for one month at 40°C (104°F).

Environmental Specifications for Ink Cartridges

Storage Temperature

-20 to 40 °C (-4 to 104 °F)"

226



http://www.epson.eu/energy-consumption
http://www.epson.eu/energy-consumption

Product Information > product Specifications > Installation Location and Space

Freezing Temperature 0°C(32°F)

Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F).

* You can store for one month at 40 °C (104 °F).

Installation Location and Space

Secure enough place to install and operate the printer correctly.

Product Name SC-P900 Series SC-P700 Series
A 576 mm 507 mm
B 173 mm™! 143 mm™2
C 110 mm 108 mm
D 964 mm 858 mm
E 825 mm 723 mm
F 100 mm 100 mm

*1: When you load paper in the front paper feeder, secure more than 405 mm, and when you set the optional roll
paper unit and load roll paper, secure more than 332 mm behind the printer.

*2: When you load paper in the front paper feeder, secure more than 330 mm, and when you load roll paper,
secure more than 164 mm behind the printer.

See "Safety Instructions” in this manual to confirm the environmental conditions.

Related Information

= “Safety Instructions” on page 11
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System Requirements
(J Windows 10 (32-bit, 64-bit)/Windows 8.1 (32-bit, 64-bit)/Windows 8 (32-bit, 64-bit)/Windows 7 (32-bit,
64-bit)

J macOS Catalina(10.15)/macOS Mojave(10.14)/macOS High Sierra(10.13)/macOS Sierra(10.12)/0S X El
Capitan(10.11)/0S X Yosemite(10.10)/0S X Mavericks(10.9)

Note:

O Mac OS may not support some applications and features.

1 The UNIX File System (UFS) for Mac OS is not supported.

Regulatory Information

Standards and Approvals

Standards and Approvals for U.S. Model

Safety UL62368-1
CAN/CSA-C22.2 No.62368-1

EMC FCC Part 15 Subpart B Class B
CAN ICES-3 (B)/NMB-3 (B)

This equipment contains the following wireless module.
Manufacturer: Seiko Epson Corporation
Type: J26H005

This product conforms to Part 15 of the FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject
to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment and
meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102 of the IC radio
frequency (RF) Exposure rules. This equipment should be installed and operated so that the radiator is kept at least
7.9 inches (20 cm) or more away from a person's body (excluding extremities: hands, wrists, feet and ankles).

Standards and Approvals for European Model

For European users

Hereby, Seiko Epson Corporation declares that the following radio equipment model is in compliance with
Directive 2014/53/EU. The full text of the EU declaration of conformity is available at the following website.
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http://www.epson.eu/conformity
K371A

For use only in Ireland, UK, Austria, Germany, Liechtenstein, Switzerland, France, Belgium, Luxemburg,
Netherlands, Italy, Portugal, Spain, Denmark, Finland, Norway, Sweden, Iceland, Croatia, Cyprus, Greece,
Slovenia, Malta, Bulgaria, Czechia, Estonia, Hungary, Latvia, Lithuania, Poland, Romania, and Slovakia.

Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-
recommended modification of the products.

Frequency Maximum Radio-Frequency Power Transmitted
2400-2483.5 MHz 20 dBm (EIRP)
5150-5250 MHz 20 dBm (EIRP)
5250-5350 MHz 20 dBm (EIRP)
5470-5725 MHz 20 dBm (EIRP)

C€

Standards and Approvals for Australian Model

EMC AS/NZS CISPR32 Class B

Epson hereby declares that the following equipment Models are in compliance with the essential requirements and
other relevant provisions of AS/NZS4268:

K371A

Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-
recommended modification of the products.

ZICTA Type Approval for Users in Zambia

See the following website to check the information for ZICTA Type Approval.

https://support.epson.net/zicta/

Restrictions on Copying

Observe the following restrictions to ensure the responsible and legal use of the printer.
Copying of the following items is prohibited by law:

O Bank bills, coins, government-issued marketable securities, government bond securities, and municipal
securities

J Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage

O Government-issued revenue stamps, and securities issued according to legal procedure
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Exercise caution when copying the following items:

[ Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession
tickets, etc.

O Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note:
Copying these items may also be prohibited by law.
Responsible use of copyrighted materials:

Printers can be misused by improperly copying copyrighted materials. Unless acting on the advice of a
knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before
copying published material.

230



Where to Get Help

Technical Support Web Site. . . . ... .. .

Contacting Epson Support. . . ...... ... .



Where to Get Help > Contacting Epson Support > Help for Users in Taiwan

Technical Support Web Site

If you need further help, visit the Epson support website shown below. Select your country or region and go to the
support section of your local Epson website. The latest drivers, FAQs, manuals, or other downloadables are also
available from the site.

https://support.epson.net/
https://support.epson.com (U.S., Canada, and Latin America)
https://www.epson.eu/support (Europe)

If your Epson product is not operating properly and you cannot solve the problem, contact Epson support.

Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting
information in your product manuals, contact Epson support services for assistance. If Epson support for your area
is not listed below, contact the dealer where you purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:

(J Product serial number

(The serial number label is usually on the back of the product.)
Q Product model

(J Product software version

(Click About, Version Info, or a similar button in the product software.)
J Brand and model of your computer
U Your computer operating system name and version

J Names and versions of the software applications you normally use with your product

Note:

Depending on the product, network settings may be stored in the product’s memory. Due to breakdown or repair of a
product, settings may be lost. Epson shall not be responsible for the loss of any data, for backing up or recovering settings
even during a warranty period. We recommend that you make your own backup data or take notes.

Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.

Help for Users in Taiwan

Contacts for information, support, and services are:
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World Wide Web
http://www.epson.com.tw

Information on product specifications, drivers for download, and products enquiry are available.

Epson HelpDesk

Phone: +886-2-2165-3138

Our HelpDesk team can help you with the following over the phone:
O Sales enquiries and product information

O Product usage questions or problems

U Enquiries on repair service and warranty

Repair service center:
http://www.tekcare.com.tw/branchMap.page

TekCare corporation is an authorized service center for Epson Taiwan Technology & Trading Ltd.

Help for Users in Australia

Epson Australia wishes to provide you with a high level of customer service. In addition to your product manuals,
we provide the following sources for obtaining information:

Internet URL
http://www.epson.com.au

Access the Epson Australia World Wide Web pages. Worth taking your modem here for the occasional surf! The
site provides a download area for drivers, Epson contact points, new product information and technical support
(e-mail).

Epson Helpdesk
Phone: 1300-361-054

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the
Helpdesk can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staff
can provide literature on new Epson products and advise where the nearest dealer or service agent is located. Many
types of queries are answered here.

We encourage you to have all the relevant information on hand when you ring. The more information you
prepare, the faster we can help solve the problem. This information includes your Epson product manuals, type of
computer, operating system, application programs, and any information you feel is required.

Transportation of Product

Epson recommends retaining product packaging for future transportation.

Help for Users in New Zealand

Epson New Zealand wishes to provide you with a high level of customer service. In addition to your product
documentation, we provide the following sources for obtaining information:
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Internet URL
http://www.epson.co.nz

Access the Epson New Zealand World Wide Web pages. Worth taking your modem here for the occasional surf!
The site provides a download area for drivers, Epson contact points, new product information and technical
support (e-mail).

Epson Helpdesk
Phone: 0800 237 766

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the
Helpdesk can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staff
can provide literature on new Epson products and advise where the nearest dealer or service agent is located. Many
types of queries are answered here.

We encourage you to have all the relevant information on hand when you ring. The more information you prepare,
the faster we can help solve the problem. This information includes your Epson product documentation, type of
computer, operating system, application programs, and any information you feel is required.

Transportation of Product

Epson recommends retaining product packaging for future transportation.

Help for Users in Singapore

Sources of information, support, and services available from Epson Singapore are:

World Wide Web
http://www.epson.com.sg

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), Sales Enquiries,
and Technical Support via e-mail are available.

Epson HelpDesk

Toll Free: 800-120-5564

Our HelpDesk team can help you with the following over the phone:
O Sales enquiries and product information

0 Product usage questions or problem troubleshooting

U Enquiries on repair service and warranty

Help for Users in Thailand
Contacts for information, support, and services are:
World Wide Web

http://www.epson.co.th

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and e-mail are
available.
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Epson Call Centre

Phone: 66-2460-9699

Email: support@eth.epson.co.th

Our Call Centre team can help you with the following over the phone:
O Sales enquiries and product information

O Product usage questions or problems

U Enquiries on repair service and warranty

Help for Users in Vietham

Contacts for information, support, and services are:

Epson Service Center

29 Tue Tinh, Quan Hai Ba Trung, Hanoi City, Vietnam

65 Truong Dinh Street, District 1, Ho Chi Minh City, Vietnam.
65 Truong Dinh Street, District 1, Ho Chi Minh City, Vietnam.
65 Truong Dinh Street, District 1, Ho Chi Minh City, Vietnam.

Help for Users in Indonesia

Contacts for information, support, and services are:

World Wide Web
http://www.epson.co.id
0 Information on product specifications, drivers for download

O Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Hotline

Phone: 1500-766 (Indonesia Only)

Email: customer.care@ein.epson.co.id

Our Hotline team can help you with the following over the phone or email:
O Sales enquiries and product information

O Technical support

Help for Users in Hong Kong

To obtain technical support as well as other after-sales services, users are welcome to contact Epson Hong Kong
Limited.
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Internet Home Page
http://www.epson.com.hk

Epson Hong Kong has established a local home page in both Chinese and English on the Internet to provide users
with the following information:

(3 Product information
O Answers to Frequently Asked Questions (FAQs)

U Latest versions of Epson product drivers

Technical Support Hotline

You can also contact our technical staff at the following telephone and fax numbers:
Phone: 852-2827-8911

Fax: 852-2827-4383

Help for Users in Malaysia

Contacts for information, support, and services are:

World Wide Web
http://www.epson.com.my
U Information on product specifications, drivers for download

U Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Call Centre

Phone: 1800-81-7349 (Toll Free)

Email: websupport@emsb.epson.com.my
0 Sales enquiries and product information
O Product usage questions or problems

O Enquiries on repair services and warranty

Epson Malaysia Sdn Bhd (Head Office)
Phone: 603-56288288
Fax: 603-5628 8388/603-5621 2088

Help for Users in India

Contacts for information, support, and services are:

World Wide Web
http://www.epson.co.in

Information on product specifications, drivers for download, and products enquiry are available.
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Toll Free Helpline
For Service, Product information or to order consumables -

18004250011 / 186030001600 / 1800123001600 (9AM - 6PM)

Email

calllog@epson-india.in

WhatsApp
+91 96400 00333

Help for Users in the Philippines

To obtain technical support as well as other after sales services, users are welcome to contact the Epson Philippines
Corporation at the telephone, fax numbers and e-mail address below:

World Wide Web
http://www.epson.com.ph

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and E-mail
Enquiries are available.

Epson Philippines Customer Care

Toll Free: (PLDT) 1-800-1069-37766

Toll Free: (Digitel) 1-800-3-0037766

Metro Manila: +632-8441-9030

Web Site: https://www.epson.com.ph/contact

E-mail: customercare@epc.epson.com.ph

Accessible 9am to 6pm, Monday through Saturday (Except public holidays)
Our Customer Care team can help you with the following over the phone:
0 Sales enquiries and product information

O Product usage questions or problems

O Enquiries on repair service and warranty

Epson Philippines Corporation
Trunk Line: +632-8706-2609
Fax: +632-8706-2663 / +632-8706-2665
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